
 

Cisco IP Solution Center
MPLS VPN User Guide, 4.0
Corporate Headquarters
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-1706 
USA
http://www.cisco.com
Tel: 408 526-4000

800 553-NETS (6387)
Fax: 408 526-4100

Text Part Number: OL-6372-02

http://www.cisco.com


THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL 
STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT 
WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT 
SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE 
OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB’s public 
domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California. 

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED “AS IS” WITH 
ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT 
LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF 
DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, 
WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO 
OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

CCSP, the Cisco Square Bridge logo, Follow Me Browsing, and StackWise are trademarks of Cisco Systems, Inc.; Changing the Way We Work, Live, Play, and Learn, and 
iQuick Study are service marks of Cisco Systems, Inc.; and Access Registrar, Aironet, ASIST, BPX, Catalyst, CCDA, CCDP, CCIE, CCIP, CCNA, CCNP, Cisco, the Cisco 
Certified Internetwork Expert logo, Cisco IOS, Cisco Press, Cisco Systems, Cisco Systems Capital, the Cisco Systems logo, Cisco Unity, Empowering the Internet Generation, 
Enterprise/Solver, EtherChannel, EtherFast, EtherSwitch, Fast Step, FormShare, GigaDrive, GigaStack, HomeLink, Internet Quotient, IOS, IP/TV, iQ Expertise, the iQ logo, 
iQ Net Readiness Scorecard, LightStream, Linksys, MeetingPlace, MGX, the Networkers logo, Networking Academy, Network Registrar, Packet, PIX, Post-Routing, 
Pre-Routing, ProConnect, RateMUX, ScriptShare, SlideCast, SMARTnet, StrataView Plus, SwitchProbe, TeleRouter, The Fastest Way to Increase Your Internet Quotient, 
TransPath, and VCO are registered trademarks of Cisco Systems, Inc. and/or its affiliates in the United States and certain other countries. 

All other trademarks mentioned in this document or Website are the property of their respective owners. The use of the word partner does not imply a partnership relationship 
between Cisco and any other company. (0411R)

Cisco IP Solution Center MPLS VPN User Guide, 4.0
Copyright © 2005 Cisco Systems, Inc. All rights reserved



 

OL-6372-02
C O N T E N T S
About This Guide xxv

Objective of this Guide xxv

Audience xxv

Organization xxvi

Related Documentation xxvi

Obtaining Documentation xxvii

Cisco.com xxvii

Ordering Documentation xxvii

Documentation Feedback xxviii

Obtaining Technical Assistance xxviii

Cisco Technical Support Website xxviii

Submitting a Service Request xxix

Definitions of Service Request Severity xxix

Obtaining Additional Publications and Information xxix

C H A P T E R  1 IP Solution Center Overview 1-1

Business Application 1-1

System Architecture 1-2

Load Balancing 1-4

System Features 1-7

Template Manager 1-9

Role-Based Access Control (RBAC) 1-10

North Bound Interface (NBI) 1-10

Service Provider Network 1-12

Resource Pools 1-15

VPN Profile 1-16

Customer View 1-16

Provider View 1-17

Provider Edge Routers 1-18

Multi-VRF CE 1-18

Service Audit 1-19

MPLS VPN 1-20

Intranets and Extranets 1-22

VPN Routing and Forwarding Tables 1-22
iii
Cisco IP Solution Center MPLS VPN User Guide, 4.0



 

Contents
VRF Implementation 1-23

VRF Instance 1-24

Route Distinguishers and Route Targets 1-24

Route Target Communities 1-25

CE Routing Communities 1-25

MPLS VPN Security 1-27

Address Space and Routing Separation 1-27

Address Space Separation 1-27

Routing Separation 1-27

Hiding the MPLS Core Structure 1-28

Resistance to Attacks 1-28

Securing the Routing Protocol 1-29

Label Spoofing 1-30

Securing the MPLS Core 1-31

Trusted Devices 1-31

PE-CE Interface 1-31

Routing Authentication 1-32

Separation of CE-PE Links 1-32

LDP Authentication 1-32

Connectivity Between VPNs 1-32

MP-BGP Security Features 1-33

Security Through IP Address Resolution 1-34

Ensuring VPN Isolation 1-34

C H A P T E R  2 Unmanaged MVRFCE Overview 2-1

Process Overview 2-2

Network Inventory 2-2

Service Policy 2-3

Service Request 2-4

MVRFCE PE-CE Policy Type 2-4

Infrastructure Data 2-4

Adding a New Customer CPE 2-5

Overview of an ISC Customer 2-5

Creating a Device 2-6

Create a Device 2-6

Collect the Configuration 2-8

Monitor Task Logs 2-10

Creating a Customer, Site, and CPE 2-11

Create a Customer 2-11
iv
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Contents
Create a Site 2-11

Create a CPE 2-13

Adding a New Provider PE 2-16

Overview of an ISC Provider 2-16

Create a Device Group 2-17

Import Configuration Files 2-18

Open a Device 2-20

Collect the Latest Configuration 2-21

Create a Provider and a PE 2-23

Create a Region for the PE 2-25

Edit a PE with the ISC GUI 2-27

Creating an Access Domain 2-27

Overview of an Access Domain 2-28

Create an Access Domain 2-28

Creating Resource Pools 2-31

Overview of Resource Pools 2-31

Create an IP Address Pool 2-32

Create a Multicast Pool 2-34

Create a Route Distinguisher Pool 2-36

Create a Route Target Pool 2-38

Create a Site of Origin Pool 2-40

Create a VC ID Pool 2-41

Create a VLAN Pool 2-43

Defining a VPN 2-45

Defining an MVRFCE PE-CE Service Policy 2-48

Creating an MVRFCE PE-CE Service Request 2-53

C H A P T E R  3 Service Policy Overview 3-1

Creating an MPLS VPN in ISC 3-1

Defining CE Routing Communities 3-6

Creating Service Policies 3-7

The Service Policy Editor 3-8

About IP Addresses in Cisco ISC 3-8

Creating an MPLS Service Policy for a PE-to-CE Link 3-9

Specifying the PE and CE Interface Parameters 3-10

Specifying the IP Address Scheme 3-13

Using an Existing Loopback Interface Number 3-15

Specifying the Routing Protocol for a Service 3-16

Redistribution of IP Routes 3-16
v
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Contents
CSC Support 3-16

Giving Only Default Routes to the CE 3-17

Static Protocol Chosen 3-17

RIP Protocol Chosen 3-18

BGP Protocol Chosen 3-22

OSPF Protocol Chosen 3-25

EIGRP Protocol Chosen 3-29

None Chosen: Cable Services 3-34

Defining the Service Policy VRF and VPN Information 3-35

C H A P T E R  4 Overview of Service Requests 4-1

Service Request Transition States 4-1

Service Enhancements 4-4

How ISC Accesses Network Devices 4-4

Creating Service Requests 4-5

MPLS VPN Topology Example 4-5

Creating a PE-CE Service Request 4-6

Static Routing Protocols 4-12

Creating a Multi-VRF Service Request 4-15

Multi-VRF Overview 4-15

Creating an Multi-VRF Service Request 4-15

Creating a PE-Only Service Request 4-24

Adding a CLE Service Request 4-29

Deploying Service Requests 4-30

Monitoring Service Requests 4-32

Auditing Service Requests 4-33

Functional Audit 4-33

How to Perform a Functional Audit 4-33

Where to Find the Functional Audit 4-34

Why a Functional Audit Could Fail 4-34

Configuration Audit 4-34

How to Perform a Configuration Audit 4-34

Where to Find the Configuration Audit 4-35

Why a Configuration Audit Could Fail 4-35

Editing Configuration Files 4-35

C H A P T E R  5 MPLS VPN PE-CE Link Overview 5-1

Network Topology 5-2

Prerequisite Tasks 5-2
vi
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Contents
Infrastructure Data 5-3

Defining a VPN for the PE-CE Link 5-3

Creating MPLS VPN PE-CE Service Policies 5-5

PE-CE Service Policy Overview 5-5

Creating a PE-CE Service Policy 5-6

Creating a PE-NoCE Service Policy 5-10

Creating MPLS VPN PE-CE Service Requests 5-14

Creating a PE-CE Service Request 5-14

Creating a PE-NoCE Service Request 5-21

C H A P T E R  6 MPLS VPN MVRFCE PE-CE Link Overview 6-1

Network Topology 6-2

Prerequisite Tasks 6-3

Infrastructure Data 6-3

Defining a VPN for the MVRFCE PE-CE Link 6-4

Creating MPLS VPN MVRFCE PE-CE Service Policies 6-6

Creating a MVRFCE PE-CE Service Policy 6-6

Creating a PE-NoCE Service Policy 6-12

Creating MPLS VPN MVRFCE PE-CE Service Requests 6-18

Creating a MVRFCE PE-CE Service Request 6-18

Creating a MVRFCE PE-NoCE Service Request 6-27

C H A P T E R  7 Overview of the ISC Management Network 7-1

Unmanaged Customer Edge Routers 7-1

Managed Customer Edge Routers 7-2

Network Management Subnets 7-3

Issues Regarding Access to VPNs 7-4

Implementation Techniques 7-4

Management CE (MCE) 7-4

Management PE (MPE) 7-5

Management VPN 7-5

Advantages 7-6

Out-of-Band Technique 7-7

Provisioning a Management CE in ISC 7-7

Defining a CE as an MCE 7-8

Creating an MCE Service Request 7-9

Adding PE-CE Links to the Management VPN 7-16

C H A P T E R  8 Overview of MPLS VPN Cable 8-1
vii
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Contents
Benefits of Cable MPLS VPNs 8-1

The Cable MPLS VPN Network 8-2

Management VPN in the Cable Network 8-4

Cable VPN Configuration Overview 8-4

Cable VPN Interfaces and Subinterfaces 8-5

Provisioning Cable Services in ISC 8-6

Creating the Service Requests 8-6

Creating a Cable Subinterface Service Request 8-6

Creating a Cable Link Service Request 8-11

C H A P T E R  9 Carrier Supporting Carrier Overview 9-1

Backbone Network with a Customer Carrier Who Is an ISP 9-1

Backbone Network with a Customer Carrier Who Is a BGP/MPLS VPN Service Provider 9-3

ISC Configuration Options 9-4

LDP/IGP 9-4

IPv4 BGP Label Distribution 9-4

Defining a CSC Service Policy 9-5

Provisioning a CSC Service Request 9-5

C H A P T E R  10 NPC Ring Topology 10-1

Ring Topology Overview 10-1

Creating a Ring of Three PE-CLE 10-2

Configuring NPC Ring Topology 10-4

Ethernet-To-The-Home 10-9

ETTH Overview 10-9

Access Domain Management 10-11

ISC ETTH Implementation 10-11

Configuring ETTH 10-11

C H A P T E R  11 Overview 11-1

Benefits 11-2

Routing Between Autonomous Systems 11-2

Exchanging VPN Routing Information 11-4

Routing Between Subautonomous Systems in a Confederation 11-8

Using ISC to Span Multiple Autonomous Systems 11-10

A P P E N D I X  A Setting Up the Network A-1

Tasks to Be Completed Before Using ISC Software A-2
viii
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Contents
Configuring Devices in the ISC MPLS Environment A-3

Setting Up the Secure Shell (SSH) on Edge Routers A-3

Setting Up SNMPv1 and SNMPv2 on the Routers in the Service Provider Network A-4

Setting the SNMPv3 Parameters on the Routers in the Service Provider Network A-5

Enabling SA Agent on Edge Routers for SLA Jitter Probes A-7

Enabling Telnet Sessions for Terminal Server Ports A-8

Time Zone Support in ISC A-8

Setting Up the ISC Workstation A-8

Enabling TFTP in Cisco ISC A-8

Setting the ISC Host as a TFTP Server A-10

Defining Collection Zones and Assigning Devices to Zones A-12

Defining Collection Zones A-13

Assigning Devices to a Collection Zone A-14

Seeing the Devices Assigned to a Collection Zone A-15

A P P E N D I X  B Service Request Transition States B-1

Service Request State Transition Sequences B-1

A P P E N D I X  C Troubleshooting MPLS VPN C-1

MPLS VPN Provisioning Workflow C-1

Terms Defined C-2

General Troubleshooting Guidelines C-2

Common Provisioning Issues C-2

Troubleshooting MPLS VPN and Layer 2 VPN C-4

Frequently Asked Questions C-5

Troubleshooting IPsec Mapping into MPLS C-6

IN D E X
ix
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Contents
x
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



F I G U R E S

 

Figure 1-1 ISC Network Life-Cycle Management Process 1-2

Figure 1-2 Four-Tiered ISC Architecture 1-3

Figure 1-3 Simple Flat-Based Server Load Balancing Configuration 1-5

Figure 1-4 Redundant Load Balancing Configuration 1-6

Figure 1-5 ISC MPLS VPN Management in the Service Provider Network 1-12

Figure 1-6 Service Provider Network for VLAN ID Management 1-14

Figure 1-7 Access Domain Assigned 1-15

Figure 1-8 The Customer’s View of the Network 1-17

Figure 1-9 Service Provider’s View of the Network 1-18

Figure 1-10 A Multi-VRF CE Providing Layer 3 Aggregation 1-19

Figure 1-11 VPNs Sharing Sites 1-20

Figure 1-12 VRFs for Sites in Multiple VPNs 1-23

Figure 1-13 Examples of CERC Topologies 1-26

Figure 2-1 Unmanaged MVRFCE PE-CE Network Topology 2-2

Figure 2-2 MVRFCE PE-CE Link 2-4

Figure 2-3 Overview of an ISC Customer 2-6

Figure 2-4 Devices 2-7

Figure 2-5 Tasks 2-8

Figure 2-6 Create Task 2-8

Figure 2-7 Collect Config Task 2-9

Figure 2-8 Select Device 2-9

Figure 2-9 Tasks 2-10

Figure 2-10 Task Runtime Actions 2-10

Figure 2-11 Create Customer Site 2-12

Figure 2-12 Select Customer 2-12

Figure 2-13 CPE Devices 2-13

Figure 2-14 Create CPE Device 2-13

Figure 2-15 Select Device 2-14

Figure 2-16 Create CPE Device 2-15

Figure 2-17 CPE Devices 2-16

Figure 2-18 Overview of an ISC Provider 2-17
xi
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Figures
Figure 2-19 Inventory Manager Task Bar 2-17

Figure 2-20 Create New Device Group 2-18

Figure 2-21 Open Config Files 2-19

Figure 2-22 Group Spreadsheet 2-19

Figure 2-23 Open Devices 2-20

Figure 2-24 Open Devices 2-20

Figure 2-25 Devices Spreadsheet 2-21

Figure 2-26 Management Address 2-22

Figure 2-27 Platform Information 2-23

Figure 2-28 Move to New Customer 2-23

Figure 2-29 Create New Provider 2-24

Figure 2-30 Provider Spreadsheet 2-24

Figure 2-31 PE Attributes 2-25

Figure 2-32 Region Name 2-25

Figure 2-33 New Region 2-26

Figure 2-34 Region Name 2-26

Figure 2-35 PE Attributes 2-26

Figure 2-36 PE Devices 2-27

Figure 2-37 Overview of an Access Domain 2-28

Figure 2-38 Access Domains 2-29

Figure 2-39 Create Access Domain 2-29

Figure 2-40 Show PEs 2-30

Figure 2-41 Create Reserved VLAN 2-30

Figure 2-42 Access Domains 2-31

Figure 2-43 Resource Pools 2-32

Figure 2-44 Create IP Address Pool 2-33

Figure 2-45 Select Region 2-33

Figure 2-46 Create IP Address Pool 2-34

Figure 2-47 Resource Pools - IP Address 2-34

Figure 2-48 Resource Pools - Multicast 2-35

Figure 2-49 Create Multicast Pool 2-35

Figure 2-50 Resource Pools - Multicast 2-36

Figure 2-51 Resource Pools - Route Distinguisher 2-36

Figure 2-52 Create Route Distinguisher Pool 2-37

Figure 2-53 Create Route Distinguisher Pool 2-37
xii
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Figures
Figure 2-54 Create Route Distinguisher Pool 2-38

Figure 2-55 Create Route Target Pool 2-38

Figure 2-56 Create Route Target Pool 2-39

Figure 2-57 Create Route Target Pool 2-39

Figure 2-58 Resource Pools - Route Target 2-40

Figure 2-59 Resource Pools - Site of Origin 2-40

Figure 2-60 Create Site of Origin Pool 2-41

Figure 2-61 Resource Pools - Site of Origin 2-41

Figure 2-62 Resource Pools - VC ID 2-42

Figure 2-63 Create VC ID Pool 2-42

Figure 2-64 Resource Pools - VC ID 2-43

Figure 2-65 Resource Pools - VLAN 2-44

Figure 2-66 Select Device 2-44

Figure 2-67 Select Access Domain 2-44

Figure 2-68 Create VLAN Pool 2-45

Figure 2-69 Resource Pools - VLAN 2-45

Figure 2-70 VPNs 2-46

Figure 2-71 Create VPN 2-46

Figure 2-72 Select Customer 2-47

Figure 2-73 VPNs 2-47

Figure 2-74 Policies 2-48

Figure 2-75 MPLS Policy Editor - Policy Type 2-48

Figure 2-76 Customer for MPLS Policy 2-49

Figure 2-77 The MPLS Policy Editor - PE Interface 2-49

Figure 2-78 The MPLS Policy Editor - CE Interface 2-50

Figure 2-79 The MPLS Policy Editor - PE IP Address Scheme 2-50

Figure 2-80 The MPLS Policy Editor - CE IP Address Scheme 2-50

Figure 2-81 The MPLS Policy Editor - PE Routing Information 2-51

Figure 2-82 The MPLS Policy Editor - CE Routing Information 2-51

Figure 2-83 The MPLS Policy Editor - VRF and VPN Membership 2-52

Figure 2-84 Policies 2-52

Figure 2-85 Service Requests 2-53

Figure 2-86 Select MPLS Policy 2-53

Figure 2-87 MPLS Service Request Editor 2-54

Figure 2-88 MPLS Service Request Editor - Select CE 2-54
xiii
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Figures
Figure 2-89 Select CPE Device - CE 2-54

Figure 2-90 MPLS Service Request Editor - CE Interface 2-55

Figure 2-91 Select CPE Device - MVRFCE 2-55

Figure 2-92 MPLS Service Request Editor - MVRFCE CE Facing Interface 2-55

Figure 2-93 MPLS Service Request Editor - Select MVRFCE PE Facing Interface 2-56

Figure 2-94 Select PE Device 2-56

Figure 2-95 MPLS Link Attribute Editor - Interface 2-56

Figure 2-96 MPLS Link Attribute Editor - Interface 2-57

Figure 2-97 MPLS Link Attribute Editor - Interface 2-58

Figure 2-98 MPLS Link Attribute Editor - IP Address Scheme 2-58

Figure 2-99 MPLS Link Attribute Editor - IP Address Scheme 2-59

Figure 2-100 MPLS Link Attribute Editor - PE Routing Information 2-59

Figure 2-101 MPLS Link Attribute Editor - MVRFCE Routing Information 2-59

Figure 2-102 Select VPN 2-60

Figure 2-103 MPLS Service Request Editor 2-60

Figure 2-104 MPLS Service Request Editor 2-61

Figure 2-105 Service Request 2-61

Figure 3-1 Creating an MPLS VPN in ISC 3-2

Figure 3-2 Viewing Existing VPNs or Creating a New VPN 3-2

Figure 3-3 Creating an MPLS VPN in ISC 3-3

Figure 3-4 Selecting a Customer for the VPN 3-3

Figure 3-5 Selecting a Customer for the VPN 3-4

Figure 3-6 Selecting a CERC 3-5

Figure 3-7 New CERC Selected 3-5

Figure 3-8 CE Routing Communities Defined for This VPN 3-6

Figure 3-9 Defining a New CE Routing Community 3-7

Figure 3-10 Creating a New Service Policy 3-9

Figure 3-11 Defining the MPLS Service Policy 3-9

Figure 3-12 Specifying the PE and CE Interface Parameters 3-11

Figure 3-13 Specifying the IP Address Scheme 3-13

Figure 3-14 Specifying the Static Routing Protocol 3-17

Figure 3-15 RIP Selected as the Routing Protocol 3-19

Figure 3-16 Selecting Protocols to Redistribute into the PE 3-20

Figure 3-17 Selecting Protocols to Redistribute into the CE 3-21

Figure 3-18 BGP Selected as the Routing Protocol 3-23
xiv
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Figures
Figure 3-19 Selecting Protocols to Redistribute into the CE 3-24

Figure 3-20 OSPF Selected as the Routing Protocol 3-26

Figure 3-21 Selecting Protocols to Redistribute into the PE 3-27

Figure 3-22 Selecting Protocols to Redistribute into the CE 3-28

Figure 3-23 EIGRP Selected as the Routing Protocol 3-30

Figure 3-24 Selecting Protocols to Redistribute into the PE 3-32

Figure 3-25 Selecting Protocols to Redistribute into the CE 3-33

Figure 3-26 No Routing Protocol Selected 3-34

Figure 3-27 Specifying the VRF Information 3-35

Figure 3-28 No Routing Protocol Selected 3-36

Figure 4-1 Service Request States: Movement and Relationships 4-2

Figure 4-2 Example Network Topology 4-6

Figure 4-3 Initial Service Requests Dialog Box 4-7

Figure 4-4 Selecting the MPLS Policy for This Service 4-7

Figure 4-5 MPLS Service Request Editor 4-7

Figure 4-6 Initial Fields Displayed to Define PE-CE Link 4-8

Figure 4-7 Selecting the CE for the MPLS Link 4-8

Figure 4-8 CE and CE Interface Fields Defined 4-9

Figure 4-9 Selecting the PE for the MPLS Link 4-9

Figure 4-10 PE and PE Interface Fields Defined 4-9

Figure 4-11 Specifying the MPLS Link Interface Attributes 4-10

Figure 4-12 Specifying the MPLS Link IP Address Attributes 4-10

Figure 4-13 Specifying the MPLS Link Routing Protocol Attributes 4-11

Figure 4-14 Specifying the MPLS Link VRF and VPN Attributes 4-11

Figure 4-15 Service Request for an MPLS Link Completed 4-12

Figure 4-16 Static Routing Protocol 4-13

Figure 4-17 Advertised Routes Window 4-13

Figure 4-18 Add IP Address 4-14

Figure 4-19 Routes to reach other sites Window 4-14

Figure 4-20 Add an IP Address 4-14

Figure 4-21 Initial Service Requests Dialog Box 4-16

Figure 4-22 Selecting the Multi-VRF Policy for this Service 4-16

Figure 4-23 MPLS Service Request Editor 4-16

Figure 4-24 Initial Fields Displayed to Define Multi-VRF Link 4-17

Figure 4-25 Selecting the CE for the Multi-VRF Link 4-17
xv
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Figures
Figure 4-26 CE Interface Fields Defined 4-18

Figure 4-27 Selecting the MVRFCE for the Multi-VRF Link 4-18

Figure 4-28 MVRFCE CE and MVRFCE PE Facing Interfaces Defined 4-19

Figure 4-29 Selecting the PE for the Multi-VRF Link 4-19

Figure 4-30 PE Interface Fields Defined 4-20

Figure 4-31 Specifying the PE and MVRFCE PE Facing Link Interface Attributes 4-20

Figure 4-32 Specifying the CE and MVRFCE CE Facing Link Interface Attributes 4-21

Figure 4-33 Specifying the PE MVRFCE Link IP Address Attributes 4-21

Figure 4-34 Specifying the MVRFCE CE Link IP Address Attributes 4-22

Figure 4-35 Specifying the PE MVRFCE Link Routing Protocol Attributes 4-22

Figure 4-36 Specifying the MVRFCE CE Link Routing Protocol Attributes 4-23

Figure 4-37 Specifying the Multi-VRF Link VRF and VPN Attribute 4-23

Figure 4-38 Service Request for Multi-VRF Links Completed 4-24

Figure 4-39 Initial Service Requests Dialog Box 4-24

Figure 4-40 Selecting the PE-Only Policy for this Service 4-25

Figure 4-41 MPLS Service Request Editor 4-25

Figure 4-42 Initial Fields Displayed to Define PE-Only Link 4-25

Figure 4-43 Selecting the PE for the PE-Only Link 4-26

Figure 4-44 PE and PE Interface Fields Defined 4-26

Figure 4-45 Specifying the PE-Only Link Interface Attributes 4-27

Figure 4-46 Specifying the PE-Only Link IP Address Attributes 4-27

Figure 4-47 Specifying the PE-Only Routing Protocol Attributes 4-28

Figure 4-48 Specifying the PE-Only Link VRF and VPN Attributes 4-28

Figure 4-49 Service Request for an PE-Only Link Completed 4-29

Figure 4-50 Selecting the CLE for the PE-Only Link 4-29

Figure 4-51 Selecting a Service Requests to Deploy 4-30

Figure 4-52 Deployment Options 4-31

Figure 4-53 Scheduling a Service Request for Deployment 4-31

Figure 4-54 Status for Successful Deployment 4-32

Figure 4-55 Viewing Information on Running Tasks 4-32

Figure 4-56 Service Request Details Displayed 4-33

Figure 4-57 List of Devices Recognized by ISC 4-36

Figure 4-58 List of Configurations for the Selected Device 4-36

Figure 4-59 Selected Configuration Displayed 4-37

Figure 5-1 PE to CE link with CE Present 5-1
xvi
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Figures
Figure 5-2 PE to CE link with No CE 5-2

Figure 5-3 Network Topology for MPLS VPN PE-CE Scenarios. 5-2

Figure 5-4 VPNs 5-4

Figure 5-5 Create VPN 5-4

Figure 5-6 Select Customer 5-5

Figure 5-7 VPNs 5-5

Figure 5-8 PE-CE Topology 5-6

Figure 5-9 Policies 5-6

Figure 5-10 MPLS Policy Editor - Policy Type 5-7

Figure 5-11 Customer for MPLS Policy 5-7

Figure 5-12 The MPLS Policy Editor - Interface 5-8

Figure 5-13 The MPLS Policy Editor - IP Address Scheme 5-8

Figure 5-14 The MPLS Policy Editor - Routing Information 5-9

Figure 5-15 The MPLS Policy Editor - VRF and VPN Membership 5-9

Figure 5-16 Policies 5-10

Figure 5-17 Policies 5-10

Figure 5-18 MPLS Policy Editor - Policy Type 5-11

Figure 5-19 Customer for MPLS Policy 5-11

Figure 5-20 The MPLS Policy Editor - Interface 5-12

Figure 5-21 The MPLS Policy Editor - IP Address Scheme 5-12

Figure 5-22 The MPLS Policy Editor - Routing Information 5-13

Figure 5-23 The MPLS Policy Editor - VRF and VPN Membership 5-13

Figure 5-24 Policies 5-14

Figure 5-25 Service Requests 5-14

Figure 5-26 Select MPLS Policy 5-15

Figure 5-27 MPLS Service Request Editor 5-15

Figure 5-28 MPLS Service Request Editor - Select CE 5-16

Figure 5-29 CPE for MPLS VPN Link 5-16

Figure 5-30 PE for MPLS VPN Link 5-17

Figure 5-31 MPLS Service Request Editor 5-17

Figure 5-32 MPLS Link Attribute Editor - Interface 5-18

Figure 5-33 MPLS Link Attribute Editor - IP Address Scheme 5-18

Figure 5-34 MPLS Link Attribute Editor - Routing Information 5-19

Figure 5-35 MPLS Link Attribute Editor - VRF and VPN 5-19

Figure 5-36 Select CERCs Window 5-20
xvii
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Figures
Figure 5-37 MPLS Service Request Editor 5-20

Figure 5-38 MPLS Service Request Editor 5-21

Figure 5-39 Service Request 5-21

Figure 5-40 Service Requests 5-22

Figure 5-41 Select MPLS Policy 5-22

Figure 5-42 MPLS Service Request Editor 5-23

Figure 5-43 MPLS Service Request Editor - Select CE 5-23

Figure 5-44 PE for MPLS VPN Link 5-24

Figure 5-45 MPLS Service Request Editor 5-24

Figure 5-46 MPLS Link Attribute Editor - Interface 5-25

Figure 5-47 MPLS Link Attribute Editor - IP Address Scheme 5-25

Figure 5-48 MPLS Link Attribute Editor - Routing Information 5-26

Figure 5-49 MPLS Link Attribute Editor - VRF and VPN 5-26

Figure 5-50 MPLS Service Request Editor 5-27

Figure 5-51 MPLS Service Request Editor 5-27

Figure 5-52 MPLS Service Request Editor 5-28

Figure 5-53 Service Request 5-28

Figure 6-1 MVRFCE PE-CE Link 6-2

Figure 6-2 MVRFCE PE-CE Link with No CE 6-2

Figure 6-3 Network Topology for MPLS VPN MVRFCE PE-CE Scenarios 6-2

Figure 6-4 VPNs 6-4

Figure 6-5 Create VPN 6-5

Figure 6-6 Select Customer 6-5

Figure 6-7 VPNs 6-6

Figure 6-8 Policies 6-7

Figure 6-9 MPLS Policy Editor - Policy Type 6-7

Figure 6-10 Customer for MPLS Policy 6-8

Figure 6-11 The MPLS Policy Editor - PE Interface 6-8

Figure 6-12 The MPLS Policy Editor - CE Interface 6-9

Figure 6-13 The MPLS Policy Editor - IP Address Scheme 6-9

Figure 6-14 The MPLS Policy Editor - IP Address Scheme 6-9

Figure 6-15 The MPLS Policy Editor - Routing Information 6-10

Figure 6-16 The MPLS Policy Editor - Routing Information 6-10

Figure 6-17 The MPLS Policy Editor - VRF and VPN Membership 6-11

Figure 6-18 Policies 6-11
xviii
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Figures
Figure 6-19 Policies 6-12

Figure 6-20 MPLS Policy Editor - Policy Type 6-12

Figure 6-21 Customer for MPLS Policy 6-13

Figure 6-22 The MPLS Policy Editor - PE Interface 6-13

Figure 6-23 The MPLS Policy Editor - CE Interface 6-14

Figure 6-24 The MPLS Policy Editor - IP Address Scheme 6-14

Figure 6-25 The MPLS Policy Editor - IP Address Scheme 6-15

Figure 6-26 The MPLS Policy Editor - Routing Information 6-15

Figure 6-27 The MPLS Policy Editor - Routing Information 6-15

Figure 6-28 The MPLS Policy Editor - VRF and VPN Membership 6-16

Figure 6-29 VPN Dialog Box 6-16

Figure 6-30 The MPLS Policy Editor - VRF and VPN Membership 6-17

Figure 6-31 Policies 6-17

Figure 6-32 Service Requests 6-18

Figure 6-33 Select MPLS Policy 6-19

Figure 6-34 MPLS Service Request Editor 6-19

Figure 6-35 MPLS Service Request Editor - Select CE 6-20

Figure 6-36 CPE for MPLS VPN Link 6-20

Figure 6-37 MPLS Service Request Editor - Select MVRFCE 6-21

Figure 6-38 PE for MPLS VPN Link 6-21

Figure 6-39 MPLS Service Request Editor - Select MVRFCE CE Facing Interface 6-21

Figure 6-40 PE for MPLS VPN Link 6-22

Figure 6-41 MPLS Link Attribute Editor - Interface 6-22

Figure 6-42 MPLS Link Attribute Editor - Interface 6-23

Figure 6-43 MPLS Link Attribute Editor - IP Address Scheme 6-23

Figure 6-44 MPLS Link Attribute Editor - IP Address Scheme 6-24

Figure 6-45 MPLS Link Attribute Editor - Routing Information 6-24

Figure 6-46 MPLS Link Attribute Editor - Routing Information 6-24

Figure 6-47 MPLS Link Attribute Editor - VRF and VPN 6-25

Figure 6-48 MPLS Link Attribute Editor - VRF and VPN 6-25

Figure 6-49 MPLS Service Request Editor 6-26

Figure 6-50 MPLS Service Request Editor 6-26

Figure 6-51 Service Request 6-27

Figure 6-52 Service Requests 6-27

Figure 6-53 Select MPLS Policy 6-28
xix
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Figures
Figure 6-54 MPLS Service Request Editor 6-28

Figure 6-55 MPLS Service Request Editor - Select MVRFCE 6-29

Figure 6-56 CPE for MPLS VPN Link 6-29

Figure 6-57 MPLS Service Request Editor - MVRFCE CE Facing Interface 6-30

Figure 6-58 MPLS Service Request Editor 6-30

Figure 6-59 MPLS Link Attribute Editor - Interface 6-31

Figure 6-60 MPLS Link Attribute Editor - Interface 6-32

Figure 6-61 MPLS Link Attribute Editor - IP Address Scheme 6-32

Figure 6-62 MPLS Link Attribute Editor - IP Address Scheme 6-33

Figure 6-63 MPLS Link Attribute Editor - Routing Information 6-33

Figure 6-64 MPLS Link Attribute Editor - Routing Information 6-33

Figure 6-65 MPLS Link Attribute Editor - VRF and VPN 6-34

Figure 6-66 MPLS Service Request Editor 6-34

Figure 6-67 Service Request 6-35

Figure 7-1 Service Provider Network and Unmanaged CEs 7-2

Figure 7-2 The ISC Network Management Subnet 7-4

Figure 7-3 Typical Topology for a Management VPN Network 7-6

Figure 7-4 Out-of-Band Technique 7-7

Figure 7-5 List of All CPEs for All Customers 7-8

Figure 7-6 Editing the Selected CPE Device 7-9

Figure 7-7 Selected CE Defined as a Management CE 7-9

Figure 7-8 Initial Service Requests Dialog Box 7-10

Figure 7-9 Selecting the MPLS Policy for This Service 7-10

Figure 7-10 MPLS Service Request Editor 7-11

Figure 7-11 Initial Fields Displayed to Define PE-CE Link 7-11

Figure 7-12 Selecting the MCE for the MPLS Link 7-12

Figure 7-13 CE and CE Interface Fields Defined 7-12

Figure 7-14 Selecting the PE for the MPLS Link 7-13

Figure 7-15 PE and PE Interface Fields Defined 7-13

Figure 7-16 Specifying the MPLS Link Interface Attributes 7-14

Figure 7-17 Specifying the MPLS Link IP Address Attributes 7-14

Figure 7-18 Specifying the MPLS Link Routing Protocol Attributes 7-15

Figure 7-19 Specifying the MPLS Link VRF and VPN Attributes 7-15

Figure 7-20 Service Request for an MPLS Link Completed 7-16

Figure 7-21 Joining a CE to the Management VPN 7-16
xx
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Figures
Figure 8-1 Example of an MPLS VPN Cable Network 8-3

Figure 8-2 Selecting the Cable Policy for the Subinterface 8-7

Figure 8-3 MPLS Service Request Editor 8-7

Figure 8-4 Selecting the PE for the MPLS Link 8-8

Figure 8-5 PE and PE Interface Fields Defined 8-8

Figure 8-6 Specifying the MPLS Link Interface Attributes 8-9

Figure 8-7 Cable Helper Addresses 8-9

Figure 8-8 Specifying the MPLS Link IP Address Attributes 8-10

Figure 8-9 Specifying the MPLS Link Routing Protocol Attributes 8-10

Figure 8-10 Specifying the MPLS Link VRF and VPN Attributes 8-11

Figure 8-11 Selecting the Cable Link Policy for This Service 8-12

Figure 8-12 MPLS Service Request Editor 8-12

Figure 8-13 Selecting the PE for the MPLS Link 8-13

Figure 8-14 PE and PE Interface Fields Defined 8-13

Figure 8-15 Specifying the MPLS Link Interface Attributes 8-14

Figure 8-16 Cable Helper Addresses 8-14

Figure 8-17 Cable Secondary Addresses 8-15

Figure 8-18 Specifying the MPLS Link IP Address Attributes 8-15

Figure 8-19 Specifying the MPLS Link Routing Protocol Attributes 8-15

Figure 8-20 Specifying the MPLS Link VRF and VPN Attributes 8-16

Figure 8-21 Select CERCs 8-16

Figure 8-22 Specifying the MPLS Link VRF and VPN Attributes 8-17

Figure 8-23 Service Request for an MPLS Link Completed 8-17

Figure 9-1 Carrier Supporting Carrier Network with a Customer Carrier Who Is an ISP 9-2

Figure 9-2 Backbone Carrier Exchanging Routing Information with a Customer Carrier Who Is an ISP 9-3

Figure 9-3 Carrier Supporting Carrier Network with a Customer Carrier Who Is an MPLS VPN Provider 9-3

Figure 9-4 Backbone Carrier Exchanging Information with a Customer Carrier Who Is an MPLS VPN Service Provider 9-4

Figure 9-5 CSC Service Policy 9-5

Figure 9-6 CSC Service Request 9-6

Figure 10-1 L2 Access Topologies 10-2

Figure 10-2 A Ring of Three PE-CLE 10-2

Figure 10-3 NPC Rings 10-3

Figure 10-4 Create Ring 10-3

Figure 10-5 Show Devices 10-3

Figure 10-6 Create Ring 10-4
xxi
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Figures
Figure 10-7 NPC Rings 10-4

Figure 10-8 The Ring Topology 10-5

Figure 10-9 Named Physical Circuits 10-5

Figure 10-10 Create a Named Physical Circuit 10-6

Figure 10-11 Create a Named Physical Circuit 10-6

Figure 10-12 Select Devices 10-6

Figure 10-13 Create a Named Physical Circuit 10-7

Figure 10-14 Create a Named Physical Circuit 10-7

Figure 10-15 Create a Named Physical Circuit 10-7

Figure 10-16 Show PE Devices 10-8

Figure 10-17 Create a Named Physical Circuit 10-8

Figure 10-18 Named Physical Circuits 10-9

Figure 10-19 Cisco ETTx Solution 10-10

Figure 10-20 MPLS Policy Editor - Interface 10-12

Figure 10-21 ETTH UNI Information 10-12

Figure 10-22 ETTH UNI Information Options 10-13

Figure 10-23 MPLS Link Attribute Editor - Interface 10-14

Figure 10-24 Multicast IP Addresses 10-15

Figure 11-1 EBGP Connection Between Two Autonomous Systems 11-3

Figure 11-2 Exchanging Routes and Labels Between Two Autonomous Systems 11-5

Figure 11-3 Host Routes Propagated to All PEs Between Two Autonomous Systems 11-6

Figure 11-4 Forwarding Packets Between Two Autonomous Systems 11-7

Figure 11-5 Forwarding Packets Without Reassigning a New Label 11-8

Figure 11-6 EGBP Connection Between Two AS’s in a Confederation 11-9

Figure 11-7 Example VPN Network with Two Autonomous Systems 11-10

Figure A-1 Cisco ISC: MPLS VPN Management in the Service Provider Network A-1

Figure A-2 Selecting the ISC Host A-9

Figure A-3 Hosts Configuration Window A-9

Figure A-4 GTL Options A-10

Figure A-5 Specifying the Device Access Protocol A-10

Figure A-6 TFTP Options A-11

Figure A-7 Specifying the Host as a TFTP Server A-11

Figure A-8 Specifying the Directory for the TFTP Server A-11

Figure A-9 Specifying the TFTP Root Directory A-12

Figure A-10 Collection Zones Option in Hosts TOC A-13
xxii
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Figures
Figure A-11 Creating a Collection Zone A-13

Figure A-12 Collection Zone Created A-14

Figure A-13 List of Devices Recognized by ISC A-14

Figure A-14 Specifying the Collection Zone for a Device A-15

Figure A-15 Selecting the Collection Zone A-15

Figure A-16 List of Devices in a Collection Zone A-16

Figure C-1 ISC Server Status C-3
xxiii
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Figures
xxiv
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

About This Guide

This chapter describes the objectives, audience, and organization of Cisco IP Solution Center MPLS 
VPN User Guide, 4.0. It also provides sources for obtaining documentation and technical assistance from 
Cisco Systems. This chapter contains the following sections:

• Objective of this Guide, page xxv

• Audience, page xxv

• Organization, page xxvi

• Related Documentation, page xxvi

• Obtaining Documentation, page xxvii

• Documentation Feedback, page xxviii

• Obtaining Technical Assistance, page xxviii

• Obtaining Additional Publications and Information, page xxix

Objective of this Guide
This guide describes how to use Cisco IP Solution Center (ISC) to configure and provision Multiprotocol 
Label Switching (MPLS) Virtual Private Network (VPN). This guide explains the concepts, tasks, and 
screen information that you need to set up the MPLS VPN network infrastructure in ISC and deploy the 
MPLS VPN service on the network.

Audience
This guide is designed for network engineers, service operators, and business managers who are 
responsible for configuring, provisioning, and managing MPLS VPN services on a network. Users of 
this documentation should be familiar with the following content:

• Basic concepts and terminology used in internetworking 

• MPLS VPN terms and technology 

• IP Network topologies and protocols 
xxv
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



About This Guide
Organization
Organization
This guide contains the following chapters:

Related Documentation
The entire documentation set for Cisco IP Solution Center, 4.0 can be accessed at: 

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/isc/4_0

The following documents comprise the ISC 4.0 documentation set.

General documentation (in suggested reading order):

Title Description

IP Solution Center—MPLS VPN Presents an overview of ISC MPLS VPN 
features and technology.

Provisioning an Unmanaged Multi-VRF CE Describes how to use the Inventory 
Manager and ISC GUI to implement 
unmanaged Multi-VRF CE from Device 
set up to Service Request.

MPLS VPN Service Policies Describes the Policy Manager GUI and 
work flow for MPLS VPN.

MPLS VPN Service Requests Describes the Service Requests GUI and 
work flow for MPLS VPN.

Provisioning Regular PE-CE Links Describes an end-to-end scenario for 
creating a Regular PE-CE link.

Provisioning MVRFCE PE-CE Links Describes an end-to-end scenario for 
creating an MVRFCE PE-CE link.

Provisioning Management VPN Describes how to provision a 
management VPN in ISC.

Provisioning Cable Services Describes how to provision MPLS VPN 
cable services.

Provisioning Carrier Supporting Carrier Describes how to provision Carrier 
Supporting Carrier.

Provisioning Multiple Devices Describes how to provision Ethernet to 
the Home, Hub and Spoke, and Ring 
Topologies.

Spanning Multiple Autonomous Systems Describes the network configuration for 
Spanning Multiple Autonomous Systems.

Setting Up the Network Describes how to configure network 
devices prior to provisioning MPLS VPN.

Service Request Transition States Describes the ISC Service Request 
Transition States.

Troubleshooting MPLS VPN Describes how to troubleshoot MPLS 
VPN.
xxvi
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/isc/4_0/index.htm


About This Guide
Obtaining Documentation
• Cisco IP Solution Center Documentation Guide, 4.0

• Cisco IP Solution Center Release Notes, 4.0

• Cisco IP Solution Center Installation Guide, 4.0

• Cisco IP Solution Center Infrastructure Reference, 4.0

• Cisco IP Solution Center System Error Messages, 4.0

Application and technology documentation (listed alphabetically):

• Cisco IP Solution Center L2VPN User Guide, 4.0

• Cisco IP Solution Center MPLS VPN User Guide, 4.0

• Cisco IP Solution Center Quality of Service User Guide, 4.0

• Cisco IP Solution Center Traffic Engineering Management User Guide, 4.0

API documentation:

• Cisco IP Solution Center API Programmer Guide, 4.0

• Index: Cisco IP Solution Center API Programmer Reference, 4.0 

Note All documentation might be upgraded.

Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several 
ways to obtain technical assistance and other technical resources. These sections explain how to obtain 
technical information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Ordering Documentation
You can find instructions for ordering documentation at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

You can order Cisco documentation in these ways:

• Registered Cisco.com users (Cisco direct customers) can order Cisco product documentation from 
the Ordering tool:

http://www.cisco.com/en/US/partner/ordering/index.shtml
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About This Guide
Documentation Feedback
• Nonregistered Cisco.com users can order documentation through a local account representative by 
calling Cisco Systems Corporate Headquarters (California, USA) at 408 526-7208 or, elsewhere in 
North America, by calling 1 800 553-NETS (6387).

Documentation Feedback
You can send comments about technical documentation to bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front cover of your 
document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance
For all customers, partners, resellers, and distributors who hold valid Cisco service contracts, Cisco 
Technical Support provides 24-hour-a-day, award-winning technical assistance. The Cisco Technical 
Support Website on Cisco.com features extensive online support resources. In addition, Cisco Technical 
Assistance Center (TAC) engineers provide telephone support. If you do not hold a valid Cisco service 
contract, contact your reseller.

Cisco Technical Support Website
The Cisco Technical Support Website provides online documents and tools for troubleshooting and 
resolving technical issues with Cisco products and technologies. The website is available 24 hours a day, 
365 days a year, at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support Website requires a Cisco.com user ID and password. 
If you have a valid service contract but do not have a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Note Use the Cisco Product Identification (CPI) tool to locate your product serial number before submitting 
a web or phone request for service. You can access the CPI tool from the Cisco Technical Support 
Website by clicking the Tools & Resources link under Documentation & Tools. Choose Cisco Product 
Identification Tool from the Alphabetical Index drop-down list, or click the Cisco Product 
Identification Tool link under Alerts & RMAs. The CPI tool offers three search options: by product ID 
or model name; by tree view; or for certain products, by copying and pasting show command output. 
Search results show an illustration of your product with the serial number label location highlighted. 
Locate the serial number label on your product and record the information before placing a service call.
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About This Guide
Obtaining Additional Publications and Information
Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 
and S4 service requests are those in which your network is minimally impaired or for which you require 
product information.) After you describe your situation, the TAC Service Request Tool provides 
recommended solutions. If your issue is not resolved using the recommended resources, your service 
request is assigned to a Cisco TAC engineer. The TAC Service Request Tool is located at this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the Cisco TAC by telephone. 
(S1 or S2 service requests are those in which your production network is down or severely degraded.) 
Cisco TAC engineers are assigned immediately to S1 and S2 service requests to help keep your business 
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553-2447

For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has established severity 
definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your business operations. You 
and Cisco will commit all necessary resources around the clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your 
business operation are negatively affected by inadequate performance of Cisco products. You and Cisco 
will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most business operations 
remain functional. You and Cisco will commit resources during normal business hours to restore service 
to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or 
configuration. There is little or no effect on your business operations.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is available from various online 
and printed sources.

• Cisco Marketplace provides a variety of Cisco books, reference guides, and logo merchandise. Visit 
Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

• The Cisco Product Catalog describes the networking products offered by Cisco Systems, as well as 
ordering and customer support services. Access the Cisco Product Catalog at this URL:

http://cisco.com/univercd/cc/td/doc/pcat/
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About This Guide
Obtaining Additional Publications and Information
• Cisco Press publishes a wide range of general networking, training and certification titles. Both new 
and experienced users will benefit from these publications. For current Cisco Press titles and other 
information, go to Cisco Press at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco Systems technical user magazine for maximizing Internet and 
networking investments. Each quarter, Packet delivers coverage of the latest industry trends, 
technology breakthroughs, and Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, certification and training 
information, and links to scores of in-depth online resources. You can access Packet magazine at 
this URL:

http://www.cisco.com/packet

• iQ Magazine is the quarterly publication from Cisco Systems designed to help growing companies 
learn how they can use technology to increase revenue, streamline their business, and expand 
services. The publication identifies the challenges facing these companies and the technologies to 
help solve them, using real-world case studies and business strategies to help readers make sound 
technology investment decisions. You can access iQ Magazine at this URL:

http://www.cisco.com/go/iqmagazine

• Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering 
professionals involved in designing, developing, and operating public and private internets and 
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

• World-class networking training is available from Cisco. You can view current offerings at 
this URL:

http://www.cisco.com/en/US/learning/index.html
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IP Solution Center—MPLS VPN

This chapter describes an overview of the Cisco IP Solution Center (ISC) Multiprotocol Label Switching 
(MPLS) virtual private network (VPN) system solution. This chapter contains the following major 
sections:

• IP Solution Center Overview, page 1-1 

• Service Provider Network, page 1-12

• MPLS VPN Security, page 1-27

IP Solution Center Overview
This section contains the following sections:

• Business Application, page 1-1

• System Architecture, page 1-2 

• System Features, page 1-7 

Business Application
ISC is a carrier-class network and service-management solution, designed especially for Cisco routing, 
switching, and security products. ISC addresses a growing customer demand for provisioning IP-based 
services with a single management platform. 

ISC provides IP-based services in four primary applications:

• MPLS VPN management

• Layer 2 VPN management

• Managed Security for IP security (IPsec) VPN, firewall, and Network Address Translation (NAT) 
management - IPsec, NAT, and Firewall are not supported in this release. - 

• Policy-based quality of service (QoS)

ISC provides a robust and centralized management platform that can manage the entire life-cycle of 
IP-based services, integrate with existing network management infrastructures, and easily accommodate 
the implementation of emerging new technologies.

Figure 1-1 shows how ISC integrates into the network life-cycle management process.
1-1
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IP Solution Center Overview
Figure 1-1 ISC Network Life-Cycle Management Process

ISC is also a scalable solution for service deployment. Service providers need a deployment tool if they 
want to deploy more than a relatively small number of VPNs. And a tool that can allocate and track the 
various number pools (IP addresses, RT, RD, VLAN ID, and VC ID) simplifies the service deployment 
model.

ISC integrates with other Cisco network management tools. Though not seen as a network monitoring 
tool in itself, ISC has an audit capability that allows service provider to track the validity of provisioned 
VPNs and other services. Through the SLA deployment capability, SNMP data can be generated on a 
per-VPN basis.

System Architecture
ISC features a four-tier, modular architecture with a distributed design and an emphasis on high 
performance, scalability, and availability. 

The four tiers consist of the following components:

• Client Tier: Web Browser or Client Application 

• Interface Tier: Web Servers or Server Farms

• Control Tier: Master Server and Database

• Distribution Tier: Processing and Collection Servers
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Figure 1-2 shows the four-tiered architecture.

Figure 1-2 Four-Tiered ISC Architecture

Client Tier

The client tier consists of web browsers (GUI) and client applications that access ISC through the 
application programming interface (API). Customers do not have to access ISC through the GUI. The 
northbound API can perform all system functions. The API allows you to tightly integrate ISC with your 
OSS environment. The web browsers communicate with the ISC web server through HTTP. The client 
applications communicate with the ISC CORBA server (the backward compatible API) or Web Server 
by way of XML/SOAP (the new API). 

Interface Tier

The interface tier contains one or more web servers in a web farm. As more operators need to access the 
system, the web farm can be scaled up by adding new web servers to the farm. The interface tier provides 
horizontal scalability for handling a large number of users. It also provides high availability. When one 
server in the farm goes away, the whole system continues to function and users can continue to interact 
with the system through other interface tier machines. This system allows the dynamic addition and 
removal of machines to and from the web farm. 

Control Tier 

The control tier consists of the ISC Repository (a relational database) and the task scheduling and 
distribution system. In ISC, there is only one control tier server. It is called the Master server. The Master 
server is the “nerve center” of the infrastructure; you can consider it identical to the ISC workstation 
itself. All vital information is stored in the Repository on the Master server. The Master server controls 
how tasks are distributed to the back-end system. 
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Distribution Tier

The distribution tier consists of the Processing servers and Collection servers. Each Processing server or 
Collection server runs on its own physical machine. Processing servers are responsible for executing 
tasks such as provisioning, auditing, SLA data collection, and so on. There can be one or more 
Processing server machines. 

A collection server is responsible for interacting with the network devices. For example, configuration 
upload and download to a Cisco router is through its Collection server. In other words, each Collection 
server owns a set of network devices. Collection servers and their geographically related network devices 
are organized into collection zones. There can be one or more Collection servers per installation. A 
Collection server is called into service when data is needed from one of the devices that it owns. 

Note Although the Web server, the Master server, the Processing server, and the Collection server are normally 
installed on different physical machines for large installations, they can be collapsed into a single 
machine for a small installation. In this case then, there is only one instance of the Web server, 
Processing server, and Collection server.

Additional Features

The ISC design has the following additional features:

• Addresses scalability at the front-end (client and interface tiers) and back-end (control and 
distribution tiers).

• Ensures consistency of data and visibility among applications, with a cohesive service model.

• Interface Tier: Sustains many concurrent users. Can be separate hardware, web-based multi-access.

• Control Tier: Central control and system monitoring.

• Distribution Tier: Supports large numbers of concurrent running tasks. Can be separate hardware.

The ISC four-tier architecture allows scaling at any level on any or all of the four tiers. 

For instance, if deployment operators are in widely scattered locations, multiple interface servers can be 
deployed to speed the input of these operators. Also, given that the slowest part of the deployment 
process is connecting to the network devices involved, multiple provisioning servers can be controlled 
by a single Master server. Complete management of all servers can be conducted from a single point, the 
Master server. 

The built-in Watchdog process on all servers restarts server processes as necessary, and all distributed 
Watchdog servers report to the Master server Watchdog process.

The Distribution Tier can be scaled horizontally to support a large number of concurrent running tasks. 
The software architecture consists of two major subsystems, the Processing Server and the Collection 
Server. Jobs are distributed to the Processing Servers in parallel by the Task Manager and Job 
Distribution Framework.

Each Processing and Collection Server has a watchdog process that reports statistics and health 
information to the Master Watchdog. All remote servers are monitored and configured from the Central 
Location (Master in Control Tier).

The Master server verifies the presence of the collection and processing servers by sending a keep-alive 
(heartbeat polling).

Load Balancing

The major aspects of distributed load balancing in ISC are as follows:
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• The Master server (which can be considered to be identical to the ISC Solaris workstation) 
distributes jobs to processing servers by way of a sophisticated load-balancing algorithm.

• The Processing server can be added dynamically. The Watchdog will discover their existence when 
you start up ISC.

• Each Collection server is responsible for a set of collection zones. Each zone has one Collection 
Server. 

• Both Processing servers and Collection servers failover to the Master server automatically. 

• Each device belongs to a zone, but a device can be relocated to a different zone as needed.

If the service provider has implemented one or more Processing servers or Collection servers, all the 
servers—Master, Processing, and Collection servers—are listed in the Administration Control Center.

The Remote server can also be installed from the Control Center.

All Remote servers are monitored by Watchdogs. Remote Watchdogs report statistics to the Master 
Watchdog. You can start and stop all the servers from the Administration Control Center. Logs are 
available for viewing in real time.

Figure 1-3 shows the topology for a simple flat-based load-balancing configuration.

Figure 1-3 Simple Flat-Based Server Load Balancing Configuration

Figure 1-4 on page 1-6 shows a flat-based route-path server load balancing configuration with 
redundancy built into the topology.
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Figure 1-4 Redundant Load Balancing Configuration
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System Features
Table 1-1 describes the ISC system features.

Table 1-1 ISC System Features

Feature Description Benefit 

Auto-Discovery of MPLS 
VPN Services

Discovers MPLS VPN services that were 
configured prior to ISC activation on the 
service provider network

Service providers could have manually 
configured several MPLS VPN services for 
customers. To continue managing these 
services, ISC MPLS VPN Service 
Discovery can be used to discover these 
services and continue managing them using 
ISC.

Automatic Resource 
Allocation 

• Allows the automatic allocation of 
parameters during MPLS VPN 
provisioning such as Router Target (RT), 
Route Distinguisher (RD), AS 
(Autonomous System Number for BGP 
Version 4), and VRF name

• Enables the service operator to 
automatically allocate resources such as IP 
addresses, VLAN, Route Distinguisher, 
and Router Target

Automatic Resource Assignment relieves 
the service operator from manually entering 
certain parameters during service 
activation. ISC keeps track of all the 
allocated resources and to which service, 
customer, or site these resources were 
allocated.

Backup and Restore ISC has the system capability to make backups 
of your database and to restore data from a 
backup. 

The backup and restore capabilities of ISC 
protect your data against operating system 
crashes, file corruption, disk failures, and 
total machine failure.

Distributed architecture ISC is a four-tiered system consisting of client, 
interface, control, and distribution tiers. 

Offers a scalable and reliable architecture 
for large-scale operations. 

Grey Management VPN Supports the management MPLS VPN. All the 
CEs that are managed by service providers can 
also be added to the management VPN 

All service provider managed CEs can be 
added to the grey management VPN in 
order to be managed and monitored

Inter-AS Management Manages the provisioning of inter-AS MPLS 
VPN Services.

The provisioning across AS can be 
problematic. In MPLS VPN, multiple 
providers can inter-operate their network 
using different BGP Autonomous System 
numbers

L2 Access into MPLS VPN ISC allocates VLANs for customers and maps 
the VLAN to a MPLS VPN at the PE level

Using Ethernet switches to distribute 
service to customers is one of the most 
cost-effective ways to deliver services. ISC 
can handle L2 Access Domain with 
aggregation or ring topologies.

In more and more cases, service providers 
utilize L2 Ethernet switches to distribute 
their services to customers. L2 Access 
Domain can be in an aggregation or ring 
topology.
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Managed and Unmanaged CE Handles managed and unmanaged CPE ISC smart management can handle the 
managed and unmanaged CE scenarios.

MPLS VPN Carrier 
Supporting Carrier (CSC) 
Support

MPLS supports the Carrier supporting Carrier 
(CSC) deployment scenario using LDP/IGP 
and BGP/MPLS. 

The carrier supporting carrier feature 
enables one MPLS VPN-based service 
provider to allow other service providers to 
use a segment of its backbone network. 

Multicast VPN Allows service providers to support multicast 
traffic in a MPLS VPN environment

ISC offers the configuration and monitoring 
of Multicast MPLS VPNs.

MPLS VPNs only support unicast traffic 
connectivity. Deploying the Multicast VPN 
feature in conjunction with MPLS VPN 
allows service providers to offer both 
unicast and multicast connectivity to MPLS 
VPN customers.

Northbound Interface CORBA 
and XML over HTTP

Integrates with other OSS FCAPS 
applications; ISC provides CORBA for 
backward compatibility with VPNSC 2.2 and, 
going forward, provides XML over 
HTTP/HTTPS

Other FCAPS OSS applications need access 
to ISC VPN topology information, by way 
of its northbound interface, to offer 
flow-through provisioning, extracting the 
VPN customer information, for example, 
for any fault application.

Policy-Based Provisioning Defines provisioning parameters in a Service 
Policy to be used during service activation

A Service Policy captures provisioning 
parameters, such as PE-CE protocol, IP 
numbering, and VLAN Auto-Allocation. 

Using Service Policies for service 
activation greatly reduces the workload for 
service operators. Parameters required for 
service activation are captured up front in 
the service policy.

Provisioning Based on Current 
Network 

Uploads the configuration of the network 
elements to calculate the delta configuration 
needed to have a successful service activation, 
prior to service activation

There is always a possibility that the 
network configuration could have varied 
since the last snap-shot. By uploading the 
configuration prior to applying the 
configuration, ISC ensures that the service 
activation configuration will be 
successfully applied and will not collide 
with the existing configuration.

Quality of Service (QOS)  
Provisioning

A QOS service policy captures all the QOS 
provisioning parameters for a collection of 
access circuits between a CE and PE. 

QoS service policy greatly reduces the 
service operator's tasks because it allows 
the configuration of QoS parameters and 
their association to access circuits. 

Role-based Access Control Implements Role-based Access Control that 
gives very granular access privileges to ISC 
users

Role-based Access Control gives access 
control to the service providers who want to 
implement strict operational processes.

Table 1-1 ISC System Features (continued)

Feature Description Benefit  (continued)
1-8
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Chapter 1      IP Solution Center—MPLS VPN
IP Solution Center Overview
Template Manager

The Template Manager in ISC is a provisioning system that provides fast, flexible, and extensible Cisco 
IOS command generation capability. The Template Manager defines standard templates to generate 
Cisco IOS configurations for common provisioning tasks, such as common IPv4, QoS, and VPN 
provisioning.

• A template file is a file created by the Template Manager that stores a ISC template definition.

• A template data file is a text file that stores variable values to generate the template file. A valid data 
file contains name-value pairs for all the variables defined in a template. Each template file can be 
associated with multiple data files; however, note that each data file can only be associated with a 
single template. You can select which data file to use to generate a template. The filename suffix for 
data files is .dat.

• A template configuration file is an IOS configuration file that stores the Cisco IOS commands 
created by the Template Manager. A template configuration file can be either a partial or complete 
configuration file. When you generate a template configuration file using a particular data file, the 
template configuration filename is the same as the data file’s name.

The template data files are tightly linked with its corresponding template. You can use a data file and its 
associated template to create a template configuration file. The template configuration file is merged 
with (either appended to or prepended to) the ISC configlet. ISC downloads the combined configlet to 
the edge device router.

You can apply the same template to multiple edge devices, assigning the appropriate template data file 
for each device. Each template data file includes the specific data for a particular device (for example, 
the management IP address or host name of each device). 

The template files and data files are in XML format. The template file, its data files, and all template 
configuration file files are mapped to a single directory.

• ISC creates the initial ISC configlet. Through the Template Manager, you can create a template 
configuration file. You can then associate a template configuration file with a service request, which 
effectively merges the ISC configlet and the template configuration file. You can then download this 
merged ISC configlet to the target router (or routers).

• You can also create a template configuration file and download it directly to a router. 

Service providers can use the Template Manager to enhance ISC functionality. You can use the Template 
Manager to provide initial configuration for any service provider core device or edge device.

Routing Protocols • OSPF 

• EIGRP 

• RIP 

• Static 

• BGP 

ISC offers most widely used routing 
protocols for PE-CE links.

Thin Client Web GUI  Provides a web-based thin client for user 
interface

ISC offers a thin web-based client that is 
easy to use. Network operators require less 
training.

VRF Lite and Multi-VRF CE VRF Lite CE management ISC offers VRF Lite CE for enhanced VPN 
traffic separation and security up to the CE.

Table 1-1 ISC System Features (continued)

Feature Description Benefit  (continued)
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The Template Manager can be used as a stand-alone tool to generate complete configuration files that 
you can download to any ISC target.

Some of the additional uses for templates are as follows:

• IOS firewall provisioning - Firewall is not supported in this release. -

• Add a set of commands that ISC does not include to a service request; for example, provisioning 
ATM Class of Service.

• Use the template feature to apply Class of Service using IP connectivity.

Download a ISC service request and an Cisco IOS configuration file in one download operation through 
the console. This edge device staging method would create a template and apply the service request in 
one step.

Role-Based Access Control (RBAC)

The central notion of role-based access control (RBAC) is that permissions are associated with roles, and 
users are made members of appropriate roles. Access control policy is embodied in various components 
of RBAC, such as role-permission, user-role, and role-role relationships. These components determine 
whether a particular user will be allowed to access a particular piece of data in the system.

The Role object specifies a set of occupants and the privileges or permissions granted to those occupants. 
There are several ways for constructing a role. 

A role can represent competency to do specific tasks, such as a technician or a support engineer. A 
technician can collect edge device and interface information and import them into the ISC Repository. 
A support engineer (service operator) can create policies, submit service requests and deploy them.

A role can reflect specific duty assignments, for example, an engineer can be assigned to provision 
customer Acme’s VPN. The operator might not be allowed to provision the competitor customer 
Widget’s VPN.

A role can have distinct authority, for example, VPN customer AcmeInc should be allowed only to view 
or make minor change on Acme’s VPN data. The customer should not be allowed to access any other 
customer’s VPN data.

There can be a role hierarchy in which a super user has all the permissions allowed to two different roles.

The service provider can define a role for each VPN customer, for example Acme and Widgets. The 
acme_customers role and the Widgets_customers role are mutually exclusive roles. The same user can 
be assigned to no more than one role in a mutually exclusive set. Role constraint supports separation of 
duties.

ISC supports full Role-Based Access Control to the system resources. Each Role defines limited access 
to the resources with a set of permissions: view, create, update, delete, and execute. This same access 
mechanism is also given to a group. When a user is part of a group, he inherits the group’s access 
privileges.

Each user can be assigned one or many roles. Each user will be shown only the resources and services 
that he or she is allowed to create view, modify, or delete. Using the access privileges that the user has 
been allocated, the display and action allowed are adjusted accordingly.

North Bound Interface (NBI)

The user’s Web browsers communicate with IP Solution Center Web server through HTTP, and the client 
applications communicate with ISC’s CORBA server (backward compatible API) or through the Web 
server by way of XML/SOAP.
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API Functionality Supported

API support is provided for the following services:

• QoS Service

• Layer 2 VPN Service

• MPLS VPN Service

• Inventory

• IPsec VPN Service - IPsec is not supported in this release. - 

• FireWall Service - Firewall is not supported in this release. - 

• NAT Service - NAT is not supported in this release. - 

• SLA 

• Tasks

• Template Manager

NBI Benefits

The benefits of the north-bound interface are as follows:

• Supports ISC services and inventory

• XML-based management interface

• Web-based

• Human-readable encoding

• Initial transport support is HTTP/SOAP

• API based on domain manager convergence API

API Approach

The API approach is as follows:

• Standards based encoding of management operations and payload.

• Layered approach combines need for rigor with flexibility (HTTP, SOAP, CIM Operations, Data 
Model).

• Leverages XML technology and adds a management framework.

• Allows for polling-based management, event-based management, and synchronous, and 
asynchronous services.

• Facilities for reliability: event numbering, tagging of requests.

• Facilities for security/RBAC.

• Standardized error semantics.

Transport protocol agnostic.
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Service Provider Network
The ISC provisioning engine accesses the configuration files on both the CE and PE to compute the 
necessary changes o those files that are required to support the service on the PE-CE link. A customer 
edge router (CE) is connected to a provider edge router (PE) in such a way that the customer’s traffic is 
encapsulated and transparently sent to other CEs, thus creating a virtual private network. CEs advertise 
routes to the VPN for all the devices in their site. 

Figure 1-5 shows all the major elements and devices that a service provider can employ to fully deploy 
ISC MPLS VPN management services.

Figure 1-5 ISC MPLS VPN Management in the Service Provider Network

The notable ISC network elements are as follows:

• ISC Network Management Subnet

The ISC Network Management Subnet is required when the service provider’s service offering 
entails the management of CEs. The management subnet consists of the ISC workstation (where ISC 
is installed). On the same LAN, the service provider can optionally install one or more Processing 
servers. The Processing servers are responsible for executing tasks such as provisioning, auditing, 
SLA data collection, and so on. 

• The Management VPN

The Management VPN is a special VPN employed by the ISC Network Management Subnet to 
manage the CEs in a service provider network. Once a CE is in a VPN, it is no longer accessible by 
means of conventional IPv4 routing, unless the CEs are part of the Management VPN. To 
communicate with the PEs, the link between the Management PE (MPE) and the Management-CE 
(MCE) uses a parallel IPv4 link. The Management VPN connects to the managed CEs.

• Multi-VRF CE

The Multi-VRF CE is a feature that provides for Layer 3 aggregation. Multiple CEs can connect to 
a single Multi-VRF CE (typically in an enterprise network); then the Multi-VRF CE connects 
directly to a PE. Figure 1-5 shows CE 1 and CE2 connected to the Multi-VRF CE, and the 
Multi-VRF CE is connected directly to the PE. For details, see Multi-VRF CE, page 1-18.

• Layer 2 Access to MPLS VPNs

CE

CE 1

CE 5

CE 2 Multi-VRF
CE

89
99

6

ISC network management subnet

Service Provider
network

IP Solution
Center

Processing
server

Collection
server

Collection
server

Service provider
MPLS core

Management CE

Management PE
Management VPN

PE

PE 1 PE 2 CE 3

CE 4

Catalyst
2950 switch

Catalyst 3550
Ethernet switch
1-12
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Chapter 1      IP Solution Center—MPLS VPN
Service Provider Network
The service provider can install multiple Layer 2 switches between a PE and CE, as shown in 
Figure 1-5. This feature provides Layer 2 aggregation. Additional CEs can be connected to the 
switches as well. Cisco supports two switches for the Layer 2 access to MPLS: either a Cisco 
Catalyst 2950 Switch or a Cisco Catalyst 3550 Intelligent Ethernet Switch. 

• Collection Servers

Cisco ISC is designed to provision a large number of devices through its distributed architecture. If 
the Master server (equivalent to the ISC workstation) cannot keep up with the number of devices, 
Collection servers can be added to offload the work of the Master server. Among other tasks, 
Collection servers are responsible for uploading and downloading configuration files to and from 
Cisco routers. For more information, see Defining Collection Zones and Assigning Devices to 
Zones, page A-12.

An MPLS VPN consists of a set of sites that are interconnected by means of an MPLS provider core 
network. At each site, there are one or more CEs, which attach to one or more PEs. PEs use the Border 
Gateway Protocol-Multiprotocol (MP-BGP) to dynamically communicate with each other. 

It is not required that the set of IPv4 addresses used in any two VPNs be mutually exclusive because the 
PEs translate IPv4 addresses into IPv4 VPN entities by using MP-BGP with extended community 
attributes.

The set of IP addresses used in a VPN, however, must be exclusive of the set of addresses used in the 
provider network. Every CE must be able to address the PEs to which it is directly attached. Thus, the 
IP addresses of the PEs must not be duplicated in any VPN.

One of ISC key features is to hide much of the complexity in dealing with the deployment of Metro 
services. 

• Autodiscovery: ISC supports Autodiscovery of network elements, of network topology, and MPLS 
VPN services. This feature greatly reduces the initial effort needed to insert ISC in the service 
provider’s operation. For details, see Chapter 2, “Provisioning an Unmanaged Multi-VRF CE.”

• Managed CLE: ISC offers the capability of managing the Customer Located Equipment (CLE), 
which gives the service provider the possibility of offering a managed Metro Service to their 
customer (configuration, monitoring, and auditing of the managed CLE). 

• Plug and Play: As the network and customer base grow, network elements can be added to the 
network. ISC, working in collaboration with CNS Intelligent Agents, is able to detect newly added 
Network Elements. 

This gives the service provider the ability to rapidly deploy services and network elements. 

• End-To-End Service Management: ISC manages the entire end-to-end provisioning of MPLS 
VPN services. Assuming that the network operator defined MPLS VPN service policy and the 
parameters that are to be editable by the service operator during the provisioning process, ISC 
translates these service requirements into IOS configurations. ISC does a just-in-time Cisco IOS 
configuration download, which consist of always validating the configuration of the real devices 
before applying the needed configuration. 

After a service is configured, ISC makes sure that the service configuration is the intended one by 
checking the configuration and verifying that VPN routing is operational.

• VLAN ID Management: ISC allocates VLAN IDs per customer and per Ethernet Service deployed. 
The service provider can track per Access Domain a particular allocated VLAN ID (per service or 
per customer or per Access Domain). 

ISC keeps track of the VLANs allocated and gives detailed usage information of the VLAN 
allocated per service, per customer, or per Access Domain. 
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Access Domain: The Layer 2 Ethernet switching domain attached to a PE defines an access domain. 
All the switches attached to the PE-POP belong to the access domain (as illustrated in Figure 1-7). 
This notion enables the network operator to tie multiple VLAN pools to a single Access Domain, 
and also allows redundancy with dual PEs in a single Access Domain. 

For illustration purpose, let’s assume that a Service Provider has a network such as the one 
illustrated in Figure 1-6. A customer has two sites (Chicago and New York), and would like to get 
an Ethernet Wire Service between the two sites. 

Figure 1-6 Service Provider Network for VLAN ID Management

1. If the network operator has chosen the Auto-Pick VLAN ID option in the service policy (see 
Specifying the PE and CE Interface Parameters, page 3-10), the network operator must assign an 
access domain and a VLAN pool for a given PE-POP. 

This automatically gives ISC the range of VLAN IDs that are attached to the access domain. 

Figure 1-7 shows the access domain assigned, with PE-POP 1, CLE 1, and CLE 2 defined within the 
access domain.
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Figure 1-7 Access Domain Assigned

2. All the network elements have been discovered during the Autodiscovery process, and the network 
topology (connectivity between sites). 

3. The service operator wants to deploy an Ethernet over MPLS service from Chicago to New York. 

4. Using ISC’s GUI, the service operator needs to select the From and To ports, and the appropriate 
service policy that allows VLAN IDs in the Access Domain to be picked automatically.

5. ISC allocated a VLAN ID for Chicago and a VLAN ID for New York. (Both sites belong to the same 
customer.)

6. VLAN IDs are allocated and assigned.

Resource Pools
ISC enables multiple pools to be defined and used during deployment operations. The following resource 
pools are available: 

• VLAN ID pool: VLAN ID pools are defined with a starting value and a size of the VLAN pool. A 
given VLAN ID pool can be attached to an Access Domain. During the deployment an Ethernet 
Service (EWS, ERS for example), VLAN ID can be auto-allocated from the Access Domain’s 
VLAN pools. This gives the Service Provider a tighter control of VLAN ID allocation. 

• IP address pool: The IP address pool can be defined and assigned to regions.

• Multicast pool: The Multicast pool is used for Multicast MPLS VPNs. 

• Route Target (RT) pool: A route target is the MPLS mechanism that informs PEs as to which routes 
should be inserted into the appropriate VRFs. Every VPN route is tagged with one or more route 
targets when it is exported from a VRF and offered to other VRFs. The route target can be considered 
a VPN identifier in MPLS VPN architecture. RTs are a 64-bit number.
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• Route Distinguisher (RD) pool: The IP subnets advertised by the CE routers to the PE routers are 
augmented with a 64-bit prefix called a route distinguisher (RD) to make them unique. The resulting 
96-bit addresses are then exchanged between the PEs, using a special address family of 
Multiprotocol BGP (referred to as MP-BGP). The RD pool is a pool of 64-bit RD values that ISC 
uses to make sure the IP addresses in the network are unique.

• Site of origin pool: The pool of values for the site-of-origin attribute. The site-of-origin attribute 
prevents routing loops when a site is multihomed to the MPLS VPN backbone. This is achieved by 
identifying the site from which the route was learned, based on its SOO value, so that it is not 
readvertised back to that site from a PE in the MPLS VPN network.

All these resources, that are made available to the service provider, enable the automation of service 
deployment.

VPN Profile
For all MPLS VPN provisioning, several network elements that participate in the VPN must be defined. 
These parameters are: 

• Choice of protocols between PE-CE and their intrinsic characteristics. 

• IP addressing for each site joining the IP VPN 

• VRF configuration (export map, import map, maximum number of routes, VRF and RD override, 
and so forth)

• Choice of joining the VPN as hub or spoke

• Choice of interfaces on the PE, CE, and intermediate network devices

All the provisioning parameters can be made editable for a service operator who will deploy the service. 
A service policy is defined by a network operator and used by a service operator. 

A service policy defines the parameters that will be used during provisioning. 

Each of these parameters can be made editable or not to the inexperienced service operator. The fact that 
a service can be profiled greatly simplifies the service operator’s tasks and has now only limited number 
of parameters to enter during the provisioning process to deploy and activate a MPLS VPN service. 

Customer View 
From the customer’s point of view, they see their internal routers communicating with their customer 
edge routers (CEs) from one site to another through a VPN managed by the service provider (see 
Figure 1-8).
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Figure 1-8 The Customer’s View of the Network

This simple view of the customer’s network is the advantage of employing VPNs: the customer 
experiences direct communication to their sites as though they had their own private network, even 
though their traffic is traversing a public network infrastructure and they are sharing that infrastructure 
with other businesses.

Provider View
The service provider’s view of the network is naturally very different, as shown in Figure 1-9. This 
illustration shows two different customers, with each customer having a single VPN. A customer can, 
however, have multiple VPNs.
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Figure 1-9 Service Provider’s View of the Network

Provider Edge Routers 
At the edge of the provider network are provider edge routers (PEs). Within the provider network are 
other provider routers as needed (often designated as P routers) that communicate with each other and 
the PEs by way of the Border Gateway Protocol-Multiprotocol (MP-BGP). Note that in this model, the 
service provider need only provision the links between the PEs and CEs.

PEs maintain separate routing tables called VPN routing and forwarding tables (VRFs). The VRFs 
contain the routes for directly connected VPN sites only. (For more information about VRFs, see VPN 
Routing and Forwarding Tables, page 1-22). PEs exchange VPN-IPv4 updates through MP-iBGP 
sessions. These updates contain VPN-IPv4 addresses and labels. The PE originating the route is the next 
hop of the route. PE addresses are referred to as host routes into the core interior gateway protocol.

Multi-VRF CE
The Multi-VRF CE is a feature that provides for Layer 3 aggregation. Multiple CEs can connect to a 
single Multi-VRF CE (typically in an enterprise network); then the Multi-VRF CE connects directly to 
a PE. A Multi-VRF CE can be a Cisco router or a Cisco Catalyst® 3550 Intelligent Ethernet Switch.

The Multi-VRF CE functionality extends some of the functionality formerly reserved to the PE to a CE 
router in an MPLS VPN—the only PE-like functionality that this feature provides is the ability to have 
multiple VRFs on the CE router so that different routing decisions can be made. The packets are sent 
toward the PE as IP packets.

With this feature, a Multi-VRF CE can maintain separate VRF tables to extend the privacy and security 
of an MPLS VPN down to a branch office, rather than just at the PE router node.
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A Multi-VRF CE is unlike a CE in that there is no label exchange, no LDP adjacency, and no labeled 
packet flow between the PE and the CE. Multi-VRF CE routers use VRF interfaces to form a VLAN-like 
configuration on the customer side. Each VRF on the Multi-VRF CE router is mapped to a VRF on the 
PE router. 

Figure 1-10 illustrates one method in which a Multi-VRF CE can be used. The Multi-VRF CE router 
associates a specific VRF by the CEs connected to its interfaces and exchanges that information with the 
PE. Routes are installed in the VRF on the Multi-VRF CE. There also needs to be a routing protocol or 
a static route that propagates routes from a specific VRF on the Multi-VRF CE to the corresponding VRF 
on the PE.

Figure 1-10 A Multi-VRF CE Providing Layer 3 Aggregation

The Multi-VRF CE feature can segment its LAN traffic by placing each CE with its own IP address 
space. To differentiate each CE, each interface contains its own IP address space.

When receiving an outbound customer data packet from a directly attached interface, the Multi-VRF CE 
router performs a route lookup in the VRF that is associated with that site. The specific VRF is 
determined by the interface or subinterface over which the data packet is received. Support for multiple 
forwarding tables makes it easy for the Multi-VRF CE router to provide segregation of routing 
information on a per-VPN basis before the routing information is sent to the PE. The use of a T1 line 
with multiple point-to-point subinterfaces allows traffic from the Multi-VRF CE router to the PE router 
to be segmented into each corresponding VRF.

With a Multi-VRF CE, the data path is as follows from the CEs to PE 1 (as shown in Figure 1-10):

1. The Multi-VRF CE learns the VPN Red routes to CE 1 from an interface directly attached to the 
Multi-VRF CE. 

2. The Multi-VRF CE then installs these routes into the VRF on the Multi-VRF CE (VRF Red).

3. PE 1 learns the VPN Red routes to CE 1 from the same VRF Red and installs the routes into 
VRF Red on PE-1.

Service Audit
A service request audit verifies that service requests are deployed on the network. You can audit new or 
existing requests. A service request audit can be scheduled on a regular basis to verify the state of the 
network provisioning requests. The audit verifies the following:

• Verifies the IOS configuration on all network devices.
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• Verifies the routing tables and routing for the VPN.

ISC audits against the Repository, not the network. The service operator should schedule auditing after 
the collection of configuration and routing tables has taken place. 

Auditing an existing service request involves three tasks:

• Collects configuration

• Collects routing

• Runs an audit against the specified service requests

Auditing Report Services

Audit reports provide these services:

• Audit New Services: Handles auditing of services requested but not yet deployed (that is, the 
configuration is not apparent in the router).

The Audit New Services also identifies problems with the download of configuration files to routers

• Audit Existing Services: Checks and evaluates configuration of deployed service to see if the service 
is still in effect.

• Audit Routing Reports: Checks the VRF for the VPN on the PE. This report also checks if VPN 
connectivity is operational by evaluating reachability of the network devices in the VPN.

MPLS VPN
At its simplest, a virtual private network (VPN) is a collection of sites that share the same routing table. 
A VPN is also a network in which customer connectivity to multiple sites is deployed on a shared 
infrastructure with the same administrative policies as a private network.The path between two systems 
in a VPN, and the characteristics of that path, might also be determined (wholly or partially) by policy. 
Whether a system in a particular VPN is allowed to communicate with systems not in the same VPN is 
also a matter of policy. 

In MPLS VPN, a VPN generally consists of a set of sites that are interconnected by means of an MPLS 
provider core network, but it is also possible to apply different policies to different systems that are 
located at the same site. Policies can also be applied to systems that dial in; the chosen policies would 
be based on the dial-in authentication processes.

A given set of systems can be in one or more VPNs. A VPN can consist of sites (or systems) that are all 
from the same enterprise (intranet), or from different enterprises (extranet); it might consist of sites (or 
systems) that all attach to the same service provider backbone, or to different service provider 
backbones.

Figure 1-11 VPNs Sharing Sites
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MPLS-based VPNs are created in Layer 3 and are based on the peer model, which makes them more 
scalable and easier to build and manage than conventional VPNs. In addition, value-added services, such 
as application and data hosting, network commerce, and telephony services, can easily be targeted and 
deployed to a particular MPLS VPN because the service provider backbone recognizes each MPLS VPN 
as a secure, connectionless IP network. 

The MPLS VPN model is a true peer VPN model that enforces traffic separations by assigning unique 
VPN route forwarding tables (VRFs) to each customer’s VPN. Thus, users in a specific VPN cannot see 
traffic outside their VPN. Traffic separation occurs without tunneling or encryption because it is built 
directly into the network. (For more information on VRFs, see VPN Routing and Forwarding Tables, 
page 1-22.)

The service provider’s backbone is comprised of the PE and its provider routers. MPLS VPN provides 
the ability that the routing information about a particular VPN be present only in those PE routers that 
attach to that VPN.

Characteristics of MPLS VPNs

MPLS VPNs have the following characteristics:

• Multiprotocol Border Gateway Protocol-Multiprotocol (MP-BGP) extensions are used to encode 
customer IPv4 address prefixes into unique VPN-IPv4 Network Layer Reachability Information 
(NLRI) values.

NLRI refers to a destination address in MP-BGP, so NLRI is considered “one routing unit.” In the 
context of IPv4 MP-BGP, NLRI refers to a network prefix/prefix length pair that is carried in the 
BGP4 routing updates.

• Extended MP-BGP community attributes are used to control the distribution of customer routes.

• Each customer route is associated with an MPLS label, which is assigned by the provider edge router 
that originates the route. The label is then employed to direct data packets to the correct egress 
customer edge router. 

When a data packet is forwarded across the provider backbone, two labels are used. The first label 
directs the packet to the appropriate egress PE; the second label indicates how that egress PE should 
forward the packet.

• Cisco MPLS CoS and QoS mechanisms provide service differentiation among customer data 
packets. 

• The link between the PE and CE routers uses standard IP forwarding.

The PE associates each CE with a per-site forwarding table that contains only the set of routes 
available to that CE.

Principal Technologies

There are four principal technologies that make it possible to build MPLS-based VPNs:

• Multiprotocol Border Gateway Protocol (MP-BGP) between PEs carries CE routing information

• Route filtering based on the VPN route target extended MP-BGP community attribute

• MPLS forwarding carries packets between PEs (across the service provider backbone)

• Each PE has multiple VPN routing and forwarding instances (VRFs)
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Intranets and Extranets
If all the sites in a VPN are owned by the same enterprise, the VPN is a corporate intranet. If the various 
sites in a VPN are owned by different enterprises, the VPN is an extranet. A site can be in more than one 
VPN. Both intranets and extranets are regarded as VPNs.

While the basic unit of connection is the site, the MPLS VPN architecture allows a finer degree of 
granularity in the control of connectivity. For example, at a given site, it might be desirable to allow only 
certain specified systems to connect to certain other sites. That is, certain systems at a site might be 
members of an intranet and members of one or more extranets, while other systems at the same site might 
be restricted to being members of the intranet only. 

A CE router can be in multiple VPNs, although it can only be in a single site. When a CE router is in 
multiple VPNs, one of these VPNs is considered its primary VPN. In general, a CE router’s primary VPN 
is the intranet that includes the CE router’s site. A PE router might attach to CE routers in any number 
of different sites, whether those CE routers are in the same or in different VPNs. A CE router might, for 
robustness, attach to multiple PE routers. A PE router attaches to a particular VPN if it is a router 
adjacent to a CE router that is in that VPN.

VPN Routing and Forwarding Tables
The VPN routing and forwarding table (VRF) is a key element in the MPLS VPN technology. VRFs exist 
on PEs only (except in the case of a Multi-VRF CE). A VRF is a routing table instance, and more than 
one VRF can exist on a PE. A VPN can contain one or more VRFs on a PE. The VRF contains routes 
that should be available to a particular set of sites. VRFs use Cisco Express Forwarding (CEF) 
technology, therefore the VPN must be CEF-enabled.

A VRF is associated with the following elements:

• IP routing table

• Derived forwarding table, based on the Cisco Express Forwarding (CEF) technology

• A set of interfaces that use the derived forwarding table

• A set of routing protocols and routing peers that inject information into the VRF

Each PE maintains one or more VRFs. ISC software looks up a particular packet’s IP destination address 
in the appropriate VRF only if that packet arrived directly through an interface that is associated with 
that VRF. The so-called “color” MPLS label tells the destination PE to check the VRF for the appropriate 
VPN so that it can deliver the packet to the correct CE and finally to the local host machine. 

A VRF is named based on the VPN or VPNs it services, and on the role of the CE in the topology. The 
schemes for the VRF names are as follows:

The VRF name for a hub: ip vrf Vx:[VPN_name]

The x parameter is a number assigned to make the VRF name unique.

For example, if we consider a VPN called Blue, then a VRF for a hub CE would be called:

ip vrf V1:blue 

A VRF for a spoke CE in the Blue VPN would be called:

ip vrf V1:blue-s

A VRF for an extranet VPN topology in the Green VPN would be called:

ip vrf V1:green-etc

Thus, you can read the VPN name and the topology type directly from the name of the VRF.
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Figure 1-12 shows a network in which two of the four sites are members of two VPNs, and illustrates 
which routes are included in the VRFs for each site.

Figure 1-12 VRFs for Sites in Multiple VPNs

VRF Implementation 
When implementing VPNs and VRFs, Cisco recommends you keep the following considerations in 
mind:

• A local VRF interface on a PE is not considered a directly-connected interface in a traditional sense. 
When you configure, for example, a Fast Ethernet interface on a PE to participate in a particular 
VRF/VPN, the interface no longer shows up as a directly-connected interface when you issue a show 
ip route command. To see that interface in a routing table, you must issue a show ip route 
vrf vrf_name command.

• The global routing table and the per-VRF routing table are independent entities. Cisco IOS 
commands apply to IP routing in a global routing table context. For example, show ip route, and 
other EXEC-level show commands—and utilities such as ping, traceroute, and telnet—all invoke 
the services of the Cisco IOS routines that deal with the global IP routing table.

• You can issue a standard Telnet command from a CE router to connect to a PE router. However, from 
that PE, you must issue the following command to connect from the PE to the CE:

telnet CE_RouterName /vrf vrf_name
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Similarly, you can utilize the Traceroute and Ping commands in a VRF context.

• The MPLS VPN backbone relies on the appropriate Interior Gateway Protocol (IGP) that is 
configured for MPLS, for example, EIGRP, or OSPF. When you issue a show ip route command on 
a PE, you see the IGP-derived routes connecting the PEs together. Contrast that with the show ip 
route vrf VRF_name command, which displays routes connecting customer sites in a particular 
VPN.

VRF Instance
The configuration commands to create a VRF instance are as follows:

Route Distinguishers and Route Targets
MPLS-based VPNs employ BGP to communicate between PEs to facilitate customer routes. This is 
made possible through extensions to BGP that carry addresses other than IPv4 addresses. A notable 
extension is called the route distinguisher (RD).

The purpose of the route distinguisher (RD) is to make the prefix value unique across the backbone. 
Prefixes should use the same RD if they are associated with the same set of route targets (RTs) and 
anything else that is used to select routing policy. The community of interest association is based on the 
route target (RT) extended community attributes distributed with the Network Layer Reachability 
Information (NLRI).The RD value must be a globally unique value to avoid conflict with other prefixes.

The MPLS label is part of a BGP routing update. The routing update also carries the addressing and 
reachability information. When the RD is unique across the MPLS VPN network, proper connectivity is 
established even if different customers use non-unique IP addresses.

For the RD, every CE that has the same overall role should use a VRF with the same name, same RD, 
and same RT values. The RDs and RTs are only for route exchange between the PEs running BGP. That 
is, for the PEs to do MPLS VPN work, they have to exchange routing information with more fields than 
usual for IPv4 routes; that extra information includes (but is not limited to) the RDs and RTs.

The route distinguisher values are chosen by the ISC software. 

• CEs with hub connectivity use bgp_AS:value. 

• CEs with spoke connectivity use bgp_AS:value + 1

Command Description

Step 1 Router# configure terminal

Router(config)#

Enter global configuration mode.

Step 2 Router(config)# ip vrf vrf_name For example, ip vrf CustomerA initiates a VPN routing table 
and an associated CEF table named CustomerA. The command 
enters VRF configuration submode to configure the variables 
associated with the VRF.

Step 3 Router(config-vrf)# rd RD_value Enter the eight-byte route descriptor (RD) or IP address. The PE 
prepends the RD to the IPv4 routes prior to redistributing the 
route into the MPLS VPN backbone.

Step 4 Router(config-vrf)# route-target import | 
export | both community

Enter the route-target information for the VRF.
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Each spoke uses its own RD value for proper hub and spoke connectivity between CEs; therefore, the 
ISC software implements a new RD for each spoke that is provisioned.

ISC chooses route target values by default, but you can override the automatically assigned RT values if 
necessary when you first define a CERC in the ISC software (see Defining CE Routing Communities, 
page 3-6).

Route Target Communities
The mechanism by which MPLS VPN controls distribution of VPN routing information is through the 
VPN route-target extended MP-BGP communities. An extended MP-BGP community is an eight octet 
structure value. MPLS VPN uses route-target communities as follows:

• When a VPN route is injected into MP-BGP, the route is associated with a list of VPN route-target 
communities. Typically, this is set through an export list of community values associated with the 
VRF from which the route was learned.

• An import list of route-target communities is associated with each VRF. This list defines the values 
that should be matched against to decide whether a route is eligible to be imported into this VRF.

For example, if the import list for a particular VRF is {A, B, C}, then any VPN route that carries 
community value A, B, or C is imported into the VRF. 

CE Routing Communities
A VPN can be organized into subsets called CE routing communities, or CERCs. A CERC describes how 
the CEs in a VPN communicate with each other. Thus, CERCs describe the logical topology of the VPN. 
ISC can be employed to form a variety of VPN topologies between CEs by building hub and spoke or 
full mesh CE routing communities. CERCs are building blocks that allow you to form complex VPN 
topologies and CE connectivity.

The most common types of VPNs are hub-and-spoke and full mesh.

• A hub-and-spoke CERC is one in which one or a few CEs act as hubs, and all spoke CEs talk only 
to or through the hubs, never directly to each other.

• A full mesh CERC is one in which every CE connects to every other CE.

These two basic types of VPNs—full mesh and hub and spoke—can be represented with a single CERC. 

Whenever you create a VPN, the ISC software creates one default CERC for you. This means that until 
you need advanced customer layout methods, you will not need to define new CERCs. Up to that point, 
you can think of a CERC as standing for the VPN itself—they are one and the same. If, for any reason, 
you need to override the software’s choice of route target values, you can do so only at the time you 
create a CERC in the ISC software (see Defining CE Routing Communities, page 3-6).

To build very complex topologies, it is necessary to break down the required connectivity between CEs 
into groups, where each group is either fully meshed, or has a hub and spoke pattern. (Note that a CE 
can be in more than one group at a time, so long as each group has one of the two basic patterns.) Each 
subgroup in the VPN needs its own CERC. Any CE that is only in one group just joins the corresponding 
CERC (as a spoke if necessary). If a CE is in more than one group, then you can use the Advanced Setup 
choice during provisioning to add the CE to all the relevant groups in one service request. Given this 
information, the provisioning software does the rest, assigning route target values and VRF tables to 
arrange exactly the connectivity the customer requires. You can use the Topology tool to double-check 
the CERC memberships and resultant VPN connectedness.
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ISC supports multiple CEs per site and multiple sites connected to the same PE. Each CERC has unique 
route targets (RT), route distinguisher (RD) and VRF naming. After provisioning a CERC, it is a good 
idea to run the audit reports to verify the CERC deployment and view the topologies created by the 
service requests. The product supports linking two or more CE routing communities in the same VPN.

Figure 1-13 shows several examples of the topologies that IP Solution Center CERCs can employ.

Figure 1-13 Examples of CERC Topologies

Hub and Spoke Considerations

In hub-and-spoke MPLS VPN environments, the spoke routers have to have unique Route Distinguishers 
(RDs). In order to use the hub site as a transit point for connectivity in such an environment, the spoke 
sites export their routes to the hub. Spokes can talk to hubs, but spokes never have routes to other spokes.

Due to the current MPLS VPN implementation, you must apply a different RD for each spoke VRF. The 
MP-BGP selection process applies to all the routes that have to be imported into the same VRF plus all 
routes that have the same RD of such a VRF. Once the selection process is done, only the best routes are 
imported. In this case this can result in a best route which is not imported. Thus, customers must have 
different RDs per spoke-VRF.

Full Mesh Considerations

Each CE Routing Community (CERC) has two distinct RTs: a hub RT and a spoke RT. When building a 
full mesh topology, always use the hub RT. Thus, when a need arises to add a spoke site for the current 
full mesh topology, you can easily add the spoke site without reconfiguring any of the hub sites. The 
existing spoke RT can be used for this purpose. This is a strategy to prevent having to do significant 
reprovisioning of a full mesh topology to a hub-and-spoke topology.
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MPLS VPN Security
This section discusses the security requirements for MPLS VPN architectures. This section concentrates 
on protecting the core network against attacks from the “outside,” that is, the Internet and connected 
VPNs. Protection against attacks from the “inside,” that is, when an attacker has logical or physical 
access to the core network is not discussed here, since any network can be attacked with access from the 
inside.

Address Space and Routing Separation
Between two non-intersecting VPNs of an MPLS VPN service, it is assumed that the address space 
between different VPNs is entirely independent. This means, for example, that two non-intersecting 
VPNs must be able to both use the 10/8 network without any interference. From a routing perspective, 
this means that each end system in a VPN has a unique address, and all routes to this address point to 
the same end system. Specifically: 

• Any VPN must be able to use the same address space as any other VPN. 

• Any VPN must be able to use the same address space as the MPLS core. 

• Routing between any two VPNs must be independent. 

• Routing between any VPN and the core must be independent. 

Address Space Separation

From a security point of view, the basic requirement is to avoid that packets destined to a host a.b.c.d 
within a given VPN reach a host with the same address in another VPN or the core. 

MPLS allows distinct VPNs to use the same address space, which can also be private address space. This 
is achieved by adding a 64-bit route distinguisher (RD) to each IPv4 route, making VPN-unique 
addresses also unique in the MPLS core. This “extended” address is also called a VPN-IPv4 address. 
Thus customers of an MPLS service do not need to change current addressing in their networks. 

In the case of using routing protocols between CE and PE routers (for static routing this is not an issue), 
there is one exception—the IP addresses of the PE routers the CE routers are peering with. To be able to 
communicate to the PE router, routing protocols on the CE routers must configure the address of the peer 
router in the core. This address must be unique from the CE router’s perspective. In an environment 
where the service provider manages also the CE routers as CPE (customer premises equipment), this can 
be made invisible to the customer. 

Routing Separation

Routing separation between the VPNs can also be achieved. Every PE router maintains a separate Virtual 
Routing and Forwarding instance (VRF) for each connected VPN. Each VRF on the PE router is 
populated with routes from one VPN, through statically configured routes or through routing protocols 
that run between the PE and the CE router. Since every VPN results in a separate VRF, there are no 
interferences between the VPNs on the PE router. 

Across the MPLS core to the other PE routers, this routing separation is maintained by adding unique 
VPN identifiers in multi-protocol BGP, such as the route distinguisher (RD). VPN routes are exclusively 
exchanged by MP-BGP across the core, and this BGP information is not redistributed to the core 
network, but only to the other PE routers, where the information is kept again in VPN-specific VRFs. 
Thus routing across an MPLS network is separate per VPN. 
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Given addressing and routing separation across an MPLS core network, MPLS offers in this respect the 
same security as comparable Layer 2 VPNs, such as ATM or Frame Relay. It is not possible to intrude 
into other VPNs through the MPLS core, unless this has been configured specifically. 

Hiding the MPLS Core Structure
The internal structure of the MPLS core network (PE and Provider router devices) should not be visible 
to outside networks (either the Internet or any connected VPN). While a breach of this requirement does 
not lead to a security problem itself, it is generally advantageous when the internal addressing and 
network structure remains hidden to the outside world. The ideal is to not reveal any information of the 
internal network to the outside. This applies equally to the customer networks as to the MPLS core.

Denial-of-service attacks against a core router, for example, are much easier to carry out if an attacker 
knows the IP address. Where addresses are not known, they can be guessed, but when the MPLS core 
structure is hidden, attacks are more difficult to make. Ideally, the MPLS core should be as invisible to 
the outside world as a comparable Layer 2 infrastructure (for example, Frame Relay or ATM).

In practice, a number of additional security measures have to be taken, most of all extensive packet 
filtering. MPLS does not reveal unnecessary information to the outside, not even to customer VPNs. The 
addressing in the core can be done with either private addresses or public addresses. Since the interface 
to the VPNs, and potentially to the Internet, is BGP, there is no need to reveal any internal information. 
The only information required in the case of a routing protocol between a PE and CE is the address of 
the PE router. If this is not desired, you can configure static routing between the PE and CE. With this 
measure, the MPLS core can be kept completely hidden. 

To ensure reachability across the MPLS cloud, customer VPNs will have to advertise their routes as a 
minimum to the MPLS core. While this could be seen as too open, the information known to the MPLS 
core is not about specific hosts, but networks (routes); this offers some degree of abstraction. Also, in a 
VPN-only MPLS network (that is, no shared Internet access), this is equal to existing Layer 2 models, 
where the customer has to trust the service provider to some degree. Also in a Frame Relay or ATM 
network, routing information about the VPNs can be seen on the core network. 

In a VPN service with shared Internet access, the service provider typically announces the routes of 
customers that wish to use the Internet to his upstream or peer providers. This can be done by way of a 
network address translation (NAT) function to further obscure the addressing information of the 
customers’ networks. In this case, the customer does not reveal more information to the general Internet 
than with a general Internet service. Core information is not revealed at all, except for the peering 
addresses of the PE router) that hold the peering with the Internet. - NAT is not supported in this 
release. -

In summary, in a pure MPLS VPN service, where no Internet access is provided, the level of information 
hiding is as good as on a comparable Frame Relay or ATM network—no addressing information is 
revealed to third parties or the Internet. If a customer chooses to access the Internet by way of the MPLS 
core, he will have to reveal the same addressing structure as for a normal Internet service. NAT can be 
used for further address hiding. - NAT is not supported in this release. -

If an MPLS network has no interconnections to the Internet, this is equal to Frame Relay or ATM 
networks. With Internet access from the MPLS cloud, the service provider has to reveal at least one 
IP address (of the peering PE router) to the next provider, and thus the outside world. 

Resistance to Attacks
It is not possible to directly intrude into other VPNs. However, it is possible to attack the MPLS core, 
and try to attack other VPNs from there. There are two basic ways the MPLS core can be attacked: 
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• Attacking the PE routers directly.

• Attacking the signaling mechanisms of MPLS (mostly routing) 

There are two basic types of attacks: denial-of-service (DoS) attacks, where resources become 
unavailable to authorized users, and intrusion attacks, where the goal is to gain unauthorized access to 
resources. 

For intrusion attacks, give unauthorized access to resources, there are two basic ways to protect the 
network:

• Harden protocols that could be abused (for example, Telnet to a router) 

• Make the network as inaccessible as possible. This is achieved by a combination of filtering packets 
or employing firewalls and hiding the IP addresses in the MPLS core. - Firewall is not supported 
in this release. -

Denial-of service attacks are easier to execute, since in the simplest case, a known IP address might be 
enough to attack a machine. The only way to be certain that you are not be vulnerable to this kind of 
attack is to make sure that machines are not reachable, again by packet filtering and pinging IP addresses.

MPLS networks must provide at least the same level of protection against both forms of attack as current 
Layer 2 networks provide.

To attack an element of an MPLS network it is first necessary to know this element, that is, its IP address. 
It is possible to hide the addressing structure of the MPLS core to the outside world, as discussed in the 
previous section. Thus, an attacker does not know the IP address of any router in the core that he wants 
to attack. The attacker could guess addresses and send packets to these addresses. However, due to the 
address separation of MPLS, each incoming packet is treated as belonging to the address space of the 
customer. It is therefore impossible to reach an internal router, even through guessing the IP addresses. 
There is only one exception to this rule—the peer interface of the PE router. 

Securing the Routing Protocol

The routing between the VPN and the MPLS core can be configured two ways: 

1. Static. In this case, the PE routers are configured with static routes to the networks behind each CE, 
and the CEs are configured to statically point to the PE router for any network in other parts of the 
VPN (usually a default route).

The static route can point to the IP address of the PE router, or to an interface of the CE router (for 
example, serial0).

Although in the static case the CE router does not know any IP addresses of the PE router, it is still 
attached to the PE router by way of some method, and could guess the address of the PE router and 
try to attack it with this address.

In the case of a static route from the CE router to the PE router, which points to an interface, the CE 
router does not need to know any IP address of the core network, not even of the PE router. This has 
the disadvantage of a more extensive (static) configuration, but from a security point of view, it is 
preferable to the other cases.

2. Dynamic. A routing protocol (for example, RIP, OSPF, or BGP) is used to exchange the routing 
information between the CE and the PE at each peering point.

In all other cases, each CE router needs to know at least the router ID (RID; peer IP address) of the PE 
router in the MPLS core, and thus has a potential destination for an attack. 
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In practice, access to the PE router over the CE-PE interface can be limited to the required routing 
protocol by using access control lists (ACLs). This limits the point of attack to one routing protocol, for 
example BGP. A potential attack could send an extensive number of routes, or flood the PE router with 
routing updates. Both of these attacks could lead to a denial-of-service attack, however, not to an 
intrusion attack. 

To restrict this risk it is necessary to configure the routing protocol on the PE router as securely as 
possible. This can be done in various ways: 

• Use VRFs. There are mechanisms within the context of a VRF for a service provider to monitor and 
control the number of routes that a customer can have in the VPN. When such thresholds are 
breached, for example 80 percent of the allowed number of routes syslog messages can be generated 
indicating to the service provider that the VRF is reaching the allowed limit.

• Use ACLs. Allow the routing protocol only from the CE router, not from anywhere else. 
Furthermore, no access other than that should be allowed to the PE router in the inbound ACL on 
each PE interface.

ACLs must be configured to limit access only to the port(s) of the routing protocol, and only from 
the CE router.

• Where available, configure MD-5 authentication for routing protocols. 

This is available for BGP, OSPF, and RIP2. It avoids the possibility that packets could be spoofed 
from other parts of the customer network than the CE router. This requires that the service provider 
and customer agree on a shared secret between all CE and PE routers. The problem here is that it is 
necessary to do this for all VPN customers; it is not sufficient to do this only for the customer with 
the highest security requirements.

Note ISC does not provide for the provisioning of MD5 authentication on PE-CE links using routing 
protocols. The VPN customer and the service provider must manually configure this.

MD5 authentication in routing protocols should be used on all PE-CE peers. It is easy to track the 
source of such a potential denial-of-service attack. 

• Configure, where available, the parameters of the routing protocol to further secure this 
communication. 

In BGP, for example, it is possible to configure dampening, which limits the number of routing 
interactions. Also, a maximum number of routes accepted per VRF should be configured where 
possible. 

In summary, it is not possible to intrude from one VPN into other VPNs or the core. However, it is 
theoretically possible to exploit the routing protocol to execute a denial-of-service attack against the PE 
router. This in turn might have negative impact on other VPNs. For this reason, PE routers must be 
extremely well secured, especially on their interfaces to the CE routers.

Label Spoofing
Assuming the address and routing separation as discussed above, a potential attacker might try to gain 
access to other VPNs by inserting packets with a label that he does not own. This is called label spoofing. 
This kind of attack can be done from the outside, that is, another CE router or from the Internet, or from 
within the MPLS core. The latter case (from within the core) is not discussed since the assumption is 
that the core network is provided in a secure manner. Should protection against an insecure core be 
required, it is necessary to run IPsec on top of the MPLS infrastructure. - Ipsec is not supported in this 
release. - 
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Within the MPLS network, packets are not forwarded based on the IP destination address, but based on 
the labels that are prepended by the PE routers. Similar to IP spoofing attacks, where an attacker replaces 
the source or destination IP address of a packet, it is also possible to spoof the label of an MPLS packet.

The interface between any CE router and its peering PE router is an IP interface, that is, without labels. 
The CE router is unaware of the MPLS core, and is only aware of the destination router. The intelligence 
exits in the PE device, where based on the configuration, the PE chooses a label and prepends it to the 
packet. This is the case for all PE routers, toward CE routers, and to the upstream service provider. All 
interfaces into the MPLS cloud require IP packets without labels. 

For security reasons, a PE router should never accept a packet with a label from a CE router. Cisco 
routers implementation is such that packets that arrive on a CE interface with a label are dropped. Thus, 
it is not possible to insert fake labels because no labels are accepted. Additional security can be 
implemented by using MD5 authentication between peer routers in the core if the service provider is 
suing LDP to distribute labels.

There remains the possibility to spoof the IP address of a packet that is being sent to the MPLS core. 
However, since there is strict addressing separation within the PE router, and each VPN has its own VRF, 
this can only do harm to the VPN the spoofed packet originated from, in other words, a VPN customer 
can attack himself. MPLS does not add any security risk here.

Securing the MPLS Core
The following is a list of recommendations and considerations on configuring an MPLS network 
securely.

Note The security of the overall solution depends on the security of its weakest link. This could be the weakest 
single interconnection between a PE and a CE, an insecure access server, or an insecure TFTP server. 

Trusted Devices

The PE and P devices, and remote access servers and AAA servers must be treated as trusted systems. 
This requires strong security management, starting with physical building security and including issues 
such as access control, secure configuration management, and storage. There is ample literature 
available on how to secure network elements, so these topics are not discussed here in more detail. 

CE routers are typically not under full control of the service provider and must be treated as “untrusted.”

PE-CE Interface

The interface between PE and CE routers is crucial for a secure MPLS network. The PE router should 
be configured as close as possible. From a security point of view, the best option is to configure the 
interface to the CE router unnumbered and route statically.

Packet filters (Access Control Lists) should be configured to permit only one specific routing protocol 
to the peering interface of the PE router, and only from the CE router. All other traffic to the router and 
the internal service provider network should be denied. This avoids the possibility that the PE and P 
routers can be attacked, since all packets to the corresponding address range are dropped by the PE 
router. The only exception is the peer interface on the PE router for routing purposes. This PE peer 
interface must be secured separately. 
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If private address space is used for the PE and P routers, the same rules with regard to packet filtering      
apply—it is required to filter all packets to this range. However, since addresses of this range should not 
be routed over the Internet, it limits attacks to adjacent networks. 

Routing Authentication

All routing protocols should be configured with the corresponding authentication option toward the CEs 
and toward any Internet connection. Specifically: BGP, OSPF, and RIP2. All peering relationships in the 
network need to be secured this way: 

• CE-PE link: use BGP MD-5 authentication

• PE-P link: use LDP MD5 authentication

• P-P

This prevents attackers from spoofing a peer router and introducing bogus routing information. Secure 
management is particularly important regarding configuration files, which often contain shared secrets 
in clear text (for example for routing protocol authentication).

Separation of CE-PE Links

If several CEs share a common Layer 2 infrastructure to access the same PE router (for example, an 
ethernet VLAN), a CE router can spoof packets as belonging to another VPN that also has a connection 
to this PE router. Securing the routing protocol is not sufficient, since this does not affect normal      
packets. 

To avoid this problem, Cisco recommends that you implement separate physical connections between 
CEs and PEs. The use of a switch between various CE routers and a PE router is also possible, but it is 
strongly recommended to put each CE-PE pair into a separate VLAN to provide traffic separation. 
Although switches with VLANs increase security, they are not unbreakable. A switch in this 
environment must thus be treated as a trusted device and configured with maximum security. 

LDP Authentication

The Label Distribution Protocol (LDP) can also be secured with MD-5 authentication across the MPLS 
cloud. This prevents hackers from introducing bogus routers, which would participate in the LDP. 

Connectivity Between VPNs

MPLS provides VPN services with address and routing separation between VPNs. In many 
environments, however, the devices in the VPN must be able to reach destinations outside the VPN. This 
could be for Internet access or for merging two VPNs, for example, in the case of two companies 
merging. MPLS not only provides full VPN separation, but also allows merging VPNs and accessing the 
Internet.

To achieve this, the PE routers maintain various tables: A routing context table is specific to a CE router, 
and contains only routes from this particular VPN. From there, routes are propagated into the VRF 
(virtual routing and forwarding instance) routing table, from which a VRF forwarding table is 
calculated.
1-32
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Chapter 1      IP Solution Center—MPLS VPN
MPLS VPN Security
For separated VPNs, the VRF routing table contains only routes from one routing context. To merge 
VPNs, different routing contexts (from different VPNs) are put into one single VRF routing table. In this 
way, two or several VPNs can be merged to a single VPN. In this case, it is necessary that all merged 
VPNs have mutually exclusive addressing spaces; in other words, the overall address space must be 
unique for all included VPNs.

For a VPN to have Internet connectivity, the same procedure is used: Routes from the Internet VRF 
routing table (the default routing table) are propagated into the VRF routing table of the VPN that 
requires Internet access. Alternatively to propagating all Internet routes, a default route can be 
propagated. In this case, the address space between the VPN and the Internet must be distinct. The VPN 
must use private address space since all other addresses can occur in the Internet.

From a security point of view, the merged VPNs behave like one logical VPN, and the security 
mechanisms described above apply now between the merged VPN and other VPNs. The merged VPN 
must have unique address space internally, but further VPNs can use the same address space without 
interference. Packets from and to the merged VPNs cannot be routed to other VPNs. All the separation 
functions of MPLS apply also for merged VPNs with respect to other VPNs.

If two VPNs are merged in this way, hosts from either part can reach the other part as if the two VPNs 
were a common VPN. With the standard MPLS features, there is no separation or firewalling or packet 
filtering between the merged VPNs. Also, if a VPN receives Internet routes through MPLS/BGP VPN 
mechanisms, firewalling or packet filtering has to be engineered in addition to the MPLS features. - 
Firewall is not supported in this release. -

MP-BGP Security Features

Security in ISC MPLS-based networks is delivered through a combination of MP-BGP and IP address 
resolution. In addition, service providers can ensure that VPNs are isolated from each other.

Multiprotocol BGP is a routing information distribution protocol that, through employing multiprotocol 
extensions and community attributes, defines who can talk to whom. VPN membership depends upon 
logical ports entering the VPN, where MP-BGP assigns a unique Route Distinguisher (RD) value (see 
Route Distinguishers and Route Targets, page 1-24). 

RDs are unknown to end users, making it impossible to enter the network on another access port and 
spoof a flow. Only preassigned ports are allowed to participate in the VPN. In an MPLS VPN, MP-BGP 
distributes forwarding information base (FIB) tables about VPNs to members of the same VPN only, 
providing native security by way of logical VPN traffic separation. Furthermore, IBGP PE routing peers 
can perform TCP segment protection using the MD5 Signature Option when establishing IBGP peering 
relationships, further reducing the likelihood of introducing spoofed TCP segments into the IBGP 
connection stream among PE routers (for information on the MD5 Signature Option, see RFC 2385).

The service provider, not the customer, associates a specific VPN with each interface when provisioning 
the VPN. Users can only participate in an intranet or extranet if they reside on the correct physical or 
logical port and have the proper RD. This setup makes a Cisco MPLS VPN virtually impossible to enter.

Within the core, a standard Interior Gateway Protocol (IGP) such as OSPF or IS-IS distributes routing 
information. Provider edge routers set up paths among one another using LDP to communicate 
label-binding information. Label binding information for external (customer) routes is distributed 
among PE routers using MP-BGP multiprotocol extensions instead of LDP, because they easily attach 
to VPN IP information already being distributed. 

The MP-BGP community attribute constrains the scope of reachability information. MP-BGP maps FIB 
tables to provider edge routers belonging to only a particular VPN, instead of updating all edge routers 
in the service provider network. 
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Security Through IP Address Resolution

MPLS VPN networks are easier to integrate with IP-based customer networks. Subscribers can 
seamlessly interconnect with a provider service without changing their intranet applications because 
MPLS-based networks have built-in application awareness. Customers can even transparently use their 
existing IP address space without Network Address Translator (NAT) because each VPN has a unique 
identifier. - NAT is not supported in this release. -

MPLS VPNs remain unaware of one another. Traffic is separated among VPNs using a logically distinct 
forwarding table and RD for each VPN. Based on the incoming interface, the PE selects a specific 
forwarding table, which lists only valid destinations in the VPN. To create extranets, a provider explicitly 
configures reachability among VPNs.

The forwarding table for a PE contains only address entries for members of the same VPN. The PE 
rejects requests for addresses not listed in its forwarding table. By implementing a logically separate 
forwarding table for each VPN, each VPN itself becomes a private, connectionless network built on a 
shared infrastructure. 

IP limits the size of an address to 32 bits in the packet header. The VPN IP address adds 64 bits in front 
of the header, creating an extended address in routing tables that classical IP cannot forward. The extra 
64 bits are defined by the Route Distinguisher and the resultant route becomes a unique 96-bit prefix. 
MPLS solves this problem by forwarding traffic based on labels, so one can use MPLS to bind VPN IP 
routes to label-switched paths. PEs are concerned with reading labels, not packet headers. MPLS 
manages forwarding through the provider’s MPLS core. Since labels only exist for valid destinations, 
this is how MPLS delivers both security and scalability. 

When a virtual circuit is provided using the overlay model, the egress interface for any particular data 
packet is a function solely of the packet’s ingress interface; the IP destination address of the packet does 
not determine its path in the backbone network. Thus, unauthorized communication into or out of a VPN 
is prevented.

In MPLS VPNs, a packet received by the backbone is first associated with a particular VPN by 
stipulating that all packets received on a certain interface (or subinterface) belong to a certain VPN. Then 
its IP address is looked up in the forwarding table associated with that VPN. The routes in that 
forwarding table are specific to the VPN of the received packet.

In this way, the ingress interface determines a set of possible egress interfaces, and the packet’s IP 
destination address is used to choose from among that set. This prevents unauthorized communication 
into and out of a VPN.

Ensuring VPN Isolation

To maintain proper isolation of one VPN from another, it is important that the provider routers not accept 
a labeled packet from any adjacent PE unless the following conditions are met: 

• The label at the top of the label stack was actually distributed by the provider router to the PE device.

• The provider router can determine that use of that label will cause the packet to exit the backbone 
before any labels lower in the stack and the IP header will be inspected. 

These restrictions are necessary to prevent packets from entering a VPN where they do not belong.

The VRF tables in a PE are used only for packets arriving from a CE that is directly attached to the PE 
device. They are not used for routing packets arriving from other routers that belong to the service 
provider backbone. As a result, there might be multiple different routes to the same system, where the 
route followed by a given packet is determined by the site from which the packet enters the backbone. 
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So one might have one route to a given IP network for packets from the extranet (where the route leads 
to a firewall), and a different route to the same network for packets from the intranet. - Firewall is not 
supported in this release. -
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C H A P T E R 2

Provisioning an Unmanaged Multi-VRF CE

This chapter describes how to implement a new, Unmanaged Multi-VRF (MVRF) CE with all the 
required infrastructure data, define an MVRFCE PE-CE Service Policy, and create an MVRFCE PE-CE 
Service Request, using the Cisco IP Solution Center (ISC). 

This chapter contains the following major sections:

• Unmanaged MVRFCE Overview, page 2-1

• Adding a New Customer CPE, page 2-5

• Adding a New Provider PE, page 2-16

• Creating an Access Domain, page 2-27

• Creating Resource Pools, page 2-31

• Defining a VPN, page 2-45

• Defining an MVRFCE PE-CE Service Policy, page 2-48

• Creating an MVRFCE PE-CE Service Request, page 2-53

Unmanaged MVRFCE Overview
The unmanaged MVRFCE feature is similar to the unmanaged CE feature in so far as the service 
provider does not use ISC to upload or download configurations to the CPE. This feature is similar to 
the managed MVRFCE feature in so far as ISC creates a link with three devices: a PE, an MVRFCE, and 
a CE. 

In the unmanaged scenarios, the customer configures the CPE manually. To automate the process of 
configuring the unmanaged MVRFCE, the service provider can use ISC to generate the configuration 
and then send it to the customer for manual implementation.

Figure 2-1 shows an overview of a network topology with MPLS VPN MVRFCE PE-CE links.
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Figure 2-1 Unmanaged MVRFCE PE-CE Network Topology

The network topology in Figure 2-1 shows a service provider (Provider-X) and a customer (Cust-A). 
The Provider contains one Region (West-X) and one PE (mlpe2). The Customer contains an MVRFCE 
(mlce3) and a CE (mlce4). Both of these CPEs are unmanaged.

This section contains the following sections:

• Process Overview, page 2-2

• MVRFCE PE-CE Policy Type, page 2-4

• Infrastructure Data, page 2-4

Process Overview
To configure MPLS VPN services with ISC, you must understand three key concepts: 

• Network Inventory, page 2-2 

• Service Policy, page 2-3

• Service Request, page 2-4

Network Inventory 

The purpose of preparing network inventory in ISC is to populate the Repository with infrastructure data. 
If multiple devices are involved, you can use Inventory Manager for importing devices and creating PE 
or CPE. Otherwise, you can use Inventory and Connection Manager to create the devices and 
infrastructure data.

To create an MPLS VPN Service Request, you must create the following infrastructure data: 

• Devices 

A Device in ISC is a logical representation of a physical device in the network. You can import 
devices (configurations) into ISC by using Inventory Manager or the ISC GUI. You can also use the 
Auto Discovery feature of Inventory Manager to import devices into the Repository.

• Customers 

A customer is typically an enterprise or large corporation that receives network services from a 
service provider. A Customer is also a key logical component of ISC.
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– Sites

A Site is a logical component of ISC that connects a Customer with a CE. It can also represent 
a physical customer site.

– CPE/CE Devices

A CPE is “customer premises equipment,” typically a customer edge router (CE). It is also a 
logical component of ISC. You can create CPE in ISC by associating a device with a Customer 
Site.

• Providers 

A provider is typically a “service provider” or large corporation that provides network services to a 
customer. A Provider is also a key logical component of ISC.

– Regions 

A Region is a logical component of ISC that connects a Provider with a PE. It can also represent 
a physical provider region.

– PE Devices

A PE is a provider edge router or switch. It is also a logical component of ISC. You can create 
PE in ISC by associating a Device with a Provider Region. In ISC, a PE can be a “point of 
presence” router (POP) or a Layer 2 switch (CLE).

• Access Domains (for Layer 2 Access)

The Layer 2 Ethernet switching domain that connects a PE to a CE is called an Access Domain. All 
the switches attached to the PE-POP belong to this Access Domain. These switches belong to the 
Provider and are defined in ISC as PE-CLE.

• Resource Pools 

– IP Addresses

– Multicast

– Route Distinguisher

– Route Target

– VLANs (for Layer 2 Access)

• CE Routing Communities (CERC is optional) 

• VPN 

Before creating a Service Policy, a VPN name must be defined within ISC. 

Service Policy

To create an MVRFCE PE-CE Service Policy, you must set up the following items: 

1. Policy Type 

2. PE-MVRFCE Interface 

3. MVRFCE-CE Interface 

4. PE-MVRFCE IP Address Scheme 

5. MVRFCE-CE IP Address Scheme 

6. PE-MVRFCE Routing Information 

7. MVRFCE-CE Routing Information 
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8. VRF and VPN Membership 

Service Request

To create an MVRFCE PE-CE Service Request, you must complete the following items: 

1. PE-MVRFCE Interface 

2. MVRFCE-CE Interface 

3. PE-MVRFCE IP Address Scheme 

4. MVRFCE-CE IP Address Scheme 

5. PE-MVRFCE Routing Information 

6. MVRFCE-CE Routing Information 

7. VRF and VPN Membership 

MVRFCE PE-CE Policy Type
An MVRFCE PE-CE Policy Type is a PE to CE link with three devices:

• PE

• MVRF CE

• CE

Figure 2-2 shows an example of an MVRFCE PE-CE link with three devices.

Figure 2-2 MVRFCE PE-CE Link

In an MVRFCE PE-CE Service Policy with CE Present enabled, interfaces FE 0/0, E 0/1, E 0/2 and FE 
0/1 are configured as an MPLS VPN link in the Service Request process.

Infrastructure Data
In this MVRFCE PE-CE scenario, the following infrastructure data is used:

• Provider: Provider-X

• Region: West-X

• AS#: 99

• PE: mlpe2 

• Device Role: PE POP

• Customer: Cust-A

• Site: Cust-A-Site- mlce3

• CE: mlce3 

PE

FE 0/0 E 0/1 E 0/2 FE 0/1

MVRFCE

mlpe2 mlce3

CE

mlce4 10
16
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• Site: Cust-A-Site- mlce4

• CE: mlce4 

• Device Role: CPE 

• IP Address Pool: 

– Name: Provider-X-West-X

– Type: Region

– Start: 25.7.0.0

– Mask: 30

– Size: 16384

• Route Distinguisher Pool: 

– Name: 99:PROVIDER-X

– Start: 50000

– Size: 10000

• Route Target Pool: 

– Name: 99:PROVIDER-X

– Start: 50000

– Size: 10000

• VPN 

– Definition: west-xVPN

Adding a New Customer CPE
This section describes how to create a new CPE with an Unmanaged Multi-VRF management Type using 
the Cisco IP Solution Center (ISC) GUI. It contains the following sections:

• Overview of an ISC Customer, page 2-5

• Creating a Device, page 2-6

• Creating a Customer, Site, and CPE, page 2-11

Overview of an ISC Customer
In ISC, a Customer is defined by the following three logical components:

• Customer Name 

• Customer Site

• Customer Device (CPE)

In ISC, a Customer is a logical container for Sites and CEs. 

Within a Customer, there can be one or more Sites. Sites are logical entities that can be defined in any 
way that makes sense to a service provider. 

Figure 2-3 shows an overview of an ISC Customer.
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Figure 2-3 Overview of an ISC Customer 

Creating a Device
This section describes how to create a Device with the ISC GUI, connect to a Cisco IOS router in the 
network, collect the live configuration, and populate the Repository. This section contains the following 
sections:

• Create a Device, page 2-6

• Collect the Configuration, page 2-8

• Monitor Task Logs, page 2-10

Create a Device

This section describes how to create a logical Device with the ISC GUI. To create a Device with the ISC 
GUI, follow these steps: 

Step 1 Log into ISC.

Step 2 Select Service Inventory > Inventory and Connection Manager > Devices. 

The Devices window appears, as shown in Figure 2-4.

CE3CE2CE1

Customer

Site-A Site-B Site-C Site-D

11
15

82
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Figure 2-4 Devices

Step 3 Click Create.

Step 4 Select Cisco IOS Device.

The Create Cisco IOS Device window appears (not shown).

Step 5 Enter the following information:

• General

– Device Host Name (mlce3)

– Management IP Address (172.29.146.26)

• Login and Password Information

– Login Password (*******)

– Verify Login Password (*******)

– Enable Password (*******)

– Verify Enable Password (*******)

• Device and Configuration Access Information

– Terminal Session Protocol: Default (Telnet) 

– Config Access Protocol: Default (Terminal) 

– SNMP Version: Default (SNMP v1/v2c) 

• SNMP v1/v2c 

– Community String RO (Public)

– Community String RW (Private)

Step 6 Click Save.

Note You have saved a Device in the Repository.
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Collect the Configuration

This section describes how to connect to the physical device in the network, collect the device 
information from the router, and populate the Repository. 

To collect the configuration, follow these steps:

Step 1 Select Monitoring > Task Manager.

The Tasks window appears, as shown in Figure 2-5.

Figure 2-5 Tasks

Step 2 Click Create.

Step 3 Select Collect Config (not shown).

The Create Task window appears, as shown in Figure 2-6. 

Note You might want to change the default Name and Description for this task, so you can more easily 
identify it in the task log. For example, by adding: mlce3DeviceCreation.

Figure 2-6 Create Task 

Step 4 Click Next (not shown).

The Collect Config Task window appears, as shown in Figure 2-7.
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Figure 2-7 Collect Config Task

Step 5 Click Select/De Select at Devices.

The Select Device window appears, as shown in Figure 2-8.

Figure 2-8 Select Device 

Step 6 Select the device, which you created in the previous section, Creating a Device, page 2-6, and then click 
Select. (mlce3)

The Collect Config Task window appears (not shown).

Step 7 Click Submit.

The Task window appears, as shown in Figure 2-9.
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Figure 2-9 Tasks

Step 8 Select your task in the Task Name column and then click Details to view more information.

Note You have created a Task in the Repository.

Monitor Task Logs

To monitor the logs for your task, follow these steps: 

Step 1 Select Monitoring > Task Manager.

The Tasks window appears (not shown).

Step 2 Click Logs in the Selection window (not shown).

The Task Runtime Actions window appears, as shown in Figure 2-10.

Figure 2-10 Task Runtime Actions
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Note The Status field shows the task has completed successfully. You have collected the configuration for a 
device and saved it in the Repository. 

Step 3 Select your task and then click Instances to view more information.

Creating a Customer, Site, and CPE
This section describes how to create a Customer with the ISC GUI, create a Site for the Customer, and 
associate a Device with the Site. This section contains the following sections:

• Create a Customer, page 2-11

• Create a Site, page 2-11

• Create a CPE, page 2-13

Create a Customer

To create a Customer with the ISC GUI, follow these steps: 

Step 1 Select Service Inventory > Inventory and Connection Manager > Customers.

The Customers window appears (not shown).

Step 2 Click Create.

The Create Customer window appears (not shown).

Step 3 Enter a Customer Name and then click Save. (Cust-A)

Note You have saved a Customer in the Repository.

The Customers window appears (not shown).

Create a Site

To create a Site, follow these steps: 

Step 1 Select Service Inventory > Inventory and Connection Manager.

Step 2 Click Customer Sites in the Selection window.

The Customer Site window appears (not shown). 

Step 3 Click Create.

The Create Customer Site window appears, as shown in Figure 2-11.
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Figure 2-11 Create Customer Site

Step 4 Enter a Site Name. (Cust-A-Site-mlce3)

Step 5 Click Select.

The Select Customer window appears, as shown in Figure 2-12.

Figure 2-12 Select Customer

Step 6 Select a Customer. (Cust-A)

Step 7 Click Select.

The Create Customer Site window appears.

Click Save.

Note You have saved a Customer Site in the Repository.
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Create a CPE

To create a CPE, follow these steps: 

Step 1 Select Service Inventory > Inventory and Connection Manager.

Step 2 Click CPE Devices in the Selection window.

The CPE Devices window appears, as shown in Figure 2-13.

Figure 2-13 CPE Devices

Step 3 Click Create.

The Create CPE Device window appears, as shown in Figure 2-14. 

Figure 2-14 Create CPE Device

Step 4 Click Select to Select a Device.

The Select Device window appears, as shown in Figure 2-15.
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Figure 2-15 Select Device

Step 5 Select a Device and then click Select. (mlce3)

The Create CPE Device window appears, as shown in Figure 2-16.
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Figure 2-16 Create CPE Device

Step 6 Select Management Type. (Unmanaged Multi-VRF)

Step 7 Click Save.

The Create CPE Device window appears, as shown in Figure 2-17.
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Figure 2-17 CPE Devices

Note You have saved a CPE in the Repository.

Adding a New Provider PE
This section describes how to use Cisco IP Solution Center (ISC) Inventory Manager to create a PE from 
a Device and configure a Provider in the process. 

This section contains the following sections:

• Overview of an ISC Provider, page 2-16

• Create a Device Group, page 2-17

• Import Configuration Files, page 2-18

• Open a Device, page 2-20

• Collect the Latest Configuration, page 2-21

• Create a Provider and a PE, page 2-23

• Create a Region for the PE, page 2-25

• Edit a PE with the ISC GUI, page 2-27

Overview of an ISC Provider
In ISC, a Provider is defined by the following three logical components:

• Provider Name and BGP Autonomous System (AS) number

• Provider Region

• Provider Device (PE)

In ISC, a provider administrative domain (PAD) is a single AS. It is not a specific service provider, rather 
it is a logical container for Regions and PEs. 
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Within a single PAD, there must be one or more Regions. Regions are logical entities that can be defined 
in any way that makes sense to a service provider. 

Within a Region, a Provider can contain one or more PEs. The PEs can be a PE-POP (“router”) or a 
PE-CLE (“switch”). 

Figure 2-3 shows an overview of an ISC Provider.

Figure 2-18 Overview of an ISC Provider 

Create a Device Group
This section describes how to create a Device Group with Inventory Manager. To create a Device Group, 
follow these steps: 

Step 1 Log into ISC.

Step 2 Select Service Inventory > Inventory and Connection Manager > Inventory Manager. 

The Inventory Manager Java Web Start window appears (not shown).

Step 3 Click Inventory Manager. 

The Inventory Manager task bar appears, as shown in Figure 2-19.

Figure 2-19 Inventory Manager Task Bar

Step 4 Select File > New > New Device Group.

PE3

PE2

PE1

Provider

Region-North Region-South Region-East Region-West

11
16

01
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The Create New Device Group window appears, as shown in Figure 2-20.

Figure 2-20 Create New Device Group

Step 5 Enter the Device Group Name (PE Device Group) and a Description (optional).

Step 6 Click OK.

The No Config Files Specified for Import window appears (not shown).

Step 7 Click Yes.

The Choose Config Files for Device Group window appears (not shown).

Note This process is continued in Import Configuration Files, page 2-18.

Import Configuration Files
This section describes how to import configuration files with Inventory Manager. 

To import configuration files, follow these steps: 

Step 1 From the Choose Config Files for Device Group window in the previous section (Step 7), click Add.

The Open window appears, as shown in Figure 2-21.
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Figure 2-21 Open Config Files

Step 2 Browse to the directory where your configuration files are located and select the appropriate 
configuration file. Use Ctrl+Click to select multiple devices.

Step 3 Click Open.

The Choose Config Files for Device Group window appears (not shown).

Step 4 Click OK.

The Group spreadsheet appears, as shown in Figure 2-22.

Figure 2-22 Group Spreadsheet

Step 5 Select File > Save.
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Note You have now saved this Device Group, with the logical Devices and configuration data, in the 
Repository. 

Open a Device

Note Inventory Manager is designed to configure multiple Devices in a single operation. To facilitate 
understanding of this process, this scenario focuses on only one Device.

This section describes how to open a Device with Inventory Manager. 

To open a Device, follow these steps: 

Step 1 From the Inventory Manager task bar (not shown), select File > Open > Open Devices. 

The Open Devices window appears, as shown in Figure 2-23.

Figure 2-23 Open Devices

Step 2 Click Find.

The Open Devices window appears, as shown in Figure 2-24.

Figure 2-24 Open Devices

Step 3 Select a Device and then click OK. (mlpe3) 

The Devices spreadsheet appears, as shown in Figure 2-25.
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Figure 2-25 Devices Spreadsheet

Note This process is continued in Collect the Latest Configuration, page 2-21.

Collect the Latest Configuration
This section describes how to connect to a physical device in the network, and collect the latest 
configuration, with Inventory Manager. 

To collect a configuration, follow these steps:

Step 1 Click the cell in the Management Address column of the Device spreadsheet shown above in 
Figure 2-25. 

The Management Address window appears, as shown in Figure 2-26. 

Note The three IP addresses in the lower window were imported previously in the section, Import 
Configuration Files, page 2-18. These interface addresses could also be used as the Management 
Address.
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Figure 2-26 Management Address

Step 2 Enter the Management Address and then click OK. (172.29.146.23)

The Devices spreadsheet appears (not shown).

Step 3 Click the Passwords tab.

The Passwords spreadsheet appears (not shown).

Step 4 Click the Login Password cell.

The Login Password window appears (not shown).

Step 5 Enter the Password (*******).

Step 6 Enter the Verify Password (*******).

Step 7 Click OK.

Step 8 Click the Enable Password cell.

The Enable Password window appears (not shown).

Step 9 Enter the Password (*******).

Step 10 Enter the Verify Password (*******).

Step 11 Click OK.

Step 12 Select File > Save.

Step 13 Select Task > Collect Latest Config Files.

Step 14 Accept the prompt to proceed. 

You are notified if the task completes successfully.

Step 15 Click the Platform Information tab to view the newly collected configuration information.

The Platform Information spreadsheet appears, as shown in Figure 2-27 below.

Step 16 Select File > Save.

Note You have now saved this Device information in the Repository. This process is continued in Create a 
Provider and a PE, page 2-23.
2-22
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Chapter 2      Provisioning an Unmanaged Multi-VRF CE
Adding a New Provider PE
Create a Provider and a PE
This section describes how to create a Provider and a PE from a Device, using Inventory Manager. 

To create a Provider and a PE, follow these steps: 

Step 1 From the Devices spreadsheet shown in Figure 2-27, click the cell in the Host column to select the 
Device. 

Figure 2-27 Platform Information

Step 2 From the Inventory Manager task bar, select Edit > Move to New Provider, as shown in Figure 2-28.

Figure 2-28 Move to New Customer

The Create New Provider window appears, as shown in Figure 2-29.
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Figure 2-29 Create New Provider

Enter the Provider Name and BGP AS Number. (Provider-X, 99)

Step 3 Click OK. 

The Provider spreadsheet appears with a PE, as shown in Figure 2-30.

Figure 2-30 Provider Spreadsheet

Step 4 Select File > Save.

Note The Provider spreadsheet contains two new tabs, PE Attributes and PE Interfaces. This process is 
continued in Create a Region for the PE, page 2-25.
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Create a Region for the PE
This section describes how to create a Region for the PE with Inventory Manager. 

To create a Region, follow these steps: 

Step 1 From the Provider spreadsheet, shown in Figure 2-30, click the PE Attributes tab. 

The PE Attributes spreadsheet appears, as shown in Figure 2-31.

Figure 2-31 PE Attributes

Step 2 Click the cell in the Region Name column.

The Region Name window appears, as shown in Figure 2-32.

Figure 2-32 Region Name

Step 3 Click Create Region. 

The New Region window appears, as shown in Figure 2-33.
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Figure 2-33 New Region

Step 4 Enter the Region Name and then click OK. (East-X)

The Region Name window appears, as shown in Figure 2-34.

Figure 2-34 Region Name

Step 5 Click OK. 

The PE Attributes spreadsheet appears, as shown in Figure 2-35.

Figure 2-35 PE Attributes

Step 6 Click File > Save. 
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Note The process of adding a PE to a Provider Region is complete. To view or edit the PE in the ISC GUI, 
continue to Edit a PE with the ISC GUI, page 2-27.

Edit a PE with the ISC GUI 
This section describes how to view or edit a PE with the ISC GUI. 

To view a PE with the ISC GUI, follow these steps: 

Step 1 Open a new browser and log into ISC.

Step 2 Select Service Inventory > Inventory and Connection Manager. 

Step 3 Click PE Devices in the Selection window. 

The PE Devices window appears, as shown in Figure 2-36.

Figure 2-36 PE Devices

Step 4 Select the PE Device.

Step 5 Click Edit.

Creating an Access Domain

Note This section is only required for Layer 2 access to MPLS VPN.

This section describes how to create an Access Domain using the Cisco IP Solution Center (ISC) GUI. 
This section contains the following sections:

• Overview of an Access Domain, page 2-28

• Create an Access Domain, page 2-28
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Overview of an Access Domain
Any Transport over MPLS (AToM) is the Cisco solution for transporting Layer 2 traffic over an IP/MPLS 
backbone. AToM is required for supporting legacy services over MPLS infrastructures and for 
supporting new connectivity options, including Layer 2 VPNs and Layer 2 virtual leased lines.

AToM supports three types of Ethernet-based L2VPNs (EoMPLS):

• Point-to-Point Ethernet Wire Service (EWS)

• Point-to-Point Ethernet Relay Service (ERS)

• Multipoint TLS Service

The Layer 2 Ethernet switching domain that connects a PE to a CE is called an Access Domain. All the 
switches attached to the PE-POP belong to this Access Domain. These switches belong to the Provider 
and are defined in ISC as PE-CLE.

Note To have ISC automatically assign VLAN links from a VLAN pool, you must create an Access Domain. 

ISC supports multiple PE-POPs per Access Domain and multiple PE-CLE devices can be included.

Figure 2-37 shows an overview of an ISC Access Domain.

Figure 2-37 Overview of an Access Domain

Create an Access Domain
This section describes how to create a Device with the ISC GUI. 

To create a Device with the ISC GUI, follow these steps: 

Step 1 Log into ISC.

Step 2 Select Service Inventory > Inventory and Connection Manager.
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Step 3 Click Access Domains in the Selection window.

The Access Domains window appears, as shown in Figure 2-38.

Figure 2-38 Access Domains

Step 4 Click Create.

The Create Access Domain window appears, as shown in Figure 2-39.

Figure 2-39 Create Access Domain

Step 5 Enter an Access Domain Name.

Step 6 Select a Provider (not shown).

Step 7 Click Select to show PEs.

The Show PEs window appears, as shown in Figure 2-40.
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Figure 2-40 Show PEs 

Step 8 Select a PE.

Step 9 Click Select.

The Create Reserved VLAN window appears, as shown in Figure 2-41.

Figure 2-41 Create Reserved VLAN

Step 10 Enter a Starting Value.

Step 11 Enter a Size.

Step 12 Select Management VLAN.

Step 13 Click OK.

The Access Domains window appears, as shown in Figure 2-8.
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Figure 2-42 Access Domains 

The Access Domain has been saved in the Repository.

Creating Resource Pools
This section describes how to create Resource Pools using the Cisco IP Solution Center (ISC) GUI. 

This section contains the following sections:

• Overview of Resource Pools, page 2-31

• Create an IP Address Pool, page 2-32

• Create a Multicast Pool, page 2-34

• Create a Route Distinguisher Pool, page 2-36

• Create a Route Target Pool, page 2-38

• Create a Site of Origin Pool, page 2-40

• Create a VC ID Pool, page 2-41

• Create a VLAN Pool, page 2-43

Overview of Resource Pools
Before creating a service in ISC, you must define your Resource Pools. From these Resource Pools, ISC 
can automatically assign some values during the provisioning process. You can also manually assign 
these values during the provisioning process, but it is not recommended. 

ISC allocates numbers from the following pools during the provisioning process:

• IP Address—Connects PE and CE interfaces, when you define addresses in a Service Request.

• Multicast—Class D addresses used with multicast, when building PE to multiple CE links.

• Route Distinguisher (RD)—A 64-bit number composed of the Provider AS number and an index 
number that is prepended to a VPN route. The RD allows the route subnet to be unique across the 
entire provider MPLS VPN network. It is carried by MP-BGPv4 as a 96-bit VPNv4 address as part 
of the extended community string.
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• Route Target (RT)—An import and export feature of a VRF, the RT allows VPN routes to be 
forwarded between VRFs. It is a 64-bit number, also carried as part of the MP-BGPv4 extended 
community string, and directly related to each VPNv4 route and its VPN-related IPv4 route.

• Site of Origin—Indicates the origin of a BGP update. Depending on the use of two Cisco IOS BGP 
commands, the Site of Origin will be used by BGP to preclude routing loops.

• VC ID (Virtual Circuit)—Used as a Layer 2 circuit identifier across a provider network.

• VLAN—Used in a Layer 2 VPN as a circuit identifier within the provider Access Domain.

Create an IP Address Pool
This section describes how to create an IP Address Pool with the ISC GUI. 

To create an IP Address Pool with the ISC GUI, follow these steps: 

Step 1 Log into ISC.

Step 2 Select Service Inventory > Inventory and Connection Manager > Resource Pools. 

The Resource Pools window appears, as shown in Figure 2-43.

Figure 2-43 Resource Pools

Step 3 Select IP Address from the Pool Type window.

Step 4 Click Create. 

The Create IP Address Pool window appears, as shown in Figure 2-44.
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Figure 2-44 Create IP Address Pool

Step 5 Enter an IP Address and Mask. (25.5.0.0/24)

Step 6 Select the Pool Mask (bits) value. (30) 

Note Use 32 for loopback addresses.

Step 7 Click Select to associate the pool with a Region.

The Select Region window appears, as shown in Figure 2-45.

Figure 2-45 Select Region

Step 8 Select a Region.

Step 9 Click Select.

The Create IP Address Pool window appears, as shown in Figure 2-6. 
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Figure 2-46 Create IP Address Pool

Step 10 Click Save.

The Resource Pools - IP Address window appears, as shown in Figure 2-47.

Figure 2-47 Resource Pools - IP Address

You have saved an IP Address Pool in the Repository.

Create a Multicast Pool
This section describes how to create a Multicast Address Pool with the ISC GUI. 

To create a Multicast Pool with the ISC GUI, follow these steps: 

Step 1 Log into ISC.

Step 2 Select Service Inventory > Inventory and Connection Manager > Resource Pools. 

The Resource Pools window appears (not shown).

Step 3 Select Multicast from the Pool Type window.

The Resource Pools - Multicast window appears, as shown in Figure 2-8.
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Figure 2-48 Resource Pools - Multicast 

Step 4 Click Create.

The Create Multicast Pool window appears, as shown in Figure 2-49.

Figure 2-49 Create Multicast Pool

Step 5 Enter an IP Address and Mask. (239.0.0.0/24)

Step 6 Select the defaults. (Default MDT and Data MDT).

Step 7 Click Save.

The Resource Pools - Multicast window appears, as shown in Figure 2-48.
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Figure 2-50 Resource Pools - Multicast

You have saved a Multicast Address Pool in the Repository.

Create a Route Distinguisher Pool
This section describes how to create a Route Distinguisher Pool with the ISC GUI. 

To create a Route Distinguisher Pool with the ISC GUI, follow these steps: 

Step 1 Log into ISC.

Step 2 Select Service Inventory > Inventory and Connection Manager > Resource Pools. 

The Resource Pools window appears (not shown).

Step 3 Select Route Distinguisher from the Pool Type window.

The Resource Pools - Route Distinguisher window appears, as shown in Figure 2-11.

Figure 2-51 Resource Pools - Route Distinguisher

Step 4 Click Create.

The Create Route Distinguisher Pool window appears, as shown in Figure 2-52.
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Figure 2-52 Create Route Distinguisher Pool

Step 5 Enter an RD Pool Start. (50000)

Step 6 Enter an RD Pool Size. (1000)

Step 7 Click Select.

The Select Provider window appears (not shown).

Step 8 Select a Provider.

The Create Route Distinguisher Pool window appears, as shown in Figure 2-53.

Figure 2-53 Create Route Distinguisher Pool

Step 9 Click Save.

The Resource Pools - Route Distinguisher window appears, as shown in Figure 2-15.
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Figure 2-54 Create Route Distinguisher Pool

You have saved a Route Distinguisher Pool in the Repository.

Create a Route Target Pool
This section describes how to create a Route Target Pool with the ISC GUI. 

To create a Route Target Pool with the ISC GUI, follow these steps: 

Step 1 Log into ISC.

Step 2 Select Service Inventory > Inventory and Connection Manager > Resource Pools. 

The Resource Pools window appears (not shown).

Step 3 Select Route Target from the Pool Type window.

The Resource Pools - Route Target window appears, as shown in Figure 2-55.

Figure 2-55 Create Route Target Pool

Step 4 Click Create.

The Create Route Target Pool window appears, as shown in Figure 2-56.
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Figure 2-56 Create Route Target Pool

Step 5 Enter an RT Pool Start. (50000)

Step 6 Enter an RT Pool Size. (1000)

Step 7 Click Select.

The Select Provider window appears (not shown).

Step 8 Select a Provider.

The Create Route Target Pool window appears, as shown in Figure 2-57.

Figure 2-57 Create Route Target Pool

Step 9 Click Save.

The Resource Pools - Route Target window appears, as shown in Figure 2-58.
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Figure 2-58 Resource Pools - Route Target

You have saved a Route Target Pool in the Repository.

Create a Site of Origin Pool
This section describes how to create a Site of Origin Pool with the ISC GUI. 

To create a Site of Origin Pool with the ISC GUI, follow these steps: 

Step 1 Log into ISC.

Step 2 Select Service Inventory > Inventory and Connection Manager > Resource Pools. 

The Resource Pools window appears (not shown).

Step 3 Select Site of Origin from the Pool Type window.

The Resource Pools - Site of Origin window appears, as shown in Figure 2-59.

Figure 2-59 Resource Pools - Site of Origin

Step 4 Click Create.

The Create Site of Origin Pool window appears, as shown in Figure 2-60.
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Figure 2-60 Create Site of Origin Pool

Step 5 Enter an SOO Pool Start. (50000)

Step 6 Enter an SOO Pool Size. (1000)

Step 7 Click Select.

The Select Provider window appears (not shown).

Step 8 Select a Provider.

The Create Route Target Pool window appears, as shown in Figure 2-61.

Figure 2-61 Resource Pools - Site of Origin

You have saved a Site of Origin Pool in the Repository.

Create a VC ID Pool
This section describes how to create a Virtual Circuit ID (VC ID) Pool with the ISC GUI. 

To create a VC ID Pool with the ISC GUI, follow these steps: 

Step 1 Log into ISC.

Step 2 Select Service Inventory > Inventory and Connection Manager > Resource Pools. 
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The Resource Pools window appears (not shown).

Step 3 Select VC ID from the Pool Type window.

The Resource Pools - VC ID window appears, as shown in Figure 2-62.

Figure 2-62 Resource Pools - VC ID

Step 4 Click Create.

The Create VC ID Pool window appears, as shown in Figure 2-63.

Figure 2-63 Create VC ID Pool

Step 5 Enter an VC Pool Start. (50000).

Step 6 Enter an VC Pool Size. (1000).

Step 7 Click Save.

The Resource Pools - VC ID window appears, as shown in Figure 2-64.
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Figure 2-64 Resource Pools - VC ID

You have saved a VC ID Pool in the Repository.

Create a VLAN Pool
This section describes how to create a VLAN (VC ID) Pool with the ISC GUI. 

To create a VLAN Pool with the ISC GUI, follow these steps: 

Step 1 Log into ISC.

Step 2 Select Service Inventory > Inventory and Connection Manager > Resource Pools. 

The Resource Pools window appears (not shown).

Step 3 Select VLAN from the Pool Type window.

The Resource Pools - VLAN window appears, as shown in Figure 2-65.
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Figure 2-65 Resource Pools - VLAN 

Step 4 Click Create.

The Create VLAN Pool window appears, as shown in Figure 2-66.

Figure 2-66 Select Device

Step 5 Enter an VLAN Pool Start. (500)

Step 6 Enter an VLAN Pool Size. (100)

Step 7 Click Select.

The Select Access Domain window appears, as shown in Figure 2-67.

Figure 2-67 Select Access Domain
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Step 8 Select an Access Domain.

Step 9 Click Select.

The Create VLAN Pool window appears, as shown in Figure 2-68.

Figure 2-68 Create VLAN Pool

Step 10 Click Save.

The Resource Pools - VLAN window appears, as shown in Figure 2-69.

Figure 2-69 Resource Pools - VLAN 

You have saved a VLAN Pool in the Repository.

Defining a VPN 
During service deployment, ISC generates the Cisco IOS commands to configure the logical VPN 
relationships.

At the beginning of the provisioning process, before creating a Service Policy, a VPN must be defined 
within ISC. The first element in a VPN definition is the name of the VPN. 

To create a VPN Name, follow these steps:
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Step 1 Log into ISC.

Step 2 Select Service Inventory > Inventory and Connection Manager > VPNs.

The VPN window appears, as shown in Figure 2-70. 

Figure 2-70 VPNs

Step 3 Click Create to create a VPN.

The Create VPN window appears, as shown in Figure 2-71.

Figure 2-71 Create VPN

Step 4 Enter the VPN Name. (west-xVPN)

Step 5 Click Select.

The Select Customer window appears, as shown in Figure 2-72.
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Figure 2-72 Select Customer

Step 6 Select a Customer and then click Select. (Cust-A)

Step 7 Click Next.

The VPNs window reappears, as shown in Figure 2-73.

Figure 2-73 VPNs

Step 8 To associate the VPN with a Provider, you have two options:

• Select Create Default CE Routing Community and then Select a Provider.

• Select a CE Routing Community, if one is already set up.

Step 9 Click Save.
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The VPN Name (west-xVPN) is associated with the Customer (Cust-A) in this new VPN definition.

Defining an MVRFCE PE-CE Service Policy
To define an MVRFCE PE-CE Service Policy, follow these steps:

Step 1 Log into ISC.

Step 2 Select Service Design > Policies.

The Policies window appears, as shown in Figure 2-74. 

Figure 2-74 Policies

Step 3 From the Create drop-down list, select MPLS Policy.

The MPLS Policy Editor - Policy Type window appears, as shown in Figure 2-75.

Figure 2-75 MPLS Policy Editor - Policy Type

Step 4 Edit the following attributes:
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Step 5 Enter the policy name. (mvrfce pe-ce)

Step 6 Select the Policy Type. (Regular MVRFCE PE-CE)

Step 7 Select CE Present. (CE Present)

Step 8 Click Select to specify a Customer.

The Customer for MPLS Policy ownership window appears, as shown in Figure 2-76.

Figure 2-76 Customer for MPLS Policy

Step 9 Select a Customer and then click Select. (Cust-A)

Step 10 Click Next.

The MPLS Policy Editor - PE Interface window appears, as shown in Figure 2-77.

Figure 2-77 The MPLS Policy Editor - PE Interface

Step 11 Click Next.

The MPLS Policy Editor - CE Interface window appears, as shown in Figure 2-78.
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Figure 2-78 The MPLS Policy Editor - CE Interface

Step 12 Click Next to accept the defaults.

Note Make sure the Editable check boxes are checked, so you can edit these attributes in the Service Request 
process.

The MPLS Policy Editor - PE IP Address Scheme window appears, as shown in Figure 2-79.

Figure 2-79 The MPLS Policy Editor - PE IP Address Scheme

Step 13 Select Automatically Assign IP Addresses.

The IP Address Pool appears with the Region Pool in the window.

Step 14 Click Next.

The MPLS Policy Editor - CE IP Address Scheme window appears, as shown in Figure 2-79.

Figure 2-80 The MPLS Policy Editor - CE IP Address Scheme

Step 15 Select Automatically Assign IP Address. 
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Step 16 Click Next.

The MPLS Policy Editor - PE Routing Information window appears, as shown in Figure 2-81.

Figure 2-81 The MPLS Policy Editor - PE Routing Information

Step 17 Click Next to accept the defaults.

The MPLS Policy Editor - CE Routing Information window appears, as shown in Figure 2-82.

Figure 2-82 The MPLS Policy Editor - CE Routing Information

Step 18 Click Next to accept the defaults.

Note Make sure the Editable check boxes are checked, so you can edit these attributes in the Service Request 
process.

The MPLS Policy Editor - VRF and VPN Membership window appears, as shown in Figure 2-83.
2-51
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Chapter 2      Provisioning an Unmanaged Multi-VRF CE
Defining an MVRFCE PE-CE Service Policy
Figure 2-83 The MPLS Policy Editor - VRF and VPN Membership

Step 19 Click Next to accept the defaults.

Note You could add the VPN here, but in this scenario you add the VPN in the Service Request process. Make 
sure the Editable check boxes are checked, so you can edit these attributes in the Service Request 
process.

Step 20 Click Finish:

The Policies window reappears, as shown in Figure 2-84.

Figure 2-84 Policies

The MVRFCE PE-CE Service Policy is complete.
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Creating an MVRFCE PE-CE Service Request 
To create a MVRFCE PE-CE Service Request, follow these steps:

Step 1 Log into ISC.

Step 2 Select Service Inventory > Inventory and Connection Manager > Service Requests.

The Service Requests window appears, as shown in Figure 2-85. 

Figure 2-85 Service Requests

Step 3 From the Create drop-down list, select MPLS VPN.

The Select MPLS Policy window appears, as shown in Figure 2-86.

Figure 2-86 Select MPLS Policy

Step 4 Select the MPLS Policy. (mvrfce pe-ce)

Step 5 Click OK.

The MPLS Service Request Editor window appears, as shown in Figure 2-87.
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Figure 2-87 MPLS Service Request Editor

Step 6 Click Add Link.

The MPLS Service Request Editor window appears, as shown in Figure 2-88.

Figure 2-88 MPLS Service Request Editor - Select CE

Step 7 Click Select CE.

The Select CPE Device - CE window appears, as shown in Figure 2-89.

Figure 2-89 Select CPE Device - CE
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Step 8 Select the CPE Device and then click Select. (mlce4)

The MPLS Service Request Editor window appears, as shown in Figure 2-90.

Figure 2-90 MPLS Service Request Editor - CE Interface

Step 9 Select the CE Interface from the drop-down box. (FE0/1)

Step 10 Click Select MVRFCE.

The Select CPE Device - MVRFCE window appears, as shown in Figure 2-91.

Figure 2-91 Select CPE Device - MVRFCE

Step 11 Select the MVRFCE and then click Select. (mlce3)

The MPLS Service Request Editor window appears, as shown in Figure 2-92.

Figure 2-92 MPLS Service Request Editor - MVRFCE CE Facing Interface

Step 12 Select the MVRFCE CE Facing Interface from the drop-down box. (E0/2)

Step 13 Select the MVRFCE PE Facing Interface from the drop-down box. (E0/1)
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The MPLS Service Request Editor window appears, as shown in Figure 2-93.

Figure 2-93 MPLS Service Request Editor - Select MVRFCE PE Facing Interface

Step 14 Select PE.

The Select PE Device window appears, as shown in Figure 2-94.

Figure 2-94 Select PE Device

Step 15 Select the PE and then click Select.

The MPLS Link Attribute Editor window appears, as shown in Figure 2-95.

Figure 2-95 MPLS Link Attribute Editor - Interface

Step 16 Select the PE Interface from the drop-down box. (FE0/0)

Step 17 Click Add in the Link Attribute cell.

The MPLS Link Attribute Editor - Interface window appears, as shown in Figure 2-95.
2-56
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Chapter 2      Provisioning an Unmanaged Multi-VRF CE
Creating an MVRFCE PE-CE Service Request
Figure 2-96 MPLS Link Attribute Editor - Interface

Step 18 Enter the VLAN ID for the PE. (510)

Step 19 Click Next.

The MPLS Link Attribute Editor - Interface window appears, as shown in Figure 2-97.
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Figure 2-97 MPLS Link Attribute Editor - Interface

Step 20 Enter the VLAN ID for the MVRFCE. (530)

Click Next.

The MPLS Link Attribute Editor - IP Address Scheme window appears, as shown in Figure 2-98.

Figure 2-98 MPLS Link Attribute Editor - IP Address Scheme

Step 21 Keep the defaults and click Next.

The MPLS Link Attribute Editor - IP Address Scheme window appears, as shown in Figure 2-99.
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Figure 2-99 MPLS Link Attribute Editor - IP Address Scheme

Step 22 Keep the defaults and click Next.

The MPLS Link Attribute Editor - Routing Information window reappears, as shown in Figure 2-100.

Figure 2-100 MPLS Link Attribute Editor - PE Routing Information

Step 23 Keep the defaults and click Next.

The MPLS Link Attribute Editor - Routing Information window reappears, as shown in Figure 2-101.

Figure 2-101 MPLS Link Attribute Editor - MVRFCE Routing Information

Step 24 Keep the defaults and click Next.

The MPLS Link Attribute Editor - VRF and VPN window appears (not shown).
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Step 25 Click Add to select a VPN.

The Select VPN window appears, as shown in Figure 2-102.

Figure 2-102 Select VPN 

Step 26 Select a VPN.

Step 27 Click Join as Hub or Join as Spoke to join the CERC.

Step 28 Click Done.

The MPLS Link Attribute Editor - VRF and VPN window reappears, as shown in Figure 2-103.

Figure 2-103 MPLS Service Request Editor

Step 29 Click Finish.

The MPLS Service Request Editor window appears, as shown in Figure 2-104.
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Figure 2-104 MPLS Service Request Editor

Step 30 Enter the Service Request description and then click Save. (mpls-mvrfce-pe-ce)

The MPLS Service Requests window appears, as shown in Figure 2-105.

Figure 2-105 Service Request 

The MPLS VPN MVRFCE PE-CE Service Request is in the Requested state and ready to deploy. 
2-61
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Chapter 2      Provisioning an Unmanaged Multi-VRF CE
Creating an MVRFCE PE-CE Service Request
2-62
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Cisco IP So
OL-6372-02
C H A P T E R 3

MPLS VPN Service Policies

This chapter describes how to use the IP Solution Center (ISC) GUI to define MPLS VPN Service 
Policies. This chapter contains the following major sections:

• Service Policy Overview, page 3-1

• Creating Service Policies, page 3-7

• Creating an MPLS Service Policy for a PE-to-CE Link, page 3-9

Service Policy Overview
Provisioning an MPLS VPN begins with defining a service policy. A service policy can be applied to 
multiple PE-CE links in a single service request. 

A network operator defines service policies. A service operator uses a service policy to create service 
requests. Each service request contains a list of PE-CE links. When a service operator creates a service 
request, the operator sees only the policy information required to be completed. All the other necessary 
information is filled in by the service policy itself (as well as the Auto Discovery process).

Creating an MPLS VPN in ISC 
At its simplest, a virtual private network (VPN) is a collection of sites that share the same routing table. 
A VPN is also a framework that provides private IP networking over a public infrastructure such as the 
Internet. In IP Solution Center (ISC), a VPN is a set of customer sites that are configured to communicate 
through a VPN service. A VPN is defined by a set of administrative policies.

A VPN is a network in which two sites can communicate over the provider’s network in a private 
manner; that is, no site outside the VPN can intercept their packets or inject new packets. The provider 
network is configured such that only one VPN’s packets can be transmitted through that VPN—that is, 
no data can come in or out of the VPN unless it is specifically configured to allow it. There is a physical 
connection from the provider edge network to the customer edge network, so authentication in the 
conventional sense is not required.

To create a new VPN in ISC: MPLS, follow these steps:

Step 1 Log into ISC.

Step 2 Choose the Service Inventory tab.

Step 3 Choose Inventory and Connection Manager.
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The Inventory and Connection Manager window appears (see Figure 3-1).

Figure 3-1 Creating an MPLS VPN in ISC 

Step 4 From the Inventory and Connection Manager, choose VPNs.

The VPNs dialog box appears (see Figure 3-2).

Figure 3-2 Viewing Existing VPNs or Creating a New VPN

Step 5 From the VPNs dialog box, click Create.

The Create VPN dialog box appears (see Figure 3-3).
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Figure 3-3 Creating an MPLS VPN in ISC 

Step 6 Name: Enter the name of the VPN:

Step 7 Customer: To select the customer associated with this VPN:

a. Click Select.

The Select Customer dialog box appears (see Figure 3-4).

Figure 3-4 Selecting a Customer for the VPN

b. From the list of customers, select the appropriate customer, then click Select.

Step 8 Create Default CE Routing Community: To create a default CE routing community, select the Create 
Default CE Routing Community check box and select a provider. 

Step 9 Enable Multicast: 
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An IP address that starts with the binary prefix 1110 is identified as a multicast group address. There 
can be more than one sender and receiver at any time for a given multicast group address. The senders 
send their data by setting the group address as the destination IP address. It is the responsibility of the 
network to deliver this data to all the receivers in the network who are listening to that group address.

Note Before you can create a VPN with multicast enabled, you must define one or more multicast resource 
pools. See Create a Multicast Pool, page 2-34, for further information.

a. To enable multicast VPN routing, check the Enable Multicast check box.

ISC enables two additional fields required to configure multicast routing (see Figure 3-5).

Figure 3-5 Selecting a Customer for the VPN

To implement multicast routing, ISC employs the concept of a multicast domain (MD), which is a 
set of VRFs associated with interfaces that can send multicast traffic to each other. A VRF contains 
VPN routing and forwarding information for unicast. A multicast VRF contains multicast routing 
and forwarding information and supports multicast routing.

b. Data MDT Size: From the drop-down list, select the data MDT size.

MDT refers to a multicast distribution tree (MDT). The MDT defined here carries multicast traffic 
from customer sites associated with the multicast domain. 

c. Data MDT Threshold: Enter the bandwidth threshold for the data multicast distribution tree.

The data MDT contains a range of multicast group addresses and a bandwidth threshold. Thus, 
whenever a CE behind a multicast-VRF exceeds that bandwidth threshold while sending multicast 
traffic, the PE sets up a new data MDT for the multicast traffic from that source. The PE informs 
the other PEs about this data MDT and, if they have receivers for the corresponding group, the other 
PEs join this data MDT.

Step 10 CE Routing Communities: If you do not choose to enable the default CERC, you can select a customized 
CERC that you have already created in ISC (see Defining CE Routing Communities, page 3-6):

a. From the CE Routing Communities pane, click Select.

The Select CE Routing Communities dialog box appears (see Figure 3-6).
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Figure 3-6 Selecting a CERC

b. Click the check box for the CERC you want used for this VPN, then click Select.

You return to the Create VPN dialog box, where the new CERC selection appears, along with its 
hub route target (HRT) and spoke route target (SRT) values (see Figure 3-7).

Figure 3-7 New CERC Selected

Step 11 Enable VPLS (optional) Select this check box to enable VPLS. 

Step 12 Service Type (optional) Select the VPLS service type from the drop-down menu: ERS (Ethernet Relay 
Service) or EWS (Ethernet Wire Service). 

Step 13 Topology (optional) Select the VPLS topology from the drop-down menu: Full Mesh (each CE will 
have direct connections to every other CE) or Hub and Spoke (only the Hub CE has connection to each 
Spoke CE and the Spoke CEs do not have direct connection to each other).

Step 14 When satisfied with the settings for this VPN, click Save.

You have successfully created a VPN, as shown in the Status display in the lower left corner of the VPNs 
dialog box.
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Defining CE Routing Communities
When you create a VPN, the ISC software creates one default CE routing community (CERC) for you. 
But if your network topology and configuration require customized CERC definitions, you can define 
CERCs customized for your network.

Tip Customized CERCs should be defined only in consultation with the VPN network administrator.

To build complex topologies, it is necessary to break down the required connectivity between CEs into 
groups, where each group is either fully meshed, or has a hub-and-spoke pattern. A CE can be in more 
than one group at a time, so long as each group has one of the two basic configuration patterns. 

Each subgroup in the VPN needs its own CERC. Any CE that is only in one group just joins the 
corresponding CERC (as a spoke if necessary). If a CE is in more than one group, then you can use the 
Advanced Setup choice during provisioning to add the CE to all the relevant groups in one service 
request. Given this information, ISC does the rest, assigning route target values and VRF tables to 
arrange the precise connectivity the customer requires. 

To define a new CERC:

Step 1 Select the Service Inventory tab.

Step 2 Choose Inventory and Connection Manager.

The Inventory and Connection Manager window appears.

Step 3 Choose CE Routing Communities.

The CE Routing Communities dialog box appears (see Figure 3-8).

Figure 3-8 CE Routing Communities Defined for This VPN

Step 4 From the CE Routing Communities dialog box, click Create.

The Create CE Routing Community dialog box appears (see Figure 3-9).
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Figure 3-9 Defining a New CE Routing Community

Step 5 Complete the CERC fields as required for the VPN:

c. Provider: To specify the service provider associated with this CERC, click Select.

The Select Provider dialog box appears.

d. Choose the name of the service provider, then click Select.

e. Name: Enter the name of the CERC.

f. CERC Type: Specify the CERC type: Hub and Spoke or Fully Meshed.

g. Auto-Pick Route Target Values: Choose to either let ISC automatically set the route target (RT) 
values or set the RT values manually.

By default, the Auto-pick route target values check box is checked. If you uncheck the check box, 
you can enter the Route Target values manually.

Caution If you choose to bypass the Auto-pick route target values option and set the route target (RT) values 
manually, note that the RT values cannot be editedafter they have been defined in the Cisco IP Solution 
Center software.

Step 6 When you have finished entering the information in the Create CE Routing Community dialog box, 
click Save.

Creating Service Policies
Provisioning an MPLS VPN begins with defining a service policy. A service policy can be applied to 
multiple PE-CE links in a single service request. 

A network operator defines service policies. A service operator uses a service policy to create service 
requests. Each service request contains a list of PE-CE links. When a service operator creates a service 
request, the operator sees only the policy information required to be completed. All the other necessary 
information is filled in by the service policy itself (as well as the Auto Discovery process).
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The Service Policy Editor
When you define a service policy for ISC, you are presented with a series of dialog boxes that allow you 
to specify the parameters for each major category required to complete an MPLS service request. The 
Service Policy editor presents three columns: Attribute, Value, and Editable:

• Attribute

The Attribute column displays the names of each parameter that you need to define for each major 
category (for example, IP addresses or routing protocols).

• Value

The Value column displays the fields and other selectable items that correspond to each parameter 
and option.

The type of dialog box that is invoked when you edit an attribute depends on the type of attribute. 
In some cases, the value is a simple string value or integer value, in which case a single text entry 
field appears. In other cases, the value is complex or consists of multiple values, such as an IP 
address. In these cases, a dialog box appears so you can specify the required values. The values you 
enter are validated; when invalid values are entered, you receive notification of the invalid values. 
In other cases, you will be presented with check boxes that will allow you to enable or disable a 
particular option.

Note In some cases, changing an attribute’s value results in invalidating the values of related attributes. For 
example, changing the PE interface name can result in invalidating the PE encapsulation value. When 
this occurs, the service policy editor removes the invalid values and you will need to reset them 
appropriately.

There is a parent-child relationship between some attributes. In these cases, changing the value of a 
parent attribute can enable or disable the child attributes. For example, changing the value of the PE 
encapsulation could result in enabling or disabling the DLCI (data link connection identifier), 
VLAN ID, ATM circuit identifiers, and the tunnel source and destination address attributes.

• Editable

The Editable column allows the network operator to indicate the attributes that are likely to change 
across multiple service requests. When attributes are checked as editable, only those attributes will 
be made available to the service operator when creating or modifying service requests with that 
service request policy.

When an attribute category is set to be editable, all the related and child attributes are also editable 
attributes.

About IP Addresses in Cisco ISC
Within a VPN (or extranet), all IP addresses must be unique. Customer IP addresses are not allowed to 
overlap with provider IP addresses. Overlap is possible only when two devices cannot see each other; 
that is, when they are in isolated, non-extranet VPNs.

The ISC: MPLS software assumes that it has an IP address pool to draw addresses from. The only way 
to guarantee that the product can use these addresses freely is if they are provider IP addresses. 

Predefining a unique section (or sections) of IP address space for the PE-CE links is the only way to 
ensure stable security. Thus, because of the security and maintenance issues, Cisco does not recommend 
using customer IP addresses on the PE-CE link.
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Creating an MPLS Service Policy for a PE-to-CE Link
To create an MPLS service policy for a PE-to-CE link, follow these steps:

Step 1 Log into ISC.

Step 2 Select the Service Design tab.

Step 3 Choose Policies.

The Policies window appears (see Figure 3-10).

Figure 3-10 Creating a New Service Policy

Step 4 From the Create drop-down list, choose MPLS Policy.

The MPLS Policy Type dialog box appears (see Figure 3-11). 

Figure 3-11 Defining the MPLS Service Policy
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Step 1 Enter a Policy Name for the MPLS policy.

Step 2 Choose the Policy Owner.

There are three types of MPLS policy ownership:

• Customer ownership

• Provider ownership

• Global ownership: Any service operator can make use of this MPLS policy.

This ownership has relevance when the ISC Role-Based Access Control (RBAC) comes into play. For 
example, an MPLS policy that is customer-owned can only be seen by operators who are allowed to work 
on this customer-owned policy. 

Similarly, operators who are allowed to work on a provider’s network can view, use, and deploy a 
particular provider-owned policy.

Step 3 Click Select to choose the owner of the MPLS policy. (If you choose Global ownership, the Select 
function is not available.) The Select Customer window or the Select Provider window appears and you 
can choose an owner of the policy and click Select.

Step 4 Choose the Policy Type of the MPLS policy. 

There are two policy types for MPLS policies:

• Regular PE-CE: PE-to-CE link

• MVRFCE PE-CE: PE to CE link using the Multi-VRF feature for the PE

Step 5 Select the CE Present check box if you want ISC to ask the service operator who uses this MPLS policy 
to provide a CE router and interface during service activation. The default is CE present in the service.

If you do not select the CE Present check box, ISC asks the service operator, during service activation, 
only for the PE-CLE or the PE-POP router and customer-facing interface. 

Step 6 Click Next.

Specifying the PE and CE Interface Parameters
The MPLS Policy Interface dialog box appears (see Figure 3-12).

Tip You do not have to select a specific interface type for the PE and CE at this point. Notice that the fields 
are set by default to Editable. With the interface parameters set to Editable, the service operator can 
specify the exact interface type and format when he or she creates the service request.

If you want to specify the device interface information for this service policy when the service request 
is created, leave the fields as they are currently set by default, then click Next.
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Figure 3-12 Specifying the PE and CE Interface Parameters

To specify the PE and CE interface information for this MPLS policy:

PE Interface Information

Step 1 Interface Type: From the drop-down list, select the interface type for the PE.

IP Solution Center supports the following interface types (for both PEs and CEs):

• Any

• ATM (Asynchronous Transfer Mode)

• BRI (Basic Rate Interface)

• Ethernet

• Fast Ethernet

• FDDI (Fiber Distributed Data Interface)

• GE-WAN (Gigabit Ethernet WAN)

• Gigabit Ethernet

• HSSI (High Speed Serial Interface)

• Loopback

• MFR

• MultiLink 

• PoS (Packet over Sonet)

• Port-Channel

• Serial

• Switch

• Tunnel
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• VLAN

Step 2 Interface Format: Optionally, you can specify the slot number and port number for the PE interface. 

Specify the format in the standard nomenclature: slot number/port number (for example, 1/0 indicates 
that the interface is located at slot 1, port 0).

This is especially useful to specify here if you know that the link will always go through a particular 
interface’s slot/port location on all or most of the network devices in the service. If this parameter is left 
editable, it can be changed when the service operator creates the service request.

You can also specify the Interface Format as a Channelized Interface: 

• slot/subSlot/port (for example, 2/3/4 indicates that the interface is located at Serial 2/3/4) 

• slot/subSlot/port/T1#:channelGroup# (for example, 2/0/4/6:8 indicates that the interface is 
located at Serial 2/0/4/6:8) 

• slot/subSlot/port.STS-1Path/T1#:channelGroup# (for example, 2/0/0.1/6:8 indicates that the 
interface is located at Serial 2/0/0.1/6:8)

Step 3 Interface Description: Optionally, you can enter a description of the PE interface.

Step 4 Shutdown Interface: When you enable this check box, the specified PE interface is configured in a shut 
down state.

Step 5 Encapsulation: Select the encapsulation used for the specified PE interface type.

When you select an interface type, the Encapsulation field displays a drop-down list of the supported 
encapsulation types for the specified interface type.

Table 3-1 shows the protocol encapsulations available for each of the supported interface types.

Table 3-1 Interface Types and Their Corresponding Encapsulations

Interface Type Encapsulations

ATM AAL5SNAP

BRI Frame-Relay, Frame-Relay-ietf, HDLC (High-Level Data Link Control), 
PPP (Point-to-Point Protocol).

Frame-Relay-ietf sets the encapsulation method to comply with the Internet 
Engineering Task Force (IETF) standard (RFC 1490). Use this method when 
connecting to another vendor’s equipment across a Frame Relay network.

Ethernet Default frame, Dot1Q (802.1Q)

Fast Ethernet Default frame, ISL (Inter-Switch Link), Dot1Q (802.1Q)

FDDI (Fiber Distributed 
Data Interface)

None

Gibabit Ethernet Default frame, ISL (Inter-Switch Link), Dot1Q (802.1Q)

Gigabit Ethernet WAN Default frame, ISL (Inter-Switch Link), Dot1Q (802.1Q)

HSSI (High Speed 
Serial Interface)

Frame-Relay, Frame-Relay-ietf, HDLC (High-Level Data Link Control), 
PPP (Point-to-Point Protocol)

Loopback None.

MFR Frame-Relay, Frame-Relay-ietf, HDLC (High-Level Data Link Control), 
PPP (Point-to-Point Protocol).

MultiLink PPP (Point-to-Point Protocol)

Port-Channel Default frame, ISL (Inter-Switch Link), Dot1Q (802.1Q)
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Step 6 Auto-Pick VLAN ID: Enable this check box to have ISC automatically pick the VLAN ID.

Step 7 Link Speed: Enter a Link Speed (optional) of 10, 100, 1000, or auto.

Step 8 Link Duplex: Enter a Line Duplex (optional) of full, half, or auto.

Step 9 ETTH Support: Enable this check box to configure Ethernet-To-The-Home (ETTH). See 
Ethernet-To-The-Home, page 10-9 for an explanation of ETTH.

CE Interface Information

Step 10 Interface Type: From the drop-down list, select the interface type for the CE.

Step 11 Interface Format: Optionally, you can specify the slot number and port number for the CE interface. 

Step 12 Interface Description: Optionally, you can enter a description of the CE interface.

Step 13 Encapsulation: Select the encapsulation used for the specified CE interface type.

Step 14 When satisfied with the interface settings, click Next.

Specifying the IP Address Scheme
The MPLS Policy Interface Address Selection dialog box appears (see Figure 3-13). This lets you 
specify the IP address scheme you want to use for this service policy.

Figure 3-13 Specifying the IP Address Scheme

Step 1 Define the IP addressing scheme that is appropriate for the PE-CE link.

POS (Packet Over 
Sonet)

Frame-Relay, HDLC (High-Level Data Link Control), PPP (Point-to-Point 
Protocol)

Serial Frame-Relay, Frame-Relay-ietf, HDLC (High-Level Data Link Control), 
PPP (Point-to-Point Protocol)

Switch AAL5SNAP

Tunnel GRE (Generic Routing Encapsulation) - GRE is not supported in this 
release. -

VLAN None

Table 3-1 Interface Types and Their Corresponding Encapsulations (continued)

Interface Type Encapsulations (continued)
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IP Numbering Scheme

A point-to-point link between two routers can be either a numbered IP address or an unnumbered IP 
address. The service provider must determine whether to use numbered or unnumbered IP addresses for 
the PE-CE link. Defining the link to use unnumbered addresses can save precious IP addresses because 
many interfaces can borrow the same IP address. 

You can choose among two options: IP Numbered or IP Unnumbered.

• IP Numbered

If you select IP numbered and choose to not use automatically assigned IP addresses, you can enter 
the IP addresses for the PE interface and CE interface in the fields provided. Entering the IP 
addresses in these fields forces the MPLS VPN software to use the indicated addresses.

If you choose IP numbered and also enable the Automatically Assign IP Address check box, ISC: 
MPLS checks for the presence of the corresponding IP addresses in the router’s configuration file. 
If the addresses are present and they are in the same subnet, ISC uses those addresses (and does not 
allocate them from the address pool). If the IP addresses are not present in the configuration file, 
ISC picks IP addresses from a /30 subnet point-to-point IP address pool.

• IP Unnumbered

IP addresses are drawn from the loopback IP address pool. An unnumbered IP address means that 
each interface “borrows” its address from another interface on the router (usually the loopback 
interface). Unnumbered addresses can only be used on point-to-point WAN links (such as Serial, 
Frame, and ATM), not on LAN links (such as Ethernet). If using IP unnumbered, then both the PE 
and CE must use the same IP unnumbered addressing scheme. When you choose IP unnumbered, 
ISC: MPLS creates a static route for the PE-CE link. 

When you choose IP unnumbered, ISC: MPLS automatically creates a loopback interface (unless 
a loopback interface already exists with the correct attributes). For related information, see Using 
an Existing Loopback Interface Number, page 3-15.

If you select IP unnumbered and choose to not use automatically assigned IP addresses, you can 
enter the IP addresses for the PE interface and CE interface in the fields provided. Entering the IP 
addresses in these fields forces the ISC: MPLS software to use the indicated addresses.

Step 2 Indicate whether an extra loopback interface is required for the CE.

Extra CE Loopback Required

Even though a numbered IP address does not require a loopback address, ISC software provides the 
option to specify than an extra CE loopback interface is required. This option places an IP address on a 
CE router that is not tied to any physical interface.

If you enable Extra CE Loopback Required, you can enter the CE loopback address.

Step 3 Specify whether you want to automatically assign IP addresses.

Automatically Assign IP Address

If you choose IP unnumbered and also enable the Automatically Assign IP Address check box, ISC 
picks two IP addresses from a /32 subnet point-to-point IP address pool.

If you choose IP numbered and also enable the Automatically Assign IP Address check box, ISC 
checks for the presence of the corresponding IP addresses in the router’s configuration file. If the 
addresses are present and they are in the same subnet, ISC uses those addresses (and does not allocate 
them from the address pool). If the IP addresses are not present in the configuration file, ISC picks IP 
addresses from a /30 subnet point-to-point IP address pool.

Step 4 Specify the IP address pool and its associated Region for this service policy.
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IP Address Pool

The IP Address Pool option gives the service operator the ability to have ISC automatically allocate IP 
addresses from the IP address pool attached to the Region. Prior to defining this aspect of the service 
policy, the Region must be defined and the appropriate IP address pools assigned to the Region.

You can specify IP address pool information for point-to-point (IP numbered) PE-CE links.

IP unnumbered addresses are drawn from the loopback IP address pool. An unnumbered IP address 
means that each interface “borrows” its address from another interface on the router (usually the 
loopback interface). Unnumbered addresses can only be used on point-to-point WAN links (such as 
Serial, Frame, and ATM), not on LAN links (such as Ethernet). If using IP unnumbered, then both the 
PE and CE must use the same IP unnumbered addressing scheme.

Step 5 When satisfied with the IP address scheme, click Next.

Using an Existing Loopback Interface Number

On each PE, there is usually only one loopback interface number per VRF for interfaces using IP 
unnumbered addresses. However, if provisioning an interface using IP unnumbered addresses and 
manually assigned IP addresses, it is possible to have more than one loopback interface number under 
the same VRF. When using automatically-assigned IP addresses for provisioning IP unnumbered 
addresses, ISC associates the first loopback number with the same VRF name to the interface. If no 
loopback number already exists, ISC creates one.

If a service provider wants ISC to use an existing loopback interface number (for example, Loopback0), 
the service provider must modify the loopback interface description line in the configuration files for the 
pertinent routers (PE or CE). 

To use the existing loopback interface number, you must modify the loopback interface description line 
so that it includes the keyword VPN-SC, as shown in the following example of a router configuration 
file. 

Note When using an existing loopback interface number on a PE, an additional command line with the “ip vrf 
forwarding <VRF_name>” command must be included directly after the “description” line.

interface Loopback0
description by VPN-SC
ip vrf forwarding <VRF_name> ; This line is required on the PE only
ip address 209.165.202.129 255.255.255.224

You can use an existing loopback interface number only when the interface configuration meets these 
conditions: it must be a WAN serial interface using IP unnumbered addresses.

ISC selects loopback interface numbers by sequence. ISC uses the first loopback interface number that 
meets the requirement—for a CE, it is inclusion of the VPN-SC keyword; for a PE, it is the matching 
VRF name.

For example, if loopback1 and loopback2 include the VPN-SC keyword, but loopback3 does not, adding 
the VPN-SC keyword to loopback3 will not force ISC to select loopback3 for the unnumbered interface 
when using automatically assigned addresses. Loopback1 will be chosen instead. The only way to select 
a specific loopback interface number is to use a manually assigned IP address that matches the desired 
loopback interface number.
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Note Unlike standard interfaces, when loopback interfaces are provisioned in ISC, the resulting configuration 
file does not include a Service Request (SR) ID number. This is because multiple interfaces or service 
requests can use the same loopback interface.

Specifying the Routing Protocol for a Service
You can now specify the routing protocol information for this service policy (see Figure 3-14).

The routing protocol you choose must run on both the PE and the CE. You can choose any one of the 
following protocols:

• Static. Specifies a static route (see Static Protocol Chosen, page 3-17).

• RIP. Routing Information Protocol (see RIP Protocol Chosen, page 3-18).

• BGP. Border Gateway Protocol (see BGP Protocol Chosen, page 3-22).

• OSPF. Open Shortest Path First (see OSPF Protocol Chosen, page 3-25).

• EIGRP. Enhanced Interior Gateway Routing Protocol (see EIGRP Protocol Chosen, page 3-29).

• None. Specifies parameters for cable services (see None Chosen: Cable Services, page 3-34).

To specify a routing protocol for the PE-CE link:

Step 1 Select the appropriate protocol from the Routing Protocol drop-down list.

When you select a particular routing protocol, the related parameters for that protocol are displayed.

Step 2 Enter the required information for the selected routing protocol, then click Next.

Step 3 Define the MPLS Policy VRF and VPN Selection parameters as described in Defining the Service Policy 
VRF and VPN Information, page 3-35.

Redistribution of IP Routes

Route redistribution is the process of taking routing information from one source and importing that 
information into another source. Redistribution should be approached with caution. When you perform 
route redistribution, you lose information. Metrics must be arbitrarily reset. For example, if a group of 
RIP routes with a metric of five hops is redistributed into IGRP, there is no way to translate the five hop 
RIP metric into the composite metric of IGRP. You must arbitrarily select a metric for the RIP routes as 
they are redistributed into IGRP. Also, when redistribution is performed at two or more points between 
two dynamic routing protocol domains, routing loops can occur.

CSC Support

To define a Service Policy with Carrier Supporting Carrier (CSC), choose the CSC Support check box 
from the MPLS Policy Editor - Routing Information. When CSC Support is checked, the CSC 
functionality is enabled to the MPLS VPN service. Provisioning CSC is explained in Chapter 9, 
“Provisioning Carrier Supporting Carrier.”
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Giving Only Default Routes to the CE

When you enable the Give only default routes to CE option, you indicate whether the site needs full 
routing or default routing. Full routing is when the site must know specifically which other routes are 
present in the VPN. Default routing is when it is sufficient to send all packets that are not specifically 
for your site to the VPN. 

If you select this option, ISC configures the default-info originate command on the PE router under the 
running protocol (for RIP, OSPF, or EIGRP). For Static, ISC configures an ip route 0.0.0.0 0.0.0.0 
<out-going interface name> command on the CE router.

A device can only have one default route. Therefore, the VPN can use a default route, but only on 
condition that the customer site does not already have a different one. The most common reason to 
already have a default route is that the site has an Internet feed that is independent of the VPN.

If the CE site already has Internet service, the CE can either route all packets to unknown destinations 
to the Internet or learn all the routes in the Internet. The obvious choice is to route all packets to unknown 
destinations to the Internet. If a site has an Internet feed, it may already have a default route. Under such 
conditions, setting the VPN as the default route is incorrect; the VPN should only route packets meant 
for other VPN sites.

Static Protocol Chosen

Static routing refers to routes to destinations that are listed manually in the router. Network reachability 
in this case is not dependent on the existence and state of the network itself. Whether a destination is up 
or down, the static routes remain in the routing table and traffic is still sent to that destination.

When you select Static as the protocol, four options are enabled: CSC Support, Give Only Default 
Routes to CE, Redistribute Connected (BGP only), and Default Information Originate (BGP only) 
(see Figure 3-14).

Note Two other options (AdvertisedRoutes and Default Routes - Routes to reach other sites) are available 
when you create the service request. See Static Routing Protocols, page 4-12.

Figure 3-14 Specifying the Static Routing Protocol

Step 1 CSC Support: To define a Service Policy with Carrier Supporting Carrier (CSC), choose the CSC 
Support check box from the MPLS Policy Editor - Routing Information. When CSC Support is checked, 
the CSC functionality is enabled to the MPLS VPN service. Provisioning CSC is explained in Chapter 9, 
“Provisioning Carrier Supporting Carrier.”

Step 2 Give Only Default Routes to CE: Specify whether this service policy should give only default routes to 
the CE when provisioning with static routes.
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When you enable the Give only default routes to CE option with static route provisioning on the PE-CE 
link, ISC creates a default route on the CE that points to the PE. The VRF static route to the CE site is 
redistributed into BGP to other sites in the VPN.

When you select this option, the default route (0.0.0.0/32) is automatically configured; the site contains 
no Internet feed or any other requirement for a default route. When the site encounters a packet that does 
not route locally, it can send the packet to the VPN.

If you select this option, ISC configures the default-info originate command on the PE router under the 
running protocol (for RIP, OSPF, or EIGRP). For Static, ISC configures an ip route 0.0.0.0 0.0.0.0 
<out-going interface name> command on the CE router.

Step 3 Redistribute Connected (BGP Only): Indicate whether this service policy should redistribute the 
connected routes to the other CEs in the VPN.

When you enable the Redistribute Connected option, the connected routes (that is, the routes to the 
directly connected PEs or CEs) are distributed to all the other CEs in that particular VPN. This option is 
meant for IBGP if the routing protocol between PE-CE is a non-BGP protocol. For example, if the 
routing protocol is RIP, OSPF, EIGRP, or Static, the option is meant for the router bgp that is configured 
on the PE for the MPLS core. On the PE router, there is one router bgp process running at all times for 
MPLS. This option is also for BGP.

Tip You must enable the Redistribute Connected option when joining the management VPN and you are 
also using IP numbered addresses.

Step 4 Default Information Originate (BGP only): When you enable this option, ISC issues a 
default-information-originate command under the iBGP address family for the currently specified 
VRF.

The Default Information Originate option is required, especially in the hub and spoke topology 
because each spoke must be able to communicate with every other spoke (by injecting a default route in 
the hub PE to the spoke PEs).

Step 5 When finished defining static routing for this service policy, click Next.

The MPLS Policy VRF and VPN Membership dialog box appears. To proceed, see Defining the Service 
Policy VRF and VPN Information, page 3-35.

RIP Protocol Chosen

The Routing Information Protocol (RIP) is a distance-vector protocol that uses hop count as its metric. 
RIP is an interior gateway protocol (IGP), which means that it performs routing within a single 
autonomous system. RIP sends routing-update messages at regular intervals and when the network 
topology changes. When a router receives a routing update that includes changes to an entry, it updates 
its routing table to reflect the new route. The metric value for the path is increased by one, and the sender 
is specified as the next hop. 

RIP routers maintain only the best route to a destination—that is, the route with the lowest possible 
metric value. After updating its routing table, the router immediately begins transmitting routing updates 
to inform other network routers of the change. These updates are sent independently of the regularly 
scheduled updates that RIP routers transmit.

Step 1 To specify RIP as the routing protocol for the service policy, choose RIP from the Routing Protocol 
drop-down list.
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The RIP Routing Protocol dialog box appears (see Figure 3-15).

Figure 3-15 RIP Selected as the Routing Protocol

Step 2 CSC Support: To define a Service Policy with Carrier Supporting Carrier (CSC), choose the CSC 
Support check box from the MPLS Policy Editor - Routing Information. When CSC Support is checked, 
the CSC functionality is enabled to the MPLS VPN service. Provisioning CSC is explained in Chapter 9, 
“Provisioning Carrier Supporting Carrier.”

Step 3 Give Only Default Routes to CE: Specify whether you want to give only the default routes to the CE.

When an internetwork is designed hierarchically, default routes are a useful tool to limit the need to 
propagate routing information. Access-level networks, such as branch offices, typically have only one 
connection to headquarters. Instead of advertising all of an organization’s network prefixes to a branch 
office, configure a default route. If a destination prefix is not in a branch office’s routing table, forward 
the packet over the default route. The Cisco IP routing table displays the default route at the top of the 
routing table as the “Gateway of Last Resort.” RIP automatically redistributes the 0.0.0.0 0.0.0.0 route.

If you select this option, ISC configures the default-info originate command on the PE router under the 
running protocol (for RIP, OSPF, or EIGRP). For Static, ISC configures an ip route 0.0.0.0 0.0.0.0 
<out-going interface name> command on the CE router.

When you enable the Give Only Default Routes to CE option for RIP, ISC creates a default RIP route 
on the PE; the default RIP route points to the PE and is sent to the CE. The provisioning request gives 
you the option of redistributing any other routing protocols in the customer network into the CE RIP 
routing protocol. The RIP routes on the PE to the CE site are redistributed into BGP to other VPN sites.

When you choose this option for RIP routing, the PE instructs the CE to send any traffic it cannot route 
any other way to the PE. Do not use this option if the CE site needs a default route for any reason, such 
as having a separate Internet feed.

Step 4 Redistribute Static (BGP and RIP): Specify whether you want to redistribute static routes into the core 
BGP network.

When you enable the Redistribute Static option for RIP, the software imports the static routes into the 
core network (running BGP) and to the CE (running RIP).

Step 5 Redistribute Connected (BGP Only): Specify whether you want to redistribute the connected routes to 
the CEs in the VPN.

When you enable the Redistribute Connected option for BGP, the software imports the connected 
routes (that is, the routes to the directly connected PEs or CEs) to all the other CEs in that particular 
VPN.

When you enable the Redistribute Connected option, the connected routes (that is, the routes to the 
directly connected PEs or CEs) are distributed to all the other CEs in that particular VPN. This option is 
meant for IBGP if the routing protocol between PE-CE is a non-BGP protocol. For example, if the 
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routing protocol is RIP, OSPF, EIGRP, or Static, the option is meant for the router bgp that is configured 
on the PE for the MPLS core. On the PE router, there is one router bgp process running at all times for 
MPLS. This option is also for BGP.

Step 6 RIP Metrics (BGP only): Enter the appropriate RIP metric value. The valid metric values are 1 
through 16.

The metrics used by RIP are hop counts. The hop count for all directly connected interfaces is 1. If an 
adjacent router advertises a route to another network with a hop count of 1, then the metric for that 
network is 2, since the source router must send a packet to that router to get to the destination network. 

As each router sends its routing tables to its neighbors, a route can be determined to each network within 
the AS. If there are multiple paths within the AS from a router to a network, the router selects the path 
with the smallest hop count and ignores the other paths. 

Step 7 Redistributed Protocols on PE: Specify whether you want to redistribute the routing protocols into 
the PE.

Redistribution allows routing information discovered through another routing protocol to be distributed 
in the update messages of the current routing protocol. With redistribution, you can reach all the points 
of your IP internetwork. When a RIP router receives routing information from another protocol, it 
updates all of its RIP neighbors with the new routing information already discovered by the protocol it 
imports redistribution information from.

To specify the protocols that RIP needs to import routing information to the PE:

a. From the Redistribute Protocols on PE option, click Edit.

The PE Redistributed Protocol dialog box appears.

b. Click Add.

The following dialog box appears (see Figure 3-16).

Figure 3-16 Selecting Protocols to Redistribute into the PE

c. From the Protocol Type drop-down list, select the protocol you want to import into the PE.

You can choose one of the following: Static, OSPF, or EIGRP.

• Redistribute Static

When you select Static routes for redistribution into RIP, ISC imports the static routes into the 
PE that is running RIP.

There are no parameters or metrics required for redistributing Static routes into the PE.

• Redistribute OSPF (Open Shortest Path First)

When you select the OSPF protocol for redistribution into RIP, ISC imports the OSPF routes 
into the PE that is running RIP.
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Parameter: OSPF process number

Metric: Any numeral from 1 to 16

• Redistribute EIGRP (Enhanced IGRP)

When you select the EIGRP protocol for redistribution into RIP, ISC imports the EIGRP routes 
into the PE that is running RIP.

Parameter: EIGRP autonomous system (AS) number

Metric: Any numeral from 1 to 16

d. Select the protocol you want to redistribute into RIP on the PE.

e. Enter the appropriate parameter for the protocol selected.

f. Click Add.

g. Repeat these steps for any additional protocols you want to redistribute into RIP on the PE, then 
click OK.

Step 8 Redistribute Protocols on CE: Specify whether you want to redistribute the routing protocols into the 
CE.

To specify the protocols that RIP needs to import routing information to the CE:

a. From the Redistribute Protocols on CE option, click Edit.

The CE Redistributed Protocol dialog box appears.

b. Click Add.

The following dialog box appears (see Figure 3-17).

Figure 3-17 Selecting Protocols to Redistribute into the CE

c. From the Protocol Type drop-down list, select the protocol you want to import into the CE.

You can choose one of the following protocols: Static, BGP, Connected (routes), IGRP, OSPF, 
EIGRP, or IS-IS.

• Redistribute Static

When you select Static routes for redistribution into RIP, ISC imports the static routes into the 
CE that is running RIP.

There are no parameters required for redistributing Static routes into the CE.

• Redistribute BGP (Border Gateway Protocol)

When you select the BGP protocol for redistribution into RIP, ISC imports the BGP routes into 
the CE that is running RIP.
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Parameter: BGP autonomous system (AS) number

• Redistribute Connected routes

When you select the Connected routes for redistribution into RIP, ISC imports all the routes to 
the interfaces connected to the current router. Use the Connected option when you want to 
advertise a network, but you don’t want to send routing updates into that network. Note that 
redistributing connected routes indiscriminately redistributes all connected routes into the 
routing domain.

Parameter: No parameter required

• Redistribute IGRP (Interior Gateway Routing Protocol) 

When you select the IGRP (Interior Gateway Routing) protocol for redistribution into RIP, 
IP Solution Center imports the IGRP routes into the CE that is running RIP.

Parameter: IGRP autonomous system (AS) number

• Redistribute EIGRP (Enhanced IGRP)

When you select the EIGRP protocol for redistribution into RIP, ISC imports the EIGRP routes 
into the PE that is running RIP.

Parameter: EIGRP autonomous system (AS) number

• Redistribute OSPF (Open Shortest Path First)

When you select the OSPF protocol for redistribution into RIP, ISC imports the OSPF routes 
into the CE that is running RIP.

Parameter: OSPF process number

• Redistribute IS-IS (Intermediate System-to-Intermediate System)

When you select the IS-IS protocol for redistribution into RIP, ISC imports the IS-IS routes into 
the CE that is running RIP.

Parameter: IS-IS tag number

d. Select the protocol you want to redistribute into RIP on the CE.

e. Enter the appropriate parameter for the selected protocol.

f. Click Add.

g. Repeat these steps for any additional protocols you want to redistribute into RIP on the CE, then 
click OK.

Step 9 When you’re satisfied with the RIP protocol settings for this service policy, click Next.

To complete this service policy, go to Defining the Service Policy VRF and VPN Information, page 
3-35.

BGP Protocol Chosen

BGP (Border Gateway Protocol) operates over TCP (Transmission Control Protocol), using port 179. By 
using TCP, BGP is assured of reliable transport, so the BGP protocol itself lacks any form of error 
detection or correction (TCP performs these functions). BGP can operate between peers that are 
separated by several intermediate hops, even when the peers are not necessarily running the BGP 
protocol. 
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BGP operates in one of two modes: Internal BGP (iBGP) or External BGP (EBGP). The protocol uses 
the same packet formats and data structures in either case. IBGP is used between BGP speakers within 
a single autonomous system, while EBGP operates over inter-AS links.

Step 1 To specify BGP as the routing protocol for the service policy, choose BGP from the Routing Protocol 
drop-down list.

The BGP Routing Protocol dialog box appears (see Figure 3-18).

Figure 3-18 BGP Selected as the Routing Protocol

Step 2 CSC Support: To define a Service Policy with Carrier Supporting Carrier (CSC), choose the CSC 
Support check box from the MPLS Policy Editor - Routing Information. When CSC Support is checked, 
the CSC functionality is enabled to the MPLS VPN service. Provisioning CSC is explained in Chapter 9, 
“Provisioning Carrier Supporting Carrier.”

Step 3 Give Only Default Routes to CE: Specify whether you want to give only the default routes to the CE.

When you enable the Give only default routes to CE option, you indicate whether the site needs full 
routing or default routing. Full routing is when the site must know specifically which other routes are 
present in the VPN. Default routing is when it is sufficient to send all packets that are not specifically 
for your site to the VPN. 

If you select this option, ISC configures the default-info originate command on the PE router under the 
running protocol (for RIP, OSPF, or EIGRP). For Static, ISC configures an ip route 0.0.0.0 0.0.0.0 
<out-going interface name> command on the CE router.

Step 4 Redistribute Static (BGP Only): Indicate whether you want to redistribute static routes into BGP.

If you are importing static routes into BGP, select this check box.

Step 5 Redistribute Connected Routes (BGP Only): Indicate whether you want to redistribute the directly 
connected routes into BGP.

Enabling the Redistribute Connected option imports all the routes to the interfaces connected to the 
current router. Use the Redistribute Connected option when you want to advertise a network, but you 
don’t want to send routing updates into that network. Note that redistributing connected routes 
indiscriminately redistributes all connected routes into the routing domain.

When you enable the Redistribute Connected option, the connected routes (that is, the routes to the 
directly connected PEs or CEs) are distributed to all the other CEs in that particular VPN. This option is 
meant for IBGP if the routing protocol between PE-CE is a non-BGP protocol. For example, if the 
routing protocol is RIP, OSPF, EIGRP, or Static, the option is meant for the router bgp that is configured 
on the PE for the MPLS core. On the PE router, there is one router bgp process running at all times for 
MPLS. This option is also for BGP.
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Step 6 CE BGP AS ID: Enter the BGP autonomous system (AS) number for the customer’s BGP network. 

The autonomous number assigned here to the CE must be different from the BGP AS number for the 
service provider’s core network.

Step 7 Neighbor Allow-AS In: If appropriate, enter the Neighbor Allow-AS-in value.

When you enter a Neighbor AllowAS-in value, you specify a maximum number of times (up to 10) that 
the service provider autonomous system (AS) number can occur in the autonomous system path.

Step 8 Neighbor AS Override: If required for this VPN, enable the Neighbor AS Override option.

The AS Override feature allows the MPLS VPN service provider to run the BGP routing protocol with 
a customer even if the customer is using the same AS number at different sites. This feature can be used 
if the VPN customer uses either a private or public autonomous system number.

When you enable the Neighbor AS-Override option, you configure VPN Solutions Center to reuse the 
same AS number on all the VPN’s sites.

Step 9 Specify whether you want to redistribute routing protocols into the CE.

Redistributed Protocols on CE: The redistribution of routes into MP-iBGP is necessary only when the 
routes are learned through any means other than BGP between the PE and CE routers. This includes 
connected subnets and static routes. In the case of routes learned via BGP from the CE, redistribution is 
not required because it’s performed automatically.

To specify the protocols that BGP needs to import routing information to the CE:

a. From the Redistribute Protocols on CE option, click Edit.

The CE Redistributed Protocol dialog box appears.

b. Click Add.

The following dialog box appears (see Figure 3-19).

Figure 3-19 Selecting Protocols to Redistribute into the CE

c. From the Protocol Type drop-down list, select the protocol you want to import into the CE.

You can choose one of the following protocols: Static, RIP, Connected (routes), IGRP, OSPF, 
EIGRP, or IS-IS.

• Redistribute Static

When you select Static routes for redistribution into BGP, ISC imports the static routes into the 
CE that is running BGP.

Parameter: No parameter required

• Redistribute RIP (Border Gateway Protocol)
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When you select the RIP protocol for redistribution into BGP, Cisco ISC imports the RIP routes 
into the CE that is running BGP.

Parameter: No parameter required

• Redistribute Connected routes

When you select the Connected routes for redistribution into BGP, ISC imports all the routes 
to the interfaces connected to the current router. Use the Connected option when you want to 
advertise a network, but you don’t want to send routing updates into that network. Note that 
redistributing connected routes indiscriminately redistributes all connected routes into the 
routing domain.

Parameter: No parameter required

• Redistribute IGRP (Interior Gateway Routing Protocol) 

When you select the IGRP (Interior Gateway Routing) protocol for redistribution into BGP, 
IP Solution Center imports the IGRP routes into the CE that is running BGP.

Parameter: IGRP autonomous system (AS) number

• Redistribute EIGRP (Enhanced IGRP)

When you select the EIGRP protocol for redistribution into BGP, ISC imports the EIGRP 
routes into the CE that is running BGP.

Parameter: EIGRP autonomous system (AS) number

• Redistribute OSPF (Open Shortest Path First)

When you select the OSPF protocol for redistribution into BGP, ISC imports the OSPF routes 
into the CE that is running BGP.

Parameter: OSPF process number

• Redistribute IS-IS (Intermediate System-to-Intermediate System)

When you select the IS-IS protocol for redistribution into BGP, ISC imports the IS-IS routes 
into the CE that is running BGP.

Parameter: IS-IS tag number

d. Select the protocol you want to redistribute into BGP on the CE.

e. Enter the appropriate parameter for the selected protocol.

f. Click Add.

g. Repeat these steps for any additional protocols you want to redistribute into BGP on the PE, then 
click OK.

Step 10 When you’re satisfied with the BGP protocol settings for this service policy, click Next.

To complete this service policy, go to Defining the Service Policy VRF and VPN Information, page 
3-35.

OSPF Protocol Chosen

The MPLS VPN backbone is not a genuine OSPF area 0 backbone. No adjacencies are formed between 
PE routers—only between PEs and CEs. MP-iBGP is used between PEs, and all OSPF routes are 
translated into VPN IPv4 routes. Thus, redistributing routes into BGP does not cause these routes to 
become external OSPF routes when advertised to other member sites of the same VPN.
3-25
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Chapter 3      MPLS VPN Service Policies
Creating an MPLS Service Policy for a PE-to-CE Link
Step 1 To specify OSPF as the routing protocol for the service policy, choose OSPF from the Routing Protocol 
drop-down list. 

The OSPF Routing Protocol dialog box appears (see Figure 3-20).

Figure 3-20 OSPF Selected as the Routing Protocol

Step 2 CSC Support: To define a Service Policy with Carrier Supporting Carrier (CsC), choose the CSC 
Support check box from the MPLS Policy Editor - Routing Information. When CSC Support is checked, 
the CSC functionality is enabled to the MPLS VPN service. Provisioning CSC is explained in Chapter 9, 
“Provisioning Carrier Supporting Carrier.”

Step 3 Give Only Default Routes to CE: Specify whether you want to give only the default routes to the CE.

When you enable the Give only default routes to CE option, you indicate whether the site needs full 
routing or default routing. Full routing is when the site must know specifically which other routes are 
present in the VPN. Default routing is when it is sufficient to send all packets that are not specifically 
for your site to the VPN. 

If you select this option, ISC configures the default-info originate command on the PE router under the 
running protocol RIP or EIGRP and the default-info originate always command on the PE router under 
the running protocol OSPF for Static and configures an ip route 0.0.0.0 0.0.0.0 <out-going interface 
name> command on the CE router.

Step 4 Redistribute Static (BGP Only): Indicate whether you want to redistribute static routes into OSPF.

If you are importing static routes into OSPF, select this check box.

Step 5 Redistribute Connected Routes (BGP Only): Indicate whether you want to redistribute the directly 
connected routes into OSPF.

Enabling the Redistribute Connected option imports all the routes to the interfaces connected to the 
current router. Use the Redistribute Connected option when you want to advertise a network, but you 
don’t want to send routing updates into that network. Note that redistributing connected routes 
indiscriminately redistributes all connected routes into the routing domain.

This option is meant for IBGP if the routing protocol between PE-CE is a non-BGP protocol. For 
example, if the routing protocol is RIP, OSPF, EIGRP, or Static, the option is meant for the router bgp 
that is configured on the PE for the MPLS core. On the PE router, there is one router bgp process running 
at all times for MPLS. This option is also for BGP.

Step 6 OSPF Process ID on PE: Enter the OSPF process ID for the PE.

The OSPF process ID is a unique value assigned for each OSPF routing process within a single 
router—this process ID is internal to the PE only. 
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Step 7 OSPF Process ID on CE: Enter the OSPF process ID for the CE.

The OSPF process ID is a unique value assigned for each OSPF routing process within a single 
router—this process ID is internal to the CE only. You can enter this number either as any decimal 
number from 1 to 65535, or a number in dotted decimal notation.

Step 8 OSPF Process Area Number: Enter the OSPF process area number.

You can enter the OSPF area number for the PE either as any decimal number in the range specified, or 
a number in dotted decimal notation.

Step 9 Redistributed Protocols on PE: If necessary, specify the redistributed protocols into the PE.

Note Restricting the amount of redistribution can be important in an OSPF environment. Whenever a route is 
redistributed into OSPF, it is done so as an external OSPF route. The OSPF protocol floods external 
routes across the OSPF domain, which increases the protocol’s overhead and the CPU load on all the 
routers participating in the OSPF domain.

To specify the protocols that OSPF needs to import to the PE, follow these steps:

a. From the Redistribute Protocols on PE option, click Edit.

The PE Redistributed Protocol dialog box appears.

b. Click Add.

The following dialog box appears (see Figure 3-21).

Figure 3-21 Selecting Protocols to Redistribute into the PE

c. From the Protocol Type drop-down list, select the protocol you want to import into the PE.

You can choose one of the following: Static, EIGRP, or RIP.

• Redistribute Static

When you select Static routes for redistribution into OSPF, ISC imports the static routes into 
the PE that is running OSPF.

There are no parameters or metrics required for redistributing Static routes into the PE.

• Redistribute EIGRP (Enhanced IGRP)

When you select the EIGRP protocol for redistribution into OSPF, ISC imports the EIGRP 
routes into the PE that is running OSPF.

Parameter: EIGRP autonomous system (AS) number

Metric: Any numeral from 1 to 16777214
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• Redistribute RIP

When you select the RIP protocol for redistribution into OSPF, ISC imports the RIP routes into 
the PE that is running OSPF.

Parameter: No parameter required

Metric: Any numeral from 1 to 16777214

d. Select the protocol you want to redistribute into OSPF on the PE.

e. Enter the appropriate parameter for the protocol selected.

f. Click Add.

g. Repeat these steps for any additional protocols you want to redistribute into OSPF on the PE, then 
click OK.

Step 10 Specify whether you want to redistribute the routing protocols into the CE.

Redistribute Protocols on CE: To specify the protocols that OSPF needs to import routing information 
to the CE, follow these steps:

a. From the Redistribute Protocols on CE option, click Edit.

The CE Redistributed Protocol dialog box appears.

b. Click Add.

The following dialog box appears (see Figure 3-22).

Figure 3-22 Selecting Protocols to Redistribute into the CE

c. From the Protocol Type drop-down list, select the protocol you want to import into the CE.

You can choose one of the following protocols: Static, RIP, BGP, Connected (routes), IGRP, 
EIGRP, or IS-IS.

• Redistribute Static

When you select Static routes for redistribution into OSPF, ISC imports the static routes into 
the CE that is running OSPF.

There are no parameters required for redistributing Static routes into the CE.

• Redistribute RIP

When you select the RIP protocol for redistribution into OSPF, ISC imports the RIP routes into 
the CE that is running OSPF.

Parameter: No parameter required

• Redistribute BGP (Border Gateway Protocol)
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When you select the BGP protocol for redistribution into OSPF, ISC imports the BGP routes 
into the CE that is running OSPF.

Parameter: BGP autonomous system (AS) number

• Redistribute Connected routes

When you select the Connected routes for redistribution into OSPF, ISC imports all the routes 
to the interfaces connected to the current router. Use the Connected option when you want to 
advertise a network, but you don’t want to send routing updates into that network. Note that 
redistributing connected routes indiscriminately redistributes all connected routes into the 
routing domain.

Parameter: No parameter required

• Redistribute IGRP (Interior Gateway Routing Protocol) 

When you select the IGRP (Interior Gateway Routing) protocol for redistribution into OSPF, 
IP Solution Center imports the IGRP routes into the CE that is running OSPF.

Parameter: IGRP autonomous system (AS) number

• Redistribute EIGRP (Enhanced IGRP)

When you select the EIGRP protocol for redistribution into OSPF, ISC imports the EIGRP 
routes into the CE that is running OSPF.

Parameter: EIGRP autonomous system (AS) number

• Redistribute IS-IS (Intermediate System-to-Intermediate System)

When you select the IS-IS protocol for redistribution into OSPF, ISC imports the IS-IS routes 
into the CE that is running OSPF.

Parameter: IS-IS tag number

d. Select the protocol you want to redistribute into OSPF on the CE.

e. Enter the appropriate parameter for the selected protocol.

f. Click Add.

g. Repeat these steps for any additional protocols you want to redistribute into OSPF on the CE, then 
click OK.

Step 11 When you’re satisfied with the OSPF protocol settings for this service policy, click Next.

To complete this service policy, go to Defining the Service Policy VRF and VPN Information, page 
3-35.

EIGRP Protocol Chosen

Enhanced IGRP (EIGRP) is a hybrid routing protocol that discovers a network like a distance vector 
protocol (namely IGRP), but maintains a topological database for rapid reconvergence. EIGRP supports 
variable length subnet masks and discontinuous subnets. When configured for IP, it automatically 
redistributes routes with IGRP processes defined in the same autonomous system. By default, EIGRP 
auto-summarizes subnets at the classful network boundaries.

EIGRP performs the same metric accumulation as IGRP. However, if you examine the metric calculation 
between IGRP and EIGRP, you will see that the EIGRP value is much greater. If you divide the EIGRP 
metric by 256, you get the same IGRP metric value.
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EIGRP allows all routers involved in a topology change to synchronize at the same time. Routers that 
are not affected by topology changes are not involved in the recomputation. The result is very fast 
convergence time.

Step 1 To specify EIGRP as the routing protocol for the service policy, choose EIGRP from the Routing 
Protocol drop-down list. 

The EIGRP Routing Protocol dialog box appears (see Figure 3-23).

Figure 3-23 EIGRP Selected as the Routing Protocol

Step 2 CSC Support: To define a Service Policy with Carrier Supporting Carrier (CSC), choose the CSC 
Support check box from the MPLS Policy Editor - Routing Information. When CSC Support is checked, 
the CSC functionality is enabled to the MPLS VPN service. Provisioning CSC is explained in Chapter 9, 
“Provisioning Carrier Supporting Carrier.”

Step 3 Redistribute Static (BGP only): If appropriate, enable the Redistribute Static (BGP only) option.

When you enable the Redistribute Static option for BGP, the software imports the static routes into the 
core network (running BGP).

Step 4 Redistribute Connected (BGP only): If appropriate, enable the Redistribute Connected (BGP only) 
option.

When you enable the Redistribute Connected option, the connected routes (that is, the routes to the 
directly connected PEs or CEs) are distributed to all the other CEs in that particular VPN. This option is 
meant for IBGP if the routing protocol between PE-CE is a non-BGP protocol. For example, if the 
routing protocol is RIP, OSPF, EIGRP, or Static, the option is meant for the router bgp that is configured 
on the PE for the MPLS core. On the PE router, there is one router bgp process running at all times for 
MPLS. This option is also for BGP.

Note Redistributing connected routes can be problematic because all the connected routes are redistributed 
indiscriminately into a specified routing domain. If you do not want all connected routes to be 
redistributed, use a distribute-list out statement to identify the specific connected routes that should be 
redistributed.
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Step 5 EIGRP AS ID on PE: Enter the EIGRP autonomous system ID on the PE. This is a unique 16-bit number. 

Step 6 EIGRP AS ID on CE: Enter the EIGRP autonomous system ID on the CE. This is a unique 16-bit number.

Step 7 Enter the values for the EIGRP metrics as described below.

EIGRP Metrics

EIGRP uses metrics in the same way as IGRP. Each route in the route table has an associated metric. 
EIGRP uses a composite metric much like IGRP, except that it is modified by a multiplier of 256. 
Bandwidth, Delay, Load, Reliability, and MTU are the submetrics. Like IGRP, EIGRP chooses a route 
based primarily on bandwidth and delay, or the composite metric with the lowest numerical value. When 
EIGRP calculates this metric for a route, it calls it the feasible distance to the route. EIGRP calculates a 
feasible distance to all routes in the network. 

Bandwidth Metric: Bandwidth is expressed in units of Kilobits. It must be statically configured to 
accurately represent the interfaces that EIGRP is running on. For example, the default bandwidth of a 
56-kbps interface and a T1 interface is 1,544 kbps. 

Delay Metric: Delay is expressed in microseconds. It, too, must be statically configured to accurately 
represent the interface that EIGRP is running on. The delay on an interface can be adjusted with the delay 
time_in_microseconds interface subcommand. 

Reliability Metric: Reliability is a dynamic number in the range of 1 to 255, where 255 is a 100 percent 
reliable link and 1 is an unreliable link.

Loading Metric: Load is the number in the range of 1 to 255 that shows the output load of an interface. 
This value is dynamic and can be viewed using the show interfaces command. A value of 1 indicates a 
minimally loaded link, whereas 255 indicates a link loaded 100 percent.

MTU Metric: The maximum transmission unit (MTU) is the recorded smallest MTU value in the path, 
usually 1500.

Note Whenever you are influencing routing decisions in IGRP or EIGRP, use the Delay metric over 
Bandwidth. Changing bandwidth can affect other routing protocols, such as OSPF. Changing delay 
affects only IGRP and EIGRP.

Step 8 Redistributed Protocols on PE: If necessary, specify the redistributed protocols on the PE.

When configured for IP, it automatically redistributes routes with IGRP processes defined in the same 
autonomous system. By default, EIGRP auto-summarizes subnets at the classful network boundaries.

To specify the protocols that EIGRP needs to import to the PE:

a. From the Redistribute Protocols on PE option, click Edit.

The PE Redistributed Protocol dialog box appears.

b. Click Add.

The following dialog box appears (see Figure 3-24).
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Figure 3-24 Selecting Protocols to Redistribute into the PE

c. From the Protocol Type drop-down list, select the protocol you want to import into the PE.

You can choose one of the following: Static, RIP, or OSPF.

• Redistribute Static

When you select Static routes for redistribution into EIGRP, ISC imports the static routes into 
the PE that is running OSPF.

There are no parameters or metrics required for redistributing Static routes into the PE.

• Redistribute RIP

When you select the RIP protocol for redistribution into EIGRP, ISC imports the RIP routes 
into the PE that is running EIGRP.

Parameter: No parameter required

Metric: Any numeral from 1 to 16777214

• Redistribute OSPF (Open Shortest Path First)

When you select the OSPF protocol for redistribution into EIGRP, ISC imports the OSPF routes 
into the PE that is running EIGRP.

Parameter: OSPF process number

Metric: Any numeral from 1 to 16

d. Select the protocol you want to redistribute into EIGRP on the CE.

e. Enter the appropriate parameter for the protocol selected.

f. Click Add.

g. Repeat these steps for any additional protocols you want to redistribute into EIGRP on the PE, then 
click OK.

Step 9 Redistribute Protocols on CE: Specify whether you want to redistribute the routing protocols into the 
CE.

To specify the protocols that EIGRP needs to import routing information to the CE:

a. From the Redistribute Protocols on CE option, click Edit.

The CE Redistributed Protocol dialog box appears.

b. Click Add.

The following dialog box appears (see Figure 3-25):
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Figure 3-25 Selecting Protocols to Redistribute into the CE

c. From the Protocol Type drop-down list, select the protocol you want to import into the CE.

You can choose one of the following protocols: Static, BGP, Connected (routes), IGRP, RIP, 
OSPF, or IS-IS.

• Redistribute Static

When you select Static routes for redistribution into EIGRP, ISC imports the static routes into 
the CE that is running OSPF.

There are no parameters required for redistributing Static routes into the CE.

• Redistribute BGP (Border Gateway Protocol)

When you select the BGP protocol for redistribution into EIGRP, ISC imports the BGP routes 
into the CE that is running OSPF.

Parameter: BGP autonomous system (AS) number

• Redistribute Connected routes

When you select the Connected routes for redistribution into EIGRP, ISC imports all the routes 
to the interfaces connected to the current router. Use the Connected option when you want to 
advertise a network, but you don’t want to send routing updates into that network. Note that 
redistributing connected routes indiscriminately redistributes all connected routes into the 
routing domain.

When you enable the Redistribute Connected option, the connected routes (that is, the routes 
to the directly connected PEs or CEs) are distributed to all the other CEs in that particular VPN. 
This option is meant for IBGP if the routing protocol between PE-CE is a non-BGP protocol. 
For example, if the routing protocol is RIP, OSPF, EIGRP, or Static, the option is meant for the 
router bgp that is configured on the PE for the MPLS core. On the PE router, there is one router 
bgp process running at all times for MPLS. This option is also for BGP.

Parameter: No parameter required

• Redistribute IGRP (Interior Gateway Routing Protocol) 

When you select the IGRP (Interior Gateway Routing) protocol for redistribution into EIGRP, 
IP Solution Center imports the IGRP routes into the CE that is running EIGRP.

Parameter: IGRP autonomous system (AS) number

• Redistribute RIP

When you select the RIP protocol for redistribution into EIGRP, Cisco ISC imports the RIP 
routes into the CE that is running EIGRP.

Parameter: No parameter required
3-33
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Chapter 3      MPLS VPN Service Policies
Creating an MPLS Service Policy for a PE-to-CE Link
• Redistribute OSPF (Open Shortest Path First)

When you select the OSPF protocol for redistribution into EIGRP, ISC imports the OSPF routes 
into the CE that is running EIGRP.

Parameter: OSPF process number

• Redistribute IS-IS (Intermediate System-to-Intermediate System)

When you select the IS-IS protocol for redistribution into EIGRP, ISC imports the IS-IS routes 
into the CE that is running EIGRP.

Parameter: IS-IS tag number

d. Select the protocol you want to redistribute into EIGRP on the CE.

e. Enter the appropriate parameter for the selected protocol.

f. Click Add.

g. Repeat these steps for any additional protocols you want to redistribute into EIGRP on the CE, then 
click OK.

Step 10 When you’re satisfied with the EIGRP protocol settings for this service policy, click Next.

To complete this service policy, go to Defining the Service Policy VRF and VPN Information, page 
3-35.

None Chosen: Cable Services

When operating a cable link, the link does not run a routing protocol. The None option in the service 
policy routing protocol dialog box is provided to allow for configuring a service over a cable link 
without having to unnecessarily specify a routing protocol.

Step 1 If this service policy is for cable services, choose None from the list of routing protocols.

The following dialog box appears (see Figure 3-26):

Figure 3-26 No Routing Protocol Selected

Step 2 CSC Support: To define a Service Policy with Carrier Supporting Carrier (CSC), choose the CSC 
Support check box from the MPLS Policy Editor - Routing Information. When CSC Support is checked, 
the CSC functionality is enabled to the MPLS VPN service. Provisioning CSC is explained in Chapter 9, 
“Provisioning Carrier Supporting Carrier.”

Step 3 Redistribute Static: If you want to distribute static routes into the provider core network (which runs 
BGP), check the Redistribute Static (BGP only) check box.
3-34
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Chapter 3      MPLS VPN Service Policies
Creating an MPLS Service Policy for a PE-to-CE Link
Step 4 Redistribute Connected: Because there is no routing protocol on the cable link, we recommend that you 
redistribute the connected routes to all the other CEs in the VPN. To do so, check the Redistribute 
Connected (BGP only) check box.

When you enable the Redistribute Connected option, the connected routes (that is, the routes to the 
directly connected PEs or CEs) are distributed to all the other CEs in that particular VPN. This option is 
meant for IBGP if the routing protocol between PE-CE is a non-BGP protocol. For example, if the 
routing protocol is RIP, OSPF, EIGRP, or Static, the option is meant for the router bgp that is configured 
on the PE for the MPLS core. On the PE router, there is one router bgp process running at all times for 
MPLS. This option is also for BGP.

Step 5 When finished specifying the necessary settings, click Next.

Defining the Service Policy VRF and VPN Information
When you are finished defining the routing protocol(s) for this service policy, you must then specify the 
VRF information. 

The MPLS Policy VRF and VPN Membership dialog box appears (see Figure 3-27).

Figure 3-27 Specifying the VRF Information

To specify the VRF and VPN information for this service policy:

Step 1 Export Map: If necessary, enter the name of the export route map.

The name of the export route map you enter here must be the name of an existing export route map on 
the PE. 

Note The Cisco IOS supports only one export route map per VRF (therefore, there can be only one export 
route map per VPN).
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When you use the ISC software to define a management VPN, ISC automatically generates an export 
route map for the management VPN. Because the Cisco IOS supports only one export route map per VRF 
and that route map is reserved for the management VPN, the Export Map field is not available if the VRF 
is part of the management VPN.

An export route map does not apply a filter; it can be used to override the default set of route targets 
associated with a route.

Step 2 Import Map: Enter the name of the import route map.

The name of the import route map you enter here must be the name of an existing import route map on 
the PE.

Note The Cisco IOS supports only one import route map per VRF—therefore, there can be only one import 
route map per VPN.

An import route map does apply a filter. Therefore, if you want to exclude a particular route from the 
VRF on this PE, you can either set an export route map on the sending router to make sure it does not 
have any route targets that can be imported into the current VRF, or create an import route map on the 
PE to exclude the route.

Step 3 Maximum Routes: Specify the maximum number of routes that can be imported into the VRF on this PE.

Step 4 Maximum Route Threshold: Specify the threshold value for the number of maximum routes. When the 
specified number of maximum routes is exceeded, ISC sends a warning message.

Step 5 VRF Description: Optionally, you can enter a description of the VRF for the current VPN. By default, 
this field states: Provisioned by ISC.

Step 6 Allocate New Route Distinguisher: A route distinguisher (RD) is a 64-bit number appended to each IPv4 
route that ensures that IP addresses that are unique in the VPN are also unique in the MPLS core. This 
extended address is also referred to as a VPN-IPv4 address.

ISC automatically sets the route target (RT) and RD values, but you can assign your own values by 
checking the Allocate new route distinguisher checkbox.

Step 7 VRF and RD Overwrite: When you enable the VRF and RD Overwrite option, this dialog box presents 
two new fields (see Figure 3-28) that allow you to overwrite the default VRF name and route 
distinguisher values.

Caution If not done correctly, changing the default values for the VRF name and the route distinguisher value 
can alter or disable service requests that are currently running. Please make these changes with caution 
and only when absolutely necessary.

Figure 3-28 No Routing Protocol Selected

a. VRF Name: Enter the new VRF name.

b. RD Value: Enter the new RD value.

Step 8 Template Enable: This option determines whether the network devices configured for links within an 
MPLS service request can be associated with MPLS templates.
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When you enable the Template Enable option, the next dialog box that appears will let the service 
operator select the templates to the associated with the MPLS link.

Step 9 PE VPN Membership: In the Select check box, specify the VPN associated with this service policy.

The PE VPN Membership information includes the customer name, VPN name, service provider name, 
CE routing community name, and whether the CERC type is a hub-and-spoke CERC or a fully meshed 
CERC. 

If the Is Hub check box is checked, it indicates that the CERC type is hub-and-spoke.

Using the Add and Delete buttons, you can add a VPN to this list or delete a VPN from this list.

Step 10 When satisfied with the VRF and VPN selections, click Finish.

Now that you have defined a service policy for an MPLS PE-to-CE service, the service operator can now 
use this policy to create and deploy a service request for a PE-CE link. For details, see Chapter 4, “MPLS 
VPN Service Requests.”
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MPLS VPN Service Requests

This chapter describes how to provision and audit service requests in IP Solution Center (ISC). This 
chapter contains the following major sections:

• Overview of Service Requests, page 4-1

• Creating Service Requests, page 4-5

• Deploying Service Requests, page 4-30

• Monitoring Service Requests, page 4-32

• Auditing Service Requests, page 4-33

• Editing Configuration Files, page 4-35

Overview of Service Requests
This section contains the following sections:

• Service Request Transition States, page 4-1

• Service Enhancements, page 4-4

• How ISC Accesses Network Devices, page 4-4

• MPLS VPN Topology Example, page 4-5

Service Request Transition States
The focus of ISC is the service provided for a customer on the link between a customer CE and a provider 
PE. The service request model is the centerpiece of service provisioning. With the service request model, 
the ISC can capture the specified VPN service provisioning request, analyze the validity of the request, 
and audit the provisioning results.

The service provider operators take all service request information from their customers. ISC can assist 
the operator in making entries because the product has customer information such as the VPN 
information, the list of the assigned PEs and CEs, and so forth.

ISC steps the operator through the process and simplifies the task of provisioning the CE and PE by 
automating most of the tasks required to set up an MPLS VPN.

Figure 4-1 shows a high-level diagram of the relationships and movement among ISC service request 
states. For a description of the service request transition sequences, see Appendix B, “Service Request 
Transition States.”
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Figure 4-1 Service Request States: Movement and Relationships

Table 4-1, “Summary of ISC Service Request States,” describes each of the service request states and 
their transition sequences.
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Table 4-1 Summary of ISC Service Request States

Service Request Type Description

Broken The router is correctly configured but the service is unavailable (due to a 
broken cable or Layer 2 problem, for example).

An MPLS service request moves to Broken if the auditor finds the routing 
and forwarding tables for this service, but they do not match the service 
intent.

An IPsec service request moves to Broken if a ping fails for all the remote 
peers of the current device. - IPsec is not supported in this release. - 

Closed A service request moves to Closed if the service request should no longer be 
used during the provisioning or auditing process. A service request moves to 
the Closed state only upon successful audit of a decommission service 
request. ISC does not remove a service request from the database to allow 
for extended auditing. Only a specific administrator purge action results in 
service requests being removed.

Deployed A service request moves to Deployed if the intention of the service request 
is found in the router configuration file. Deployed indicates that the 
configuration file has been downloaded to the router, and the intent of the 
request has been verified at the configuration level. That is, ISC downloaded 
the configlets to the routers and the service request passed the audit process.
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Failed Audit This state indicates that ISC downloaded the configlet to the router 
successfully, but the service request did not pass the audit. Therefore, the 
service did not move to the Deployed state. The Failed Audit state is 
initiated from the Pending state. Once a service request is deployed 
successfully, it cannot re-enter the Failed Audit state (except if the service 
request is redeployed). 

Failed Deploy The cause for a Failed Deploy status is that DCS reports that either the 
upload of the initial configuration file from the routers failed or the 
download of the configuration update to the routers failed (due to lost 
connection, faulty password, and so on).

Functional An MPLS service request moves to Functional when the auditor finds the 
VPN routing and forwarding tables (VRF) for this service and they match 
with the service intent. This state requires that both the configuration file 
audit and the routing audit are successful.

An IPsec service request moves to Functional when the auditor finds that the 
router is configured properly and the IPsec traffic is flowing (ping is used to 
determine if IPsec traffic is flowing). - IPsec is not supported in this 
release. -

Invalid Invalid indicates that the service request information is incorrect in some 
way. A service request moves to Invalid if the request was either internally 
inconsistent or not consistent with the rest of the existing network/router 
configurations (for example, no more interfaces were available on the 
router). The Provisioning Driver cannot generate configuration updates to 
service this request. 

A request moves back to Requested when the Service Request is modified.

Lost A service request moves to Lost when the Auditor cannot find a 
configuration-level verification of intent in the router configuration files. 
The service request was in the Deployed state, but now some or all router 
configuration information is missing. A service request can move to the Lost 
state only when the service request had been Deployed.

Pending A service request moves to Pending when the Provisioning Driver 
determines that the request looks consistent and was able to generate the 
required configuration updates for this request. Pending indicates that the 
service request has generated the configuration updates and the 
configuration updates are successfully downloaded to the routers.

The Auditor regards pending service requests as new requests and begins the 
audit. If the service has been freshly provisioned and not yet audited, it is not 
an error (pending audit). However, if an audit is performed and the service 
is still pending, it is in an error state.

Table 4-1 Summary of ISC Service Request States (continued)

Service Request Type Description
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Service Enhancements
With this release of MPLS VPN Management, a number of enhancements to the service function are 
available:

• A service is no longer limited to a single PE-CE link at a time. Under ISC, a service can be 
comprised of multiple PE-CE links per service request.

• Multicast MPLS VPNs

A multicast address is a single address that represents a group of machines. Unlike a broadcast 
address, however, the machines using a multicast address have all expressed a desire to receive the 
messages sent to the address. A message sent to the broadcast address is received by all IP-speaking 
machines, whether they care what it contains or not. For example, some routing protocols use 
multicast addresses as the destination for their periodic routing messages. This allows machines that 
have no interest in routing updates to ignore them.

To implement multicast routing, ISC employs the concept of a multicast domain (MD), which is a 
set of VRFs associated with interfaces that can send multicast traffic to each other. A VRF contains 
VPN routing and forwarding information for unicast. To support multicast routing, a VRF also 
contains multicast routing and forwarding information; this is called a Multicast VRF.

• Site of Origin support

Although a route target provides the mechanisms to identify which VRFs should receive routes, a 
route target does not provide a facility that can prevent routing loops. These routing loops can occur 
if routes learned from a site are advertised back to that site. To prevent this, the Site of Origin (SOO) 
feature identifies which site originated the route, and therefore, which site should not receive the 
route from any other PE routers.

• Layer 2 access into MPLS VPNs

• Provisioning PE-Only service requests

How ISC Accesses Network Devices
When ISC attempts to access a router, it uses the following algorithm:

1. Checks to see if a terminal server is associated with the device, and if this is the case, ISC uses the 
terminal server to access the device.

2. If there is no terminal server, ISC looks for the management interface on the device.

Requested If the service is newly entered and not yet deployed, it is not an error. 
However, if a Deploy is done and it remains Requested, the service is in an 
error state.

Wait Deploy This service request state pertains only when downloading configlets to a 
Cisco CNS-CE server, such as a Cisco CNS IE2100 appliance. Wait Deploy 
indicates that the configlet has been generated, but it has not been 
downloaded to the Cisco CNS-CE server because the device is not currently 
online. The configlet is staged in the repository until such time as the Cisco 
CNS-CE server notifies ISC that it is up. Configlets in the Wait Deploy state 
are then downloaded to the Cisco CNS-CE server.

Table 4-1 Summary of ISC Service Request States (continued)

Service Request Type Description
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3. If there is no management interface, ISC tries to access the device using the fully-qualified domain 
name (hostname plus domain name).

If any step in the VPN Solutions Center device-access algorithm fails, the entire device access operation 
fails—there is no retry or rollover operation in place. For example, if there is a terminal server and ISC 
encounters an error in attempting to access the target device through the terminal server, the access 
operation fails at that point. With the failure of the terminal server access method, ISC does not attempt 
to find the management interface to access the target device.

Creating Service Requests
A service request is an instance of service contract between a customer edge router (CE) and a provider 
edge router (PE). The service request user interface asks you to enter several parameters, including the 
specific interfaces on the CE and PE routers, routing protocol information, and IP addressing 
information.

You can also integrate an ISC template with a service request, and associate one or more templates to 
the CE and the PE.

To create a service request, a Service Policy must already be defined, as described in Chapter 4, “MPLS 
VPN Service Requests.”

This section has the following sections:

• MPLS VPN Topology Example, page 4-5

• Creating a PE-CE Service Request, page 4-6

• Creating a Multi-VRF Service Request, page 4-15

• Creating a PE-Only Service Request, page 4-24

MPLS VPN Topology Example 
Figure 4-2 shows the topology for the network used to define the service requests in this section. 

PE-CE Example

In the PE-CE example, the service provider needs to create an MPLS service for a CE (mlce1) in their 
customer site Acme_NY (in New York). 

Multi-VRF Example

In the Multi-VRF example, the service provider needs to create an MPLS service between a CE (mlce4) 
in their customer site Widgets_NY (in New York) and a Multi-VRFCE (mlce3) located in their customer 
site Widgets_NY (in New York).

The goal is to create a single service request that defines a link between the customer site in New York 
and the PE (mlpe2).

PE-Only Example

In the PE-Only example, the service provider needs to create an MPLS service for a PE (mlpe2.)
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Figure 4-2 Example Network Topology

Creating a PE-CE Service Request
To create a PE-CE service request, follow these steps:

Step 1 Start up and log into ISC.

a. From the Welcome to ISC window, choose Service Inventory.

b. From the Service Inventory window, choose Inventory and Connection Manager.

c. From the Inventory and Connection Manager window, choose Service Requests.

The Service Requests dialog box appears (see Figure 4-3).
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Figure 4-3 Initial Service Requests Dialog Box

Step 2 To start the process to create a new service, click Create.

A drop-down list is displayed, showing the types of service requests you can create.

Step 3 Choose MPLS VPN.

The Select MPLS Policy dialog box appears (see Figure 4-4).

This dialog box displays the list of all the MPLS service policies that have been defined in ISC.

Figure 4-4 Selecting the MPLS Policy for This Service

Step 4 Select the policy of choice, then click OK.

The MPLS Service Request Editor appears (see Figure 4-5).

Figure 4-5 MPLS Service Request Editor

Step 5 Click Add Link.
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The MPLS Service Request Editor now displays a set of fields, as shown in Figure 4-6. Notice that the 
Select CE field is enabled. Specifying the CE for the link is the first task required to define the link for 
this service.

Figure 4-6 Initial Fields Displayed to Define PE-CE Link

Step 6 CE: Click Select CE.

The Select CPE Device dialog box is displayed (see Figure 4-7). 

Figure 4-7 Selecting the CE for the MPLS Link

a. From the Show CPEs with drop-down list, you can display CEs by Customer Name, by Site, or by 
Device Name.

b. You can use the Find button to either search for a specific CE, or to refresh the display.

c. You can set the Rows per page to 5, 10, 20, 30, 40, or All.

d. This dialog box displays the first page of the list of currently defined CE devices. The number of 
pages of information is displayed in the lower right corner of the dialog box. 

To go to the another page of CE devices, click the number of the page you want to go to. 

Step 7 In the Select column, select the name of the CE for the MPLS link, then click Select.

You return to the Service Request Editor window, where the name of the selected CE is now displayed 
in the CE column.

Step 8 CE Interface: Select the CE interface from the drop-down list (see Figure 4-8).
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Figure 4-8 CE and CE Interface Fields Defined

Note that in the PE column, the Select PE option is now enabled.

Step 9 PE: Click Select PE.

The Select PE Device dialog box is displayed (see Figure 4-9). 

Figure 4-9 Selecting the PE for the MPLS Link

a. From the Show PEs with drop-down list, you can display PEs by Customer Name, by Site, or by 
Device Name.

b. You can use the Find button to either search for a specific PE, or to refresh the display.

c. You can set the Rows per page to 5, 10, 20, 30, 40, or All.

d. This dialog box displays the first page of the list of currently defined PE devices. The number of 
pages of information is displayed in the lower right corner of the dialog box. 

To go to the another page of PE devices, click the number of the page you want to go to. 

Step 10 In the Select column, select the name of the PE for the MPLS link, then click Select.

You return to the Service Request Editor window, where the name of the selected PE is now displayed 
in the PE column.

Step 11 PE Interface: Select the PE interface from the drop-down list (see Figure 4-10).

Figure 4-10 PE and PE Interface Fields Defined
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Note that the Link Attribute Add option is now enabled.

Step 12 In the Link Attribute column, click Add.

The MPLS Link Attribute Editor appears, showing the fields for the interface parameters 
(see Figure 4-11).

Figure 4-11 Specifying the MPLS Link Interface Attributes

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. For details on each of the PE and CE interface fields, see Specifying the PE and CE 
Interface Parameters, page 3-10.

Note The VLAN ID is shared between the PE and CE, so there is one VLAN ID for both.

Step 13 Edit any interface values that must be modified for this particular link, then click Next.

The MPLS Link Attribute Editor for the IP Address Scheme appears (see Figure 4-12).

Figure 4-12 Specifying the MPLS Link IP Address Attributes

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. For details on the IP address scheme fields, see Specifying the IP Address Scheme, 
page 3-13.

Step 14 Edit any IP address scheme values that must be modified for this particular link, then click Next.

The MPLS Link Attribute Editor for Routing Information appears (see Figure 4-13).
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Figure 4-13 Specifying the MPLS Link Routing Protocol Attributes

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. For details on the routing information for the PE and CE, see Specifying the Routing 
Protocol for a Service, page 3-16.

Because the service policy used for this service specified the routing protocol as editable, you can 
change the routing protocol for this service request as needed. 

Note For the Static routing protocol, there are two additional attributes that you can add via the Link 
Attribute Editor. See Static Routing Protocols, page 4-12.

Step 15 Edit any routing protocol values that must be modified for this particular link, then click Next.

The MPLS Link Attribute Editor for the VRF and VPN attributes appears (see Figure 4-14).

Figure 4-14 Specifying the MPLS Link VRF and VPN Attributes

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. For details on the VRF and VPN information, see Defining the Service Policy VRF 
and VPN Information, page 3-35.
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Step 16 Edit any VRF and VPN values that must be modified for this particular link, then click Finish.

You return to the MPLS Service Request Editor. You can define multiple links in this service request. 

Step 17 To save your work on this first link in the service request, click Save.

You return to the Service Requests dialog box, where the information for the link you just defined is now 
displayed (see Figure 4-15). 

Figure 4-15 Service Request for an MPLS Link Completed

You can add additional links to this service request by choosing Add Link and specifying the attributes 
of the next link in the service. As you can see, the service request is in the Requested state. When all the 
links for this service have been defined, you must deploy the service, as described in Deploying Service 
Requests, page 4-30.

Static Routing Protocols

For the static routing protocol, in addition to the attributes that you can specify in the service policy, 
here are two additional attributes that you can add via the Link Attribute Editor. 

• Advertised Routes for CE: allows you to add a list of ip addresses, static routes to put on the PE, 
that describes all the address apace in the CE’s site.

• Routes to Reach other Sites: allows you to add a list of ip addresses, static routes to put on the CE, 
that describes all the address apace throughout the VPN. 

Step 1 When you perform Step 14 on page 4-10 for static routing protocols, the MPLS Link Attribute Editor 
for Routing Information appears (Figure 4-16).
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Figure 4-16 Static Routing Protocol

You can edit Advertised Routes for CE: and Routes to Reach other Sites: for this service request.

Step 2 To edit Advertised Routes for CE:, click EDIT. The Advertised Routes window appears as shown in 
Figure 4-17.

Figure 4-17 Advertised Routes Window

Step 3 Click Add to add IP addresses. The Advertised Routes window appears again as shown in Figure 4-18.
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Figure 4-18 Add IP Address

Step 4 Enter an IP address and a metric. Click Add to add another IP address or click OK.

Step 5 To edit Routes to Reach Other Sites:, click EDIT. The Routes to reach other sites window appears as 
shown in Figure 4-19.

Figure 4-19 Routes to reach other sites Window

Step 6 Click Add to add IP addresses. The Routes to reach other sites window appears again as shown in 
Figure 4-20.

Figure 4-20 Add an IP Address

Step 7 Enter an IP address and a metric. Click Add to add another IP address or click OK.
4-14
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Chapter 4      MPLS VPN Service Requests
Creating Service Requests
Creating a Multi-VRF Service Request
This chapter contains graphics for the following sections:

• Multi-VRF Overview

• Creating an MVRF Service Request

Multi-VRF Overview

MPLS-VPNs provide security and privacy as traffic travels through the provider network. The CE router 
has no mechanism to guarantee private networks across the traditional LAN network. Traditionally to 
provide privacy, either a switch needed to be deployed and each client be placed in a separate VLAN or 
a separate CE router is needed per each client's organization or IP address grouping attaching to a PE. 

These solutions are costly to the customer as additional equipment is needed and requires more network 
management and provisioning of each client site.

Multi-VRF is a new feature, introduced in Cisco IOS release 12.2(4)T, that addresses these issues. 
Multi-VRF extends limited PE functionality to a CE router in an MPLS-VPN model. A CE router now 
has the ability to maintain separate VRF tables in order to extend the privacy and security of an 
MPLS-VPN down to a branch office rather than just at the PE router node.

CE routers use VRF interfaces to form a VLAN-like configuration on the customer side. Each VRF on 
the CE router is mapped to a VRF on the PE router. With Multi-VRF, the CE router can only configure 
VRF interfaces and support VRF routing tables. Multi-VRF extends some of the PE functionality to the 
CE router—there is no label exchange, there is no LDP adjacency, there is no labeled packet flow 
between PE and CE. The only PE-like functionality that is supported is the ability to have multiple VRFs 
on the CE router so that different routing decisions can be made. The packets are sent toward the PE as 
IP packets.

Creating an Multi-VRF Service Request

To create an Multi-VRF service request, follow these steps:

Step 1 Log into ISC.

a. From the Welcome to ISC window, choose Service Inventory.

b. From the Service Inventory window, choose Inventory and Connection Manager.

c. From the Inventory and Connection Manager window, choose Service Requests.

The Service Requests dialog box appears (see Figure 4-21).
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Figure 4-21 Initial Service Requests Dialog Box

Step 2 To create a new service request, click Create.

A drop-down list appears, showing the types of service requests you can create.

Step 3 Choose MPLS VPN.

The Select MPLS Policy dialog box appears (see Figure 4-22).

This dialog box displays the list of all the MPLS service policies that have been defined in ISC.

Figure 4-22 Selecting the Multi-VRF Policy for this Service

Step 4 Select a policy, then click OK.

The MPLS Service Request Editor appears (see Figure 4-23).

Figure 4-23 MPLS Service Request Editor

Step 5 Click Add Link.

The MPLS Service Request Editor now displays a set of fields, as shown in Figure 4-24. Notice that the 
Select CE field is enabled. Specifying the CE for the link is the first task required to define the link for 
this service.
4-16
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Chapter 4      MPLS VPN Service Requests
Creating Service Requests
Figure 4-24 Initial Fields Displayed to Define Multi-VRF Link

Step 6 CE: Click Select CE.

The Select CPE Device dialog box appears (see Figure 4-25).

Figure 4-25 Selecting the CE for the Multi-VRF Link

a. From the Show CPEs with drop-down list, you can display CEs by Customer Name, by Site, or by 
Device Name.

b. You can use the Find button to either search for a specific CE, or to refresh the display.

c. You can set the Rows per page to 5, 10, 20, 30, 40, or All.

d. This dialog box displays the first page of the list of currently defined CE devices. The number of 
pages of information is displayed in the lower right corner of the dialog box. 

To go to the another page of CE devices, click the number of the page you want to go to. 

Step 7 In the Select column, select the name of the CE for the MPLS link, then click Select.

You return to the Service Request Editor window, where the name of the selected CE is now displayed 
in the CE column.

CE Interface: Select the CE interface from the drop-down list (see Figure 4-26).
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Figure 4-26 CE Interface Fields Defined

In the MVRFCE column, the Select MVRFCE option is now enabled. 

Step 8 MVRFCE: Click Select MVRFCE.

The Select CPE Device dialog box is displayed (see Figure 4-27).

Figure 4-27 Selecting the MVRFCE for the Multi-VRF Link

Step 9 In the Select column, select the name of the MVRFCE for the Multi-VRF link, then click Select.

You return to the Service Request Editor window, where the name of the selected MVRFCE is now 
displayed in the MVRFCE column.

Step 10 MVRFCE CE Facing Interface: Select the MVRFCE CE Facing interface from the drop-down list (see 
Figure 4-28).

Step 11 MVRFCE PE Facing Interface: Select the MVRFCE PE Facing interface from the drop-down list (see 
Figure 4-28).
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Figure 4-28 MVRFCE CE and MVRFCE PE Facing Interfaces Defined

Note that in the PE column, the Select PE option is now enabled.

Step 12 PE: Click Select PE.

The Select PE Device dialog box is displayed (see Figure 4-29). 

Figure 4-29 Selecting the PE for the Multi-VRF Link

a. From the Show PEs with drop-down list, you can display PEs by Customer Name, by Site, or by 
Device Name.

b. You can use the Find button to either search for a specific PE, or to refresh the display.

c. You can set the Rows per page to 5, 10, 20, 30, 40, or All.

d. This dialog box displays the first page of the list of currently defined PE devices. The number of 
pages of information is displayed in the lower right corner of the dialog box. 

To go to the another page of PE devices, click the number of the page you want to go to. 
4-19
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Chapter 4      MPLS VPN Service Requests
Creating Service Requests
Step 13 In the Select column, select the name of the PE for the MPLS link, then click Select.

You return to the Service Request Editor window, where the name of the selected PE is now displayed 
in the PE column.

PE Interface: Select the PE interface from the drop-down list (see Figure 4-30).

Figure 4-30 PE Interface Fields Defined 

The Link Attribute Add option is now enabled.

Step 14 In the Link Attribute column, click Add.

The MPLS Link Attribute Editor is displayed, showing the fields for the interface parameters 
(see Figure 4-31).

Figure 4-31 Specifying the PE and MVRFCE PE Facing Link Interface Attributes 

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. For details on each of the PE and CE interface fields, see Specifying the PE and CE 
Interface Parameters, page 3-10.
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Note The VLAN ID is shared between the PE and MVRFCE, so there is one VLAN ID for both.

Step 15 Edit any interface values that must be modified for this particular link, then click Next.

The MPLS Link Attribute Editor appears (see Figure 4-32).

Figure 4-32 Specifying the CE and MVRFCE CE Facing Link Interface Attributes 

Note The VLAN ID is shared between the MVRFCE and CE, so there is one VLAN ID for both.

Step 16 Edit any interface values that must be modified for this particular link, then click Next.

The MPLS Link Attribute Editor for the IP Address Scheme appears (see Figure 4-33).

Figure 4-33 Specifying the PE MVRFCE Link IP Address Attributes 

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. For details on the IP address scheme fields, see the “Specifying the IP Address 
Scheme” section on page 4-13.

Step 17 Edit any interface values that must be modified for this particular link, then click Next.

The MPLS Link Attribute Editor for the IP Address Scheme appears (see Figure 4-34).
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Figure 4-34 Specifying the MVRFCE CE Link IP Address Attributes 

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. For details on the IP address scheme fields, see the “Specifying the IP Address 
Scheme” section on page 4-13.

Step 18 Edit any interface values that must be modified for this particular link, then click Next.

The MPLS Link Attribute Editor for Routing Information appears (see Figure 4-35).

Figure 4-35 Specifying the PE MVRFCE Link Routing Protocol Attributes

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. For details on the routing information for the PE and MVRFCE, see Specifying the 
Routing Protocol for a Service, page 3-16.

Because the service policy used for this service specified the routing protocol as editable, you can 
change the routing protocol for this service request as needed.

Step 19 Edit any routing protocol values that must be modified for this particular link, then click Next.

The MPLS Link Attribute Editor for Routing Information appears (see Figure 4-36).
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Figure 4-36 Specifying the MVRFCE CE Link Routing Protocol Attributes

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. For details on the routing information for the MVRFCE and CE, see Specifying the 
Routing Protocol for a Service, page 3-16.

Because the service policy used for this service specified the routing protocol as editable, you can 
change the routing protocol for this service request as needed.

Step 20 Edit any routing protocol values that must be modified for this particular link, then click Next.

The MPLS Link Attribute Editor for VRF and VPN appears (see Figure 4-37).

Figure 4-37 Specifying the Multi-VRF Link VRF and VPN Attribute

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. For details on the VRF and VPN information, see Defining the Service Policy VRF 
and VPN Information, page 3-35.

Step 21 Edit any VRF and VPN values that must be modified for this particular link, then click Finish.

You return to the MPLS Service Request Editor. You can define multiple links in this service request. 

Step 22 To save your work on this first link in the service request, click Save.

You return to the Service Requests dialog box, where the information for the link you just defined is now 
displayed (see Figure 4-38). 
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Figure 4-38 Service Request for Multi-VRF Links Completed

You can add additional links to this service request by choosing Add Link and specifying the attributes 
of the next link in the service. As you can see, the service request is in the Requested state. When all the 
links for this service have been defined, you must deploy the service, as described in Deploying Service 
Requests, page 4-30.

Creating a PE-Only Service Request
To create a PE-Only (No CE) service request, follow these steps:

Step 1 Start up and log into ISC.

a. From the Welcome to ISC window, choose Service Inventory.

b. From the Service Inventory window, choose Inventory and Connection Manager.

c. From the Inventory and Connection Manager window, choose Service Requests.

The Service Requests dialog box appears (see Figure 4-39).

Figure 4-39 Initial Service Requests Dialog Box

Step 2 To start the process to create a new service, click Create.

A drop-down list is displayed, showing the types of service requests you can create.

Step 3 Choose MPLS VPN.

The Select MPLS Policy dialog box appears (see Figure 4-40).

This dialog box displays the list of all the MPLS service policies that have been defined in ISC.
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Figure 4-40 Selecting the PE-Only Policy for this Service

Step 4 Select the policy that has CE not present, then click OK.

The MPLS Service Request Editor appears (see Figure 4-41).

Figure 4-41 MPLS Service Request Editor

Step 5 Click Add Link.

The MPLS Service Request Editor now displays a set of fields, as shown in Figure 4-42. Notice that the 
Select PE field is enabled. Specifying the PE for the link is the first task required to define the link for 
this service, unless a CLE switch link is needed. If a CLE switch is needed go to “Adding a CLE Service 
Request” section on page 4-29.

Figure 4-42 Initial Fields Displayed to Define PE-Only Link

Step 6 PE: Click Select PE.

The Select PE Device dialog box is displayed (see Figure 4-43).
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Figure 4-43 Selecting the PE for the PE-Only Link

a. From the Show PEs with drop-down list, you can display PEs by Provider Name, by Region, or by 
Device Name.

b. You can use the Find button to either search for a specific PE, or to refresh the display.

c. You can set the Rows per page to 5, 10, 20, 30, 40, or All.

d. This dialog box displays the first page of the list of currently defined PE devices. The number of 
pages of information is displayed in the lower right corner of the dialog box. 

To go to the another page of PE devices, click the number of the page you want to go to. 

Step 7 In the Select column, select the name of the PE for the MPLS link, then click Select.

You return to the Service Request Editor window, where the name of the selected PE is now displayed 
in the PE column.

PE Interface: Select the PE interface from the drop-down list (see Figure 4-44).

Figure 4-44 PE and PE Interface Fields Defined

Note that the Link Attribute Add option is now enabled.
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Step 8 In the Link Attribute column, click Add.

The MPLS Link Attribute Editor is displayed, showing the fields for the interface parameters 
(see Figure 4-45).

Figure 4-45 Specifying the PE-Only Link Interface Attributes 

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. For details on the PE interface fields, see Specifying the PE and CE Interface 
Parameters, page 3-10.

Step 9 Edit any interface values that must be modified for this particular link, then click Next.

The MPLS Link Attribute Editor for the IP Address Scheme appears (see Figure 4-46).

Figure 4-46 Specifying the PE-Only Link IP Address Attributes 

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. For details on the IP address scheme fields, see Specifying the IP Address Scheme, 
page 3-13.

Step 10 Edit any IP address scheme values that must be modified for this particular link, then click Next.

The MPLS Link Attribute Editor for Routing Information appears (see Figure 4-47).
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Figure 4-47 Specifying the PE-Only Routing Protocol Attributes 

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. For details on the routing information for the PE, see Specifying the Routing Protocol 
for a Service, page 3-16.

Because the service policy used for this service specified the routing protocol as editable, you can 
change the routing protocol for this service request as needed.

Step 11 Edit any routing protocol values that must be modified for this particular link, then click Next.

The MPLS Link Attribute Editor for the VRF and VPN attributes appears (see Figure 4-48).

Figure 4-48 Specifying the PE-Only Link VRF and VPN Attributes

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. For details on the VRF and VPN information, see Defining the Service Policy VRF 
and VPN Information, page 3-35.

Step 12 Edit any VRF and VPN values that must be modified for this particular link, then click Finish.

You return to the MPLS Service Request Editor. You can define multiple links in this service request. 

Step 13 To save your work on this first link in the service request, click Save.

You return to the Service Requests dialog box, where the information for the link you just defined is now 
displayed (see Figure 4-49). 
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Figure 4-49 Service Request for an PE-Only Link Completed

You can add additional links to this service request by choosing Add Link and specifying the attributes 
of the next link in the service. As you can see, the service request is in the Requested state. When all the 
links for this service have been defined, you must deploy the service, as described in Deploying Service 
Requests, page 4-30.

Adding a CLE Service Request

To add a CLE link:

Step 1 Follow Step 1 through Step 5 of “Creating a PE-Only Service Request” section on page 4-24.

Step 2 Click Select CLE.

The Select PE Device dialog box is displayed (see Figure 4-50).

Figure 4-50 Selecting the CLE for the PE-Only Link

a. From the Show PEs with drop-down list, you can display PEs by Provider Name, by Region, or by 
Device Name.

b. You can use the Find button to either search for a specific PE, or to refresh the display.

c. You can set the Rows per page to 5, 10, 20, 30, 40, or All.
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d. This dialog box displays the first page of the list of currently defined PE devices. The number of 
pages of information is displayed in the lower right corner of the dialog box. 

To go to the another page of PE devices, click the number of the page you want to go to. 

Step 3 In the Select column, select the name of the CLE for the MPLS link, then click Select.

You return to the Service Request Editor window, where the name of the selected CLE is now displayed 
in the CLE column.

Step 4 CLE Interface: Select the CLE interface from the drop-down list.

Step 5 Continue following Step 8 through Step 13 of “Creating a PE-Only Service Request” section on 
page 4-24.

Deploying Service Requests
When you have queued one or more service requests, you can then deploy them. This procedure 
automatically audits the new service requests. This audit passes the service request into an operational 
state.

ISC sets up a scheduled task that deploys service requests to the appropriate routers. This involves 
computing the configlets for each service request, downloading the configlets to the routers, and running 
audit reports to determine whether the service was successfully deployed.

You can choose to deploy the service requests immediately or schedule their deployment.

Step 1 Start up and log into ISC.

a. From the Welcome to ISC window, choose Service Inventory.

b. From the Service Inventory window, choose Inventory and Connection Manager.

c. From the Inventory and Connection Manager window, choose Service Requests.

The Service Requests dialog box appears (see Figure 4-51).

Figure 4-51 Selecting a Service Requests to Deploy

Step 2 Select the check box next to the Job ID for the service request you want to deploy. 

Step 3 Click the Deploy drop-down list.

You have two deployment options, as shown in Figure 4-52:

• Deploy: Use Deploy when the service request state is Requested or Invalid.
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• Force Deploy: Use Force Deploy when the service request state is Deployed or Failed Audit.

Figure 4-52 Deployment Options

Step 4 Choose Deploy.

The Deploy Service Requests dialog box appears, which allows you to schedule when you want to 
deploy the selected service request (see Figure 4-53).

Figure 4-53 Scheduling a Service Request for Deployment

Step 5 Complete the fields in this dialog box to schedule the service requested as needed.

Step 6 When satisfied with the schedule settings, click Save.

You return to the Service Requests dialog box. Check the Status display in the lower left corner of the 
window. If the service request has been deployed successfully, the Status display appears as shown 
in Figure 4-54.
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Figure 4-54 Status for Successful Deployment

Step 7 To update the State from Requested to Deployed, enable the Auto Refresh check box.

You can view logs to check on the task status and whether or not it completed successfully. To view 
logs, select Monitoring > Task Manager > Logs (for Log details, refer to Cisco IP Solution Center 
Infrastructure Reference on Cisco.com).

Monitoring Service Requests
Once you have created and deployed a service request, you can monitor its status.

Step 1 Choose the Monitoring tab.

Step 2 From the Monitoring window, choose Task Manager.

The Task Manager dialog box is displayed (see Figure 4-55).

Figure 4-55 Viewing Information on Running Tasks

Step 3 Select the check box for the task (that is, service request) that you’re interested in.

Step 4 To see details about the service request’s deployment, click Details.

The Service Request Details window appears (see Figure 4-56).
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Figure 4-56 Service Request Details Displayed

Auditing Service Requests
This section describes auditing in MPLS VPN. It contains the following sections:

• Functional Audit, page 4-33

• Configuration Audit, page 4-34

Functional Audit
A functional audit verifies that the links in a service request or VPN are working correctly. The audit 
checks the routes to remote CEs in the VRF route tables on the PE devices. The user can optionally ping 
the connected CE from the PE to verify that the link is functional.

How to Perform a Functional Audit
ISC automatically provides a functional audit whenever a service request is deployed or 
force-redeployed.

You can also create a task to do a functional audit for one or more service requests. To create a task to 
do a functional audit, follow these steps:

Step 1 Choose Monitoring > Tasks > Audit > MPLS Functional Audit

Step 2 Select one or more service requests in Deployed, Functional, or Broken states as the targets for the task. 

a. You can select a VPN to audit. If you select a VPN to audit, all the links that form the VPN are 
audited.

b. You can select either SR(s) or VPN(s) in one task, but you cannot select both in the same task.

c. After the audit, a schedule page appears. 
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d. You can select a schedule.

e. In the summary page, you can un-check the Perform Ping to verify PE/CE link check box if you do 
not want to invoke ping in that particular task. 

f. For links without CEs (CE not present case), ping is not performed, whether the check box is 
selected or not.

Where to Find the Functional Audit
To find the Functional Audit, follow these steps:

Step 1 Select a service request, and click on Details. 

On the service request details page, the Audit button has two choices: 

• Config

• Functional

Step 2 Click on Functional to display the Functional audit report.

Why a Functional Audit Could Fail 
A Functional Audit could fail for the following reasons:

• BGP peering is incorrect

• MPLS setup in the core is faulty

• Remote links are down

A Ping could fail for the following reasons:

• Physical circuit is not setup correctly

• CE is down 

Configuration Audit
A configuration audit verifies if all the commands for a service (service intent) are present on the 
network elements that participate in the service.

How to Perform a Configuration Audit
ISC automatically does a config audit whenever a service request is deployed or force-redeployed. You 
can also create a task to do a configuration audit for one or more service requests. 

To create a task to do a configuration audit, follow these steps:

Step 1 Choose Monitoring > Tasks > Audit> Config Audit.
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Step 2 Select one or more service requests. 

Step 3 Create a schedule for the config-audit task.

Where to Find the Configuration Audit
After selecting the service request, click on Details. 

On the details page, the Audit button has two choices: 

• Config

• Functional

Click on Config to display the Configuration audit report.

Why a Configuration Audit Could Fail
A configuration audit can fail if some of the commands are removed after provisioning from the network 
elements. This could happen if the commands are manually removed or they are removed as part of 
provisioning some other service.

Editing Configuration Files
To view or edit an existing router configuration file:

Caution Exercise caution when editing a configuration file, particularly if you then choose to make the edited file 
the running configuration file.

Step 1 Choose the Service Inventory tab, then choose Inventory and Connection Manager.

The Inventory and Connection Manager window is displayed.

Step 2 Click Devices.

The Devices dialog box appears (see Figure 4-57).
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Figure 4-57 List of Devices Recognized by ISC 

Step 3 Click the check box next to the device name to select the configuration file versions you want to view.

Step 4 Click Config.

The Device Configurations dialog box appears (see Figure 4-58).

Figure 4-58 List of Configurations for the Selected Device

The Device Configurations dialog box displays the list of the current versions of the configuration files 
for the selected device. The configurations are listed by date and time. The configuration file listed first 
is the latest version.

Step 5 Select the version of the configuration file you want to view, then click Edit.

The contents of the selected configuration file are displayed (see Figure 4-59).
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Figure 4-59 Selected Configuration Displayed

You can view or edit the displayed device configuration file. 

Step 6 If necessary, edit the configuration file.

Step 7 When finished editing the file, click Save.
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C H A P T E R 5

Provisioning Regular PE-CE Links

This chapter describes how to configure MPLS VPN PE-CE links in the IP Solution Center (ISC) 
provisioning process. This chapter contains the following major sections:

• MPLS VPN PE-CE Link Overview, page 5-1

• Creating MPLS VPN PE-CE Service Policies, page 5-5

• Creating MPLS VPN PE-CE Service Requests, page 5-14

MPLS VPN PE-CE Link Overview
This section contains the following sections:

• Network Topology, page 5-2

• Prerequisite Tasks, page 5-2

• Infrastructure Data, page 5-3

To provision an MPLS VPN service in ISC, you must first create an MPLS VPN Service Policy. In ISC, 
a Service Policy is a set of default configurations for creating and deploying a Service Request.

ISC supports two MPLS VPN Service Policy Types: Regular PE-CE and MVRFCE PE-CE. The 
following scenarios focus on the Regular PE-CE Policy Type. 

The Regular PE-CE Policy Type is a normal PE to CE link between two devices. This Policy Type has 
two options:

• CE Present enabled (One PE with one CE; two devices)

• CE Present disabled (PE Only with no CE; one device)

Figure 5-1 shows an example of a normal PE to CE link between two devices.

Figure 5-1 PE to CE link with CE Present 

In a PE to CE link with CE Present enabled, interfaces S3/1 and S1/0 are configured as an MPLS VPN 
link in the Service Request process.

Figure 5-2 shows an example of a PE Only link with no CE.

PE

S3/1 S1/0

CE

mlpe3 mlce11 10
16
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Figure 5-2 PE to CE link with No CE 

In a PE to CE link with CE Present disabled, interface FE0/0 is configured as an MPLS VPN link in the 
Service Request process.

Network Topology 
Figure 5-3 shows an overview of the network topology in which the MPLS VPN PE-CE links are 
created.

Figure 5-3 Network Topology for MPLS VPN PE-CE Scenarios.

The network topology in Figure 5-3 illustrates the lab environment of a service provider (Provider-X) 
and one customer (Cust-A). There is one Region (East-X) and one PE (mlpe3.cisco.com). Each customer 
device (one CE and one CLE) represents a Site (mlce11-Site and mlsw4-Site).

Prerequisite Tasks
Before you can create a Service Policy in ISC, you must complete the following Inventory Management 
tasks:

Step 1 Set up a Customer with a Site. 

Step 2 Setup a Provider with a Region. 

Step 3 Import, create, or discover Devices.

Step 4 Create CPE and PE.

Step 5 Collect Configurations.

Step 6 Create Resource Pools and CE routing communities (CERC).

Step 7 Define a VPN.
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Infrastructure Data
In the subsequent PE-CE scenarios, the following infrastructure data is used:

• Provider: Provider-X

• Region: East-X

• AS#: 99

• PE: mlpe3.cisco.com

• Device Role: PE POP

• Customer: Cust-A

• Site: Cust-A-Site- mlce11

• CE: mlce11.cisco.com

• Device Role: CPE 

• IP Address Pool: 

– Name: Provider-X-East-X

– Type: Region

– Start: 25.5.0.0

– Mask: 30

– Size: 16384

• Route Distinguisher Pool: 

– Name: 99:PROVIDER-X

– Start: 50000

– Size: 10000

• Route Target Pool: 

– Name: 99:PROVIDER-X

– Start: 50000

– Size: 10000

• VPN 

– Definition: east-xVPN

– See: Defining a VPN for the PE-CE Link, page 5-3

Defining a VPN for the PE-CE Link

During service deployment, ISC generates the Cisco IOS commands to configure the logical VPN 
relationships.

At the beginning of the provisioning process, before creating a Service Policy, a VPN must be defined 
within ISC. The first element in a VPN definition is the name of the VPN. 

To create a VPN Name, follow these steps:

Step 1 Log into ISC.
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Step 2 Choose Service Inventory > Inventory and Connection Manager > VPNs.

The VPN window appears, as shown in Figure 5-4. 

Figure 5-4 VPNs

Step 3 Click Create to create a VPN.

The Create VPN window appears, as shown in Figure 5-5.

Figure 5-5 Create VPN

Step 4 Edit the following attributes:

• Name: Enter the vpn name. (east-xVPN)

• Customer: Click Select.
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The Select Customer window appears, as shown in Figure 5-6.

Figure 5-6 Select Customer

Step 5 Choose a Customer and click Select. (Cust-A)

Step 6 Click Save.

The VPNs window reappears, as shown in Figure 5-7.

Figure 5-7 VPNs

The VPN Name (east-xVPN) is associated with the Customer (Cust-A) in this new VPN definition.

Creating MPLS VPN PE-CE Service Policies
This section contains the following sections:

• PE-CE Service Policy Overview, page 5-5

• Creating a PE-CE Service Policy, page 5-6

• Creating a PE-NoCE Service Policy, page 5-10

PE-CE Service Policy Overview

Figure 5-8 shows an example of the PE-CE link that is defined in the PE-CE Service Policy scenario.
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Figure 5-8 PE-CE Topology

Creating a PE-CE Service Policy

To create a PE-CE Service Policy, follow these steps:

Step 1 Log into ISC.

Step 2 Choose Service Design > Policies.

The Policies window appears, as shown in Figure 5-9. 

Figure 5-9 Policies

Step 3 From the Create drop-down list, choose MPLS Policy.

The MPLS Policy Editor - Policy Type window appears, as shown in Figure 5-10.
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Figure 5-10 MPLS Policy Editor - Policy Type

Step 4 Edit the following attributes:

• Policy Name: Enter the policy name. (mpls-pe-ce)

• Policy Owner: Choose the Policy Owner. (Customer)

• Customer: See Step 5.

• Policy Type: Choose the Policy Type. (Regular PE-CE)

• CE Present: Choose CE Present. (CE Present)

Step 5 Click Select to specify a Customer.

The Customer for MPLS Policy ownership window appears, as shown in Figure 5-11.

Figure 5-11 Customer for MPLS Policy

Step 6 Choose a Customer and click Select. (Cust-A)

Step 7 Click Next.

The MPLS Policy Editor - Interface window appears, as shown in Figure 5-12.
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Figure 5-12 The MPLS Policy Editor - Interface

Step 8 Click Next to accept the defaults.

Note Make sure the Editable check boxes are checked, so you can edit these attributes in the Service Request 
process.

The MPLS Policy Editor - IP Address Scheme window appears, as shown in Figure 5-13.

Figure 5-13 The MPLS Policy Editor - IP Address Scheme

Step 9 Edit the following attributes:

• IP Numbering Scheme: Choose an IP Numbering Scheme. (IP Numbered)

• Automatically Assign IP Address: To have ISC automatically assign IP Addresses, click the check 
box.

• IP Address Pool: Choose the IP Address Pool. (Region Pool)

Step 10 Click Next.

The MPLS Policy Editor - Routing Information window appears, as shown in Figure 5-14.
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Figure 5-14 The MPLS Policy Editor - Routing Information

Step 11 Click Next to accept the defaults.

Note Make sure the Editable check boxes are checked, so you can edit these attributes in the Service Request 
process.

The MPLS Policy Editor - VRF and VPN Membership window appears, as shown in Figure 5-15.

Figure 5-15 The MPLS Policy Editor - VRF and VPN Membership

Step 12 Click Next to accept the defaults.

Note Make sure the Editable check boxes are checked, so you can edit these attributes in the Service Request 
process.

Step 13 Choose Finish.

The Policies window reappears, as shown in Figure 5-16.
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Figure 5-16 Policies

The MPLS VPN PE-CE Service Policy is complete.

Creating a PE-NoCE Service Policy

To create a PE-NoCE Service Policy, follow these steps:

Step 1 Log into ISC.

Step 2 Choose Service Design > Policies.

The Policies window appears, as shown in Figure 5-17. 

Figure 5-17 Policies

Step 3 From the Create drop-down list, choose MPLS Policy.

The MPLS Policy Editor - Policy Type window appears, as shown in Figure 5-18.
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Figure 5-18 MPLS Policy Editor - Policy Type

Step 4 Edit the following attributes:

• Policy Name: Enter the policy name. (mpls-pe-noce)

• Policy Owner: Choose the Policy Owner. (Customer)

• Customer: See Step 5.

• Policy Type: Choose the Policy Type. (Regular PE-CE)

• CE Present: Do not choose CE Present.

Step 5 Click Select to specify a Customer.

The Customer for MPLS Policy window appears, as shown in Figure 5-19.

Figure 5-19 Customer for MPLS Policy

Step 6 Choose a Customer and click Select. (Cust-A)

Step 7 Click Next.

The MPLS Policy Editor - Interface window appears, as shown in Figure 5-20.
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Figure 5-20 The MPLS Policy Editor - Interface

Step 8 Click Next to accept the defaults.

Note Make sure the Editable check boxes are checked, so you can edit these attributes in the Service Request 
process.

The MPLS Policy Editor - IP Address Scheme window appears, as shown in Figure 5-21.

Figure 5-21 The MPLS Policy Editor - IP Address Scheme

Step 9 Edit the following attributes:

• IP Numbering Scheme: Choose the IP Numbering Scheme. (IP Numbered)

• Automatically Assign IP Address: To have ISC automatically assign IP Addresses, click the check 
box.

• IP Address Pool: Choose the IP Address Pool. (Region Pool)

• Click Next.

Step 10 Click Next.

The MPLS Policy Editor - Routing Information window appears, as shown in Figure 5-22.
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Figure 5-22 The MPLS Policy Editor - Routing Information

Step 11 Click Next to accept the defaults.

Note Make sure the Editable check boxes are checked, so you can edit these attributes in the Service Request 
process.

The MPLS Policy Editor - VRF and VPN Membership window appears, as shown in Figure 5-23.

Figure 5-23 The MPLS Policy Editor - VRF and VPN Membership

Step 12 Accept the default attributes and choose Finish.

The Policies window reappears, as shown in Figure 5-24.
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Figure 5-24 Policies

The MPLS VPN PE-NoCE Service Policy is complete.

Creating MPLS VPN PE-CE Service Requests
This section contains the following sections:

• Creating a PE-CE Service Request, page 5-14

• Creating a PE-NoCE Service Request, page 5-21

Creating a PE-CE Service Request

To create a PE-CE Service Request, follow these steps:

Step 1 Log into ISC.

Step 2 Choose Service Inventory > Inventory and Connection Manager > Service Requests.

The Service Requests window appears, as shown in Figure 5-25. 

Figure 5-25 Service Requests

Step 3 From the Create drop-down list, choose MPLS VPN.

The Select MPLS Policy window appears, as shown in Figure 5-26.
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Figure 5-26 Select MPLS Policy

Step 4 Choose the MPLS Policy. (mpls-pe-ce)

Step 5 Click OK.

The MPLS Service Request Editor window appears, as shown in Figure 5-27.

Figure 5-27 MPLS Service Request Editor

Step 6 Click Add Link.

The MPLS Service Request Editor window appears, as shown in Figure 5-28.
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Figure 5-28 MPLS Service Request Editor - Select CE

Step 7 Click Select CE.

The CPE for MPLS VPN Link window appears, as shown in Figure 5-29.

Figure 5-29 CPE for MPLS VPN Link

Step 8 Choose the CPE device (mlce10) and click Select. 

The MPLS Service Request Editor window appears.

Step 9 Choose the CE Interface from the drop-down box. (S1/0)

The MPLS Service Request Editor window appears.

Step 10 Click Select PE.

The PE for MPLS VPN Link window appears, as shown in Figure 5-30.
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Figure 5-30 PE for MPLS VPN Link

Step 11 Choose the PE device (mlpe2) and click Select. 

The MPLS Service Request Editor window appears.

Step 12 Choose the PE Interface from the drop-down box. (S3/1)

The MPLS Service Request Editor window appears.

Step 13 Click Select PE.

The PE for MPLS VPN Link window appears, as shown in Figure 5-31.

Figure 5-31 MPLS Service Request Editor 

Step 14 Click Add in the Link Attribute cell.

The MPLS Link Attribute Editor - Interface window appears, as shown in Figure 5-32.
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Figure 5-32 MPLS Link Attribute Editor - Interface

PE Information

Step 15 Encapsulation: Choose the PE Encapsulation from the drop-down box. (Frame_Relay)

Step 16 DLCI: Enter the CE DLCI. (100)

CE Information

Step 17 Encapsulation: Choose the PE Encapsulation from the drop-down box. (Frame_Relay)

Step 18 DLCI: Enter the PE DLCI. (100)

Step 19 Click Next.

The MPLS Link Attribute Editor - IP Address Scheme window appears, as shown in Figure 5-33.

Figure 5-33 MPLS Link Attribute Editor - IP Address Scheme

Step 20 Accept the defaults and click Next.

The MPLS Link Attribute Editor - Routing Information window reappears, as shown in Figure 5-34.
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Figure 5-34 MPLS Link Attribute Editor - Routing Information

Step 21 Accept the defaults and click Next.

The MPLS Link Attribute Editor - VRF and VPN window appears, as shown in Figure 5-35.

Figure 5-35 MPLS Link Attribute Editor - VRF and VPN 

Step 22 Click Add to join VPN. The Select CERCs window appears as show in Figure 5-36.
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Figure 5-36 Select CERCs Window

Step 23 Select a Customer from the drop-down menu. Select a VPN from the drop-down menu. Select a VPN 
from the list.

Step 24 Click Join As Hub or Join As Spoke.

Step 25 Click Done. The MPLS Link Attribute Editor - VRF and VPN window reappears, as shown in 
Figure 5-37.

Figure 5-37 MPLS Service Request Editor

Step 26 Click Finish.

The MPLS Service Request Editor window reappears, as shown in Figure 5-38.
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Figure 5-38 MPLS Service Request Editor

Step 27 Enter the Service Request description and click Save. (mpls-pe-ce)

The MPLS Service Requests window reappears, as shown in Figure 5-39.

Figure 5-39 Service Request 

The MPLS VPN PE-CE Service Request is in the Requested state and ready to deploy. 

Creating a PE-NoCE Service Request

To create a PE-NoCE Service Request, follow these steps:

Step 1 Log into ISC.

Step 2 Choose Service Inventory > Inventory and Connection Manager > Service Requests.

The Service Requests window appears, as shown in Figure 5-40. 
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Figure 5-40 Service Requests

Step 3 From the Create drop-down list, choose MPLS VPN.

The Select MPLS Policy window appears, as shown in Figure 5-41.

Figure 5-41 Select MPLS Policy

Step 4 Choose the MPLS Policy. (mpls-pe-ce)

Step 5 Click OK.

The MPLS Service Request Editor window appears, as shown in Figure 5-42.
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Figure 5-42 MPLS Service Request Editor

Step 6 Click Add Link.

The MPLS Service Request Editor window appears, as shown in Figure 5-43.

Figure 5-43 MPLS Service Request Editor - Select CE

Step 7 Click Select PE.

The PE for MPLS VPN Link window appears, as shown in Figure 5-44.
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Figure 5-44 PE for MPLS VPN Link

Step 8 Choose the PE device (mlpe4) and click Select. 

The MPLS Service Request Editor window appears.

Step 9 Choose the PE Interface from the drop-down box. (FE0/0)

The MPLS Service Request Editor window appears, as shown in Figure 5-45.

Figure 5-45 MPLS Service Request Editor 

Step 10 Click Add in the Link Attribute cell.

The MPLS Link Attribute Editor - Interface window appears, as shown in Figure 5-46.
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Figure 5-46 MPLS Link Attribute Editor - Interface

Step 11 Choose the CE Encapsulation from the drop-down box. (DOT1Q)

Note This field is needed for deciding PE/UNI encapsulation.

Step 12 Click Next.

The MPLS Link Attribute Editor - IP Address Scheme window appears, as shown in Figure 5-47.

Figure 5-47 MPLS Link Attribute Editor - IP Address Scheme

Step 13 Accept the defaults and click Next.

The MPLS Link Attribute Editor - Routing Information window reappears, as shown in Figure 5-48.
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Figure 5-48 MPLS Link Attribute Editor - Routing Information

Step 14 Accept the defaults and click Next.

The MPLS Link Attribute Editor - VRF and VPN window reappears, as shown in Figure 5-49.

Figure 5-49 MPLS Link Attribute Editor - VRF and VPN 

Click Add to join the VPN.

The Join VPN dialog box appears, as shown in Figure 5-50.
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Figure 5-50 MPLS Service Request Editor

Step 15 Click the check box to choose the VPN. (Cust-A east-xVPN)

Step 16 Click Join as Hub or Join as Spoke. (Join as Spoke)

Click Done.

The MPLS Service Request Editor window reappears, as shown in Figure 5-51.

Figure 5-51 MPLS Service Request Editor

Step 17 Click Finish.

The MPLS Service Requests Editor window reappears, as shown in Figure 5-52.
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Figure 5-52 MPLS Service Request Editor

Step 18 Enter the Service Request description and click Save. (mpls-pe-noce)

The MPLS Service Requests window reappears, as shown in Figure 5-53.

Figure 5-53 Service Request 

The MPLS VPN PE-NoCE Service Request is ready to deploy. 
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Provisioning MVRFCE PE-CE Links

This chapter describes how to configure MPLS VPN MVRFCE PE-CE links in the IP Solution Center 
(ISC) provisioning process. This chapter contains the following major sections:

• MPLS VPN MVRFCE PE-CE Link Overview, page 6-1

• Creating MPLS VPN MVRFCE PE-CE Service Policies, page 6-6

• Creating MPLS VPN MVRFCE PE-CE Service Requests, page 6-18

MPLS VPN MVRFCE PE-CE Link Overview
This section contains the following sections:

• Network Topology, page 6-2

• Prerequisite Tasks, page 6-3

• Infrastructure Data, page 6-3

To provision an MPLS VPN service in ISC, you must first create an MPLS VPN Service Policy. In ISC, 
a Service Policy is a set of default configurations for creating and deploying a Service Request.

ISC supports two MPLS VPN Service Policy Types: Regular PE-CE an MVRFCE PE-CE. The following 
scenarios focus on the MVRFCE PE-CE Policy Type. 

An MVRFCE PE-CE Policy Type is a PE to CE link with three devices:

• PE

• Multi-VRF CE

• CE

This Policy Type has two options:

• CE Present enabled (One PE with one MVRFCE and one CE; three devices)

• CE Present disabled (One PE with one MVRFCE; two devices)

Figure 6-1 shows an example of an MVRFCE PE-CE link with three devices.
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Figure 6-1 MVRFCE PE-CE Link

In an MVRFCE PE-CE link with CE Present enabled, interfaces FE 0/0, E 0/1, E 0/2 and FE 0/1 are 
configured as an MPLS VPN link in the Service Request process.

Figure 6-2 shows an example of a PE to MVRFCE link with no CE.

Figure 6-2 MVRFCE PE-CE Link with No CE 

In an MVRFCE PE-CE link with CE Present disabled, interfaces FE 0/0, E 0/1, and E 0/2 are configured 
as an MPLS VPN link in the Service Request process.

Network Topology 
Figure 6-3 shows an overview of the network topology in which the MPLS VPN MVRFCE PE-CE links 
are created.

Figure 6-3 Network Topology for MPLS VPN MVRFCE PE-CE Scenarios 

The network topology in Figure 6-3 illustrates the lab environment of a service provider (Provider-X) 
and one customer (Cust-A). There is one Region (West-X) and one PE (mlpe2.cisco.com). Each 
customer device (one MVRFCE and one CE) represents a Site (mlce3-Site and mlce4-Site).
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Prerequisite Tasks
Before you can create a Service Policy in ISC, you must complete the following Inventory Management 
tasks:

Step 1 Set up a Customer with a Site. 

Step 2 Setup a Provider with a Region. 

Step 3 Import, create, or discover Devices.

Step 4 Create CPE and PE.

Step 5 Collect Configurations.

Step 6 Create Resource Pools and CE routing communities (CERC).

Step 7 Define a VPN.

Infrastructure Data
In the subsequent MVRFCE PE-CE scenarios, the following infrastructure data is used:

• Provider: Provider-X

• Region: West-X

• AS#: 99

• PE: mlpe2.cisco.com

• Device Role: PE POP

• Customer: Cust-A

• Site: Cust-A-Site- mlce3

• CE: mlce3.cisco.com

• Site: Cust-A-Site- mlce4

• CE: mlce4.cisco.com

• Device Role: CPE 

• IP Address Pool: 

– Name: Provider-X-West-X

– Type: Region

– Start: 25.7.0.0

– Mask: 30

– Size: 16384

• Route Distinguisher Pool: 

– Name: 99:PROVIDER-X

– Start: 50000

– Size: 10000
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• Route Target Pool: 

– Name: 99:PROVIDER-X

– Start: 50000

– Size: 10000

• VPN 

– Definition: west-xVPN

– See: Defining a VPN for the MVRFCE PE-CE Link, page 6-4

Defining a VPN for the MVRFCE PE-CE Link

During service deployment, ISC generates the Cisco IOS commands to configure the logical VPN 
relationships.

At the beginning of the provisioning process, before creating a Service Policy, a VPN must be defined 
within ISC. The first element in a VPN definition is the name of the VPN. 

To create a VPN Name, follow these steps:

Step 1 Log into ISC.

Step 2 Choose Service Inventory > Inventory and Connection Manager > VPNs.

The VPN window appears, as shown in Figure 6-4. 

Figure 6-4 VPNs

Step 3 Click Create to create a VPN.

The Create VPN window appears, as shown in Figure 6-5.
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Figure 6-5 Create VPN

Step 4 Edit the following attributes:

• Name: Enter the vpn name. (west-xVPN)

• Customer: Click Select.

The Select Customer window appears, as shown in Figure 6-6.

Figure 6-6 Select Customer

Step 5 Choose a Customer and click Select. (Cust-A)

Step 6 Click Next.

The VPNs window reappears, as shown in Figure 6-7.
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Figure 6-7 VPNs

The VPN Name (west-xVPN) is associated with the Customer (Cust-A) in this new VPN definition.

Creating MPLS VPN MVRFCE PE-CE Service Policies
This section contains the following sections:

• Creating a MVRFCE PE-CE Service Policy, page 6-6

• Creating a PE-NoCE Service Policy, page 6-12

Creating a MVRFCE PE-CE Service Policy
To create a MVRFCE PE-CE Service Policy, follow these steps:

Step 1 Log into ISC.

Step 2 Choose Service Design > Policy Manager.

The Policies window appears, as shown in Figure 6-8. 
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Figure 6-8 Policies

Step 3 From the Create drop-down list, choose MPLS Policy.

The MPLS Policy Editor - Policy Type window appears, as shown in Figure 6-9.

Figure 6-9 MPLS Policy Editor - Policy Type

Step 4 Edit the following attributes:

• Policy Name: Enter the policy name. (mpls-mvrfce-pe-ce)

• Policy Owner: Choose the Policy Owner. (Customer)

• Customer: See Step 5.

• Policy Type: Choose the Policy Type. (Regular MVRFCE PE-CE)

• CE Present: Choose CE Present. (CE Present)

Step 5 Click Select to specify a Customer.

The Customer for MPLS Policy ownership window appears, as shown in Figure 6-10.
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Figure 6-10 Customer for MPLS Policy

Step 6 Choose a Customer and click Select. (Cust-A)

Step 7 Click Next.

The MPLS Policy Editor - PE Interface window appears, as shown in Figure 6-11.

Figure 6-11 The MPLS Policy Editor - PE Interface

Step 8 Click Next.

The MPLS Policy Editor - Interface window appears, as shown in Figure 6-11.
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Figure 6-12 The MPLS Policy Editor - CE Interface

Step 9 Click Next to accept the defaults.

Note Make sure the Editable check boxes are checked, so you can edit these attributes in the Service Request 
process.

The MPLS Policy Editor - IP Address Scheme window appears, as shown in Figure 6-13.

Figure 6-13 The MPLS Policy Editor - IP Address Scheme

The MPLS Policy Editor - IP Address Scheme window appears, as shown in Figure 6-13.

Figure 6-14 The MPLS Policy Editor - IP Address Scheme

Step 10 Edit the following attributes:

• IP Numbering Scheme: Choose an IP Numbering Scheme. (IP Numbered)

• Automatically Assign IP Address: To have ISC automatically assign IP Addresses, click the check 
box.
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• IP Address Pool: Choose the IP Address Pool. (Region Pool)

Step 11 Click Next.

The MPLS Policy Editor - Routing Information window appears, as shown in Figure 6-15.

Figure 6-15 The MPLS Policy Editor - Routing Information

Step 12 Click Next to accept the defaults.

The MPLS Policy Editor - Routing Information window appears, as shown in Figure 6-16.

Figure 6-16 The MPLS Policy Editor - Routing Information

Step 13 Click Next to accept the defaults.

Note Make sure the Editable check boxes are checked, so you can edit these attributes in the Service Request 
process.

The MPLS Policy Editor - VRF and VPN Membership window appears, as shown in Figure 6-17.
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Figure 6-17 The MPLS Policy Editor - VRF and VPN Membership

Step 14 Click Next to accept the defaults.

Note Make sure the Editable check boxes are checked, so you can edit these attributes in the Service Request 
process.

Step 15 Click Finish.

The Policies window reappears, as shown in Figure 6-18.

Figure 6-18 Policies

The MPLS VPN MVRFCE PE-CE Service Policy is complete.
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Creating a PE-NoCE Service Policy
To create a PE-NoCE Service Policy, follow these steps:

Step 1 Log into ISC.

Step 2 Choose Service Design > Policy Manager.

The Policies window appears, as shown in Figure 6-19. 

Figure 6-19 Policies

Step 3 From the Create drop-down list, choose MPLS Policy.

The MPLS Policy Editor - Policy Type window appears, as shown in Figure 6-20.

Figure 6-20 MPLS Policy Editor - Policy Type
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Step 4 Edit the following attributes:

• Policy Name: Enter the policy name. (mpls-pe-noce)

• Policy Owner: Choose the Policy Owner. (Customer)

• Customer: See Step 5.

• Policy Type: Choose the Policy Type. (MVRFCE PE-CE)

• CE Present: Do not choose CE Present.

Step 5 Click Select to specify a Customer.

The Customer for MPLS Policy window appears, as shown in Figure 6-21.

Figure 6-21 Customer for MPLS Policy

Step 6 Choose a Customer and click Select. (Cust-A)

Step 7 Click Next.

The MPLS Policy Editor - Interface window appears, as shown in Figure 6-22.

Figure 6-22 The MPLS Policy Editor - PE Interface

The MPLS Policy Editor - Interface window appears, as shown in Figure 6-23.
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Step 8 Click Next to accept the defaults.

Figure 6-23 The MPLS Policy Editor - CE Interface

Step 9 Click Next to accept the defaults.

Note Make sure the Editable check boxes are checked, so you can edit these attributes in the Service Request 
process.

The MPLS Policy Editor - IP Address Scheme window appears, as shown in Figure 6-24.

Figure 6-24 The MPLS Policy Editor - IP Address Scheme

Step 10 Edit the following attributes:

• IP Numbering Scheme: Choose the IP Numbering Scheme. (IP Numbered)

• Automatically Assign IP Address: To have ISC automatically assign IP Addresses, click the check 
box.

• IP Address Pool: Choose the IP Address Pool. (Region Pool)

• Click Next.

Step 11 Click Next.

The MPLS Policy Editor - IP Address Scheme window appears, as shown in Figure 6-25.
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Figure 6-25 The MPLS Policy Editor - IP Address Scheme

Step 12 Edit the following attributes:

• IP Numbering Scheme: Choose the IP Numbering Scheme. (IP Numbered)

• Automatically Assign IP Address: To have ISC automatically assign IP Addresses, click the check 
box.

• IP Address Pool: Choose the IP Address Pool. (Region Pool)

Click Next.

The MPLS Policy Editor - Routing Information window appears, as shown in Figure 6-26.

Figure 6-26 The MPLS Policy Editor - Routing Information

Step 13 Click Next to accept the defaults.

The MPLS Policy Editor - Routing Information window appears, as shown in Figure 6-27.

Figure 6-27 The MPLS Policy Editor - Routing Information

Click Next to accept the defaults.

Note Make sure the Editable check boxes are checked, so you can edit these attributes in the Service Request 
process.

The MPLS Policy Editor - VRF and VPN Membership window appears, as shown in Figure 6-28.
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Figure 6-28 The MPLS Policy Editor - VRF and VPN Membership

Step 14 To add the VPN definition, choose Add:

The VPN dialog box appears, as shown in Figure 6-29.

Figure 6-29 VPN Dialog Box

Click Join as Hub and then click Done.

The MPLS Policy Editor - VRF and VPN Membership window appears, as shown in Figure 6-30.
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Figure 6-30 The MPLS Policy Editor - VRF and VPN Membership

Click Finish.

The Policies window reappears, as shown in Figure 6-31.

Figure 6-31 Policies
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The MPLS VPN PE-NoCE Service Policy is complete.

Creating MPLS VPN MVRFCE PE-CE Service Requests
This section contains the following sections:

• Creating a MVRFCE PE-CE Service Request, page 6-18

• Creating a MVRFCE PE-NoCE Service Request, page 6-27

Creating a MVRFCE PE-CE Service Request
To create a MVRFCE PE-CE Service Request, follow these steps:

Step 1 Log into ISC.

Step 2 Choose Service Inventory > Inventory and Connection Manager > Service Requests.

The Service Requests window appears, as shown in Figure 6-32. 

Figure 6-32 Service Requests

Step 3 From the Create drop-down list, choose MPLS Policy.

The Select MPLS Policy window appears, as shown in Figure 6-33.
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Figure 6-33 Select MPLS Policy

Step 4 Choose the MPLS Policy. (mpls-mvrfce-pe-ce)

Step 5 Click OK.

The MPLS Service Request Editor window appears, as shown in Figure 6-34.

Figure 6-34 MPLS Service Request Editor

Step 6 Click Add Link.

The MPLS Service Request Editor window appears, as shown in Figure 6-35.
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Figure 6-35 MPLS Service Request Editor - Select CE

Step 7 Click Select CE.

The CPE for MPLS VPN Link window appears, as shown in Figure 6-36.

Figure 6-36 CPE for MPLS VPN Link

Step 8 Choose the CPE Device and click Select. (mlce4.cisco.com)

The MPLS Service Request Editor window appears, as shown in Figure 6-37.
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Figure 6-37 MPLS Service Request Editor - Select MVRFCE

Step 9 Choose the CE Interface from the drop-down box. (FE0/1)

Step 10 Click Select MVRFCE.

The MVRFCE for MPLS VPN Link window appears, as shown in Figure 6-38.

Figure 6-38 PE for MPLS VPN Link

Step 11 Choose the MVRFCE and click Select. (mlce3.cisco.com)

The MPLS Service Request Editor window appears, as shown in Figure 6-39.

Figure 6-39 MPLS Service Request Editor - Select MVRFCE CE Facing Interface

Step 12 Choose the MVRFCE CE Facing Interface from the drop-down box. (E0/2)

Step 13 Choose the MVRFCE PE Facing Interface from the drop-down box. (E0/1)
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The MPLS Service Request Editor window appears, as shown in Figure 6-40.

Figure 6-40 PE for MPLS VPN Link

Step 14 Click Add in the Link Attribute cell.

The MPLS Link Attribute Editor - Interface window appears, as shown in Figure 6-41.

Figure 6-41 MPLS Link Attribute Editor - Interface

PE Information

Step 15 Encapsulation: Choose the PE Encapsulation from the drop-down box. (DOT1Q)

Step 16 VLAN ID: Enter the PE VLAN ID. (510)

MVRFCE PE Facing Information

Step 17 Encapsulation: Choose the PE Encapsulation from the drop-down box. (DOT1Q))

Step 18 Click Next.

The MPLS Link Attribute Editor - Interface window appears, as shown in Figure 6-42.
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Figure 6-42 MPLS Link Attribute Editor - Interface

MVRFCE CE Information

Step 19 Encapsulation: Choose the PE Encapsulation from the drop-down box. (DOT1Q)

Step 20 VLAN ID: Enter the PE VLAN ID. (530)

MVRFCE PE Facing Information

Step 21 Encapsulation: Choose the PE Encapsulation from the drop-down box. (DOT1Q)

Click Next.

The MPLS Link Attribute Editor - IP Address Scheme window appears, as shown in Figure 6-43.

Figure 6-43 MPLS Link Attribute Editor - IP Address Scheme

Step 22 Accept the defaults and click Next.

The MPLS Link Attribute Editor - IP Address Scheme window appears, as shown in Figure 6-44.
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Figure 6-44 MPLS Link Attribute Editor - IP Address Scheme

Accept the defaults and click Next.

The MPLS Link Attribute Editor - Routing Information window reappears, as shown in Figure 6-45.

Figure 6-45 MPLS Link Attribute Editor - Routing Information

Step 23 Accept the defaults and click Next.

The MPLS Link Attribute Editor - Routing Information window reappears, as shown in Figure 6-46.

Figure 6-46 MPLS Link Attribute Editor - Routing Information

Accept the defaults and click Next.

The MPLS Link Attribute Editor - VRF and VPN window appears, as shown in Figure 6-47.
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Figure 6-47 MPLS Link Attribute Editor - VRF and VPN 

Step 24 Click Add to join VPN.

The MPLS Link Attribute Editor - VRF and VPN window appears, as shown in Figure 6-48.

Figure 6-48 MPLS Link Attribute Editor - VRF and VPN 

Click Add to join VPN.

The MPLS Link Attribute Editor - VRF and VPN window reappears, as shown in Figure 6-49.
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Figure 6-49 MPLS Service Request Editor

Step 25 Click Finish.

The MPLS Service Request Editor window reappears, as shown in Figure 6-50.

Figure 6-50 MPLS Service Request Editor

Step 26 Enter the Service Request description and click Save. (mpls-mvrfce-pe-ce)

The MPLS Service Requests window reappears, as shown in Figure 6-51.
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Figure 6-51 Service Request 

The MPLS VPN MVRFCE PE-CE Service Request is in the Requested state and ready to deploy. 

Creating a MVRFCE PE-NoCE Service Request
To create a MVRFCE PE-NoCE Service Request, follow these steps:

Step 1 Log into ISC.

Step 2 Choose Service Inventory > Inventory and Connection Manager > Service Requests.

The Service Requests window appears, as shown in Figure 6-52. 

Figure 6-52 Service Requests

Step 3 From the Create drop-down list, choose MPLS Policy.

The Select MPLS Policy window appears, as shown in Figure 6-53.
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Figure 6-53 Select MPLS Policy

Step 4 Choose the MPLS Policy. (mpls-mvrfce-pe-noce)

Step 5 Click OK.

The MPLS Service Request Editor window appears, as shown in Figure 6-54.

Figure 6-54 MPLS Service Request Editor

Step 6 Click Add Link.

The MPLS Service Request Editor window appears, as shown in Figure 6-55.
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Figure 6-55 MPLS Service Request Editor - Select MVRFCE

Step 7 Click Select MVRFCE.

The CPE for MPLS VPN Link window appears, as shown in Figure 6-56.

Figure 6-56 CPE for MPLS VPN Link

Step 8 Choose the MVRFCE and click Select. (mlce3.cisco.com)

Step 9 Click Select MVRFCE.

The MPLS Service Request Editor window appears, as shown in Figure 6-57.
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Figure 6-57 MPLS Service Request Editor - MVRFCE CE Facing Interface

Step 10 Choose the MVRFCE CE Facing Interface from the drop-down box. (E0/2)

Step 11 Choose the MVRFCE PE Facing Interface from the drop-down box. (E0/1)

The MPLS Service Request Editor window appears, as shown in Figure 6-58.

Figure 6-58 MPLS Service Request Editor

Step 12 Click Add in the Link Attribute cell.

The MPLS Link Attribute Editor - Interface window appears, as shown in Figure 6-59.
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Figure 6-59 MPLS Link Attribute Editor - Interface

PE Information

Step 13 Encapsulation: Choose the PE Encapsulation from the drop-down box. (DOT1Q)

Step 14 VLAN ID: Enter the PE VLAN ID. (550)

MVRFCE PE Facing Information

Step 15 Encapsulation: Choose the PE Encapsulation from the drop-down box. (DOT1Q))

Step 16 Click Next.

The MPLS Link Attribute Editor - Interface window appears, as shown in Figure 6-60.
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Figure 6-60 MPLS Link Attribute Editor - Interface

MVRFCE CE Information

Step 17 Encapsulation: Choose the PE Encapsulation from the drop-down box. (DOT1Q)

Step 18 VLAN ID: Enter the PE VLAN ID. (570)

MVRFCE PE Facing Information

Step 19 Encapsulation: Choose the PE Encapsulation from the drop-down box. (DOT1Q)

Click Next.

The MPLS Link Attribute Editor - IP Address Scheme window appears, as shown in Figure 6-61.

Figure 6-61 MPLS Link Attribute Editor - IP Address Scheme

Step 20 Accept the defaults and click Next.

The MPLS Link Attribute Editor - IP Address Scheme window appears, as shown in Figure 6-62.
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Figure 6-62 MPLS Link Attribute Editor - IP Address Scheme

Accept the defaults and click Next.

The MPLS Link Attribute Editor - Routing Information window reappears, as shown in Figure 6-63.

Figure 6-63 MPLS Link Attribute Editor - Routing Information

Step 21 Accept the defaults and click Next.

The MPLS Link Attribute Editor - Routing Information window reappears, as shown in Figure 6-64.

Figure 6-64 MPLS Link Attribute Editor - Routing Information

Accept the defaults and click Next.

The MPLS Link Attribute Editor - VRF and VPN window appears, as shown in Figure 6-65.
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Figure 6-65 MPLS Link Attribute Editor - VRF and VPN 

Step 22 Click Add to join VPN.

Step 23 Click Finish.

The MPLS Service Request Editor window reappears, as shown in Figure 6-66.

Figure 6-66 MPLS Service Request Editor

Step 24 Enter the Service Request description and click Save. (mpls-mvrfce-pe-noce)

The MPLS Service Requests window reappears, as shown in Figure 6-67.
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Figure 6-67 Service Request 

The MPLS VPN MVRFCE PE-NoCE Service Request is in the Requested state and ready to deploy. 
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Provisioning Management VPN

This chapter describes how to implement the IP Solutions Center (ISC) Management VPN. This chapter 
contains the following major sections:

• Overview of the ISC Management Network, page 7-1

• Provisioning a Management CE in ISC, page 7-7

Overview of the ISC Management Network
This section provides the fundamental concepts and considerations for administering customer edge 
routers (CEs) in the context of an ISC management subnet. Before ISC can be appropriately deployed to 
deliver services to customers, the question of whether the CEs are to be managed by the Service Provider 
or not must be answered

This section contains the following sections:

• Unmanaged Customer Edge Routers, page 7-1

• Managed Customer Edge Routers, page 7-2

• Network Management Subnets, page 7-3

• Implementation Techniques, page 7-4

• Out-of-Band Technique, page 7-7

Unmanaged Customer Edge Routers
One of the options available to the Service Provider is to not manage the customer edge routers (CEs) 
connected to the Service Provider network. For the Service Provider, the primary advantage of an 
unmanaged CE is administrative simplicity. 

If the CEs are unmanaged, the provider can use IPv4 connectivity for all management traffic. ISC is not 
employed for provisioning or managing unmanaged CEs.

Figure 7-1 shows a basic topology with unmanaged CEs. The network management subnet has a direct 
link to the Service Provider MPLS core network.
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Figure 7-1 Service Provider Network and Unmanaged CEs

Regarding unmanaged CEs, Service Providers should note the following considerations:

• Because unmanaged CEs are outside the Service Provider’s administrative domain, the Service 
Provider does not maintain or configure unmanaged CEs.

• The Service Provider does not administer the following elements on the unmanaged CE:

– IP addresses

– Host name

– Domain Name server

– Fault management (and timestamp coordination by means of the Network Time Protocol)

– Collecting, archiving, and restoring CE configurations

– Access data such as passwords and SNMP strings on the unmanaged CE

• Prototype CE configlets are generated, but they are not automatically downloaded to the router.

• There is no configuration management.

– With no configuration management, no configuration history is maintained and there is no 
configuration change management. 

– Changes to a service request (on the PE-CE link) are not deployed to the CE.

• There is no configuration auditing because there is no means to retrieve the current CE 
configuration.

• You can perform routing auditing.

• You can use the Service Assurance Agent (SA Agent) to measure response times between shadow 
routers, but you cannot use SA Agent to measure response times between CEs.

Managed Customer Edge Routers
The alternative to unmanaged CEs is managed CEs, that is, customer edge routers managed by the 
Service Provider. Managed CEs can be wholly within the Service Provider’s administrative domain or 
co-managed between the provider and the customer, although CE co-management poses a number of 
ongoing administrative challenges and is not recommended. 
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Regarding managed CEs, Service Providers should note the following considerations:

• Managed CEs are within the Service Provider’s administrative domain. Thus, some connectivity to 
the CEs from the Service Provider network is required.

• The Service Provider must administer the following elements on the managed CE:

– IP addresses

– Host name

– Domain Name server

– Access data such as passwords and SNMP strings

• The Service Provider should administer fault management (and timestamp coordination by means 
of the Network Time Protocol)

• The Service Provider can administer collecting, archiving, and restoring CE configurations.

• CE configlets are generated and downloaded to the managed CE.

• Changes to service requests are based on the current CE configuration and automatically 
downloaded.

• The CE configurations are audited.

• Customer routing and Service Provider routing must interact. 

• Access from CEs to the management hosts on the network management subnet is required.

• Configuration auditing and routing auditing are both functional.

• You can use the Service Assurance Agent (SA Agent) to measure response times between CEs and 
between shadow routers.

The following sections discuss the concepts and issues required for administering a managed CE 
environment.

Network Management Subnets
The Network Management Subnet is required when the provider’s service offering entails the 
management of CEs. Once a CE is in a VPN, it is no longer accessible by means of conventional IPv4 
routing unless one of the techniques described in this chapter is employed.

Figure 7-2 shows the ISC network management subnet and the devices that might be required to connect 
to it:
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Figure 7-2 The ISC Network Management Subnet

Issues Regarding Access to VPNs
The core issues with regard to gaining access to VPNs are as follows:

• How to keep provider space “clean” from unnecessary customer routes

• How to keep customer space “clean” from both the provider’s and other customer’s routes

• How to provide effective security

• How to prevent routing loops

ISC does not handle any of these responsibilities—doing so must be designed and implemented by 
the Service Provider. 

• Reachability changes as a direct consequence of employing ISC. 

Before you provision a CE in the ISC, you might be able to reach the CE via IPv4 connectivity, but 
the moment the product deploys a service request, you cannot reach that CE any more—unless you 
have first implemented the network management subnet.

Implementation Techniques
The network management subnet must have access to a Management CE (MCE) and PEs.

The network management subnet is appropriate—and necessary—when there is an intent to have 
managed CEs connected via an in-band connection. In-band indicates a single link or permanent virtual 
circuit (PVC) that carries both the customer's VPN traffic, as well as the provider’s network management 
traffic.

Management CE (MCE)

The network management subnet is connected to the Management CE (MCE). The MCE emulates the 
role of a customer edge router (CE), but the MCE is in provider space and serves as a network operations 
center gateway router. The MCE is part of a management site as defined in the ISC. 
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You configure the MCE by identifying the CE as part of the management LAN in ISC.

Management PE (MPE)

The Management PE (MPE) emulates the role of a PE in the provider core network. The MPE connects 
the MCE to the provider core network. An MPE can have a dual role as both a PE and the MPE. 

The MPE needs access to the following devices:

At the current time, ISC recommends two main network management subnet implementation techniques:

• Management VPN Technique

The MPE-MCE link uses a Management VPN (see Management VPN, page 7-5) to connect to 
managed CEs. To connect to the PEs, the MPE-MCE link uses a parallel IPv4 link.

• Out-of-Band Technique

In the Out-of-Band technique, the MCE has IPv4 connectivity (that is, not MPLS VPN connectivity) 
to all the CEs and PEs in the network (see Out-of-Band Technique, page 7-7). In this context, 
out-of-band signifies a separate link between PEs that carries the provider’s management traffic.

The network management subnet technique the provider chooses to implement depends on many factors, 
which are discussed later in this chapter.

Management VPN 
The Management VPN technique is the default method provisioned by ISC. A key concept for this 
implementation technique is that all the CEs in the network are a member of the management VPN. To 
connect to the PEs, the MPE-MCE link uses a parallel IPv4 link. Figure 7-3 shows a typical topology 
for the Management VPN technique.

Device Connectivity Function

1. Customer Edge Routers 
(CEs)

Access from the network 
management subnet into the 
VPNs

Provision or change 
configuration and collect SA 
Agent performance data

2. Shadow CEs Access from the network 
management subnet into the 
VPNs

A simulated CE used to measure 
data travel time between two 
devices. A shadow CE is 
connected directly to a PE via 
Ethernet.

3. Provider Edge Routers 
(PEs)

Standard IP connectivity Provision or change 
configuration
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Figure 7-3 Typical Topology for a Management VPN Network

When employing the Management VPN technique, the MPE-MCE link uses a management VPN to 
connect to managed CEs. To connect to the PEs, the MPE-MCE link employs a parallel IPv4 link.

Each CE in a customer VPN is also added to the management VPN by selecting the Join the 
management VPN option in the service request user interface. 

The function of the management route map is to allow only the routes to the specific CE into the 
management VPN. The Cisco IOS supports only one export route map and one import route map per 
VRF.

As shown in Figure 7-3, a second parallel non-MPLS VPN link is required between the MPE and MCE 
to reach the PEs.

Note Implementation of the Management VPN technique requires Cisco IOS 12.07 or higher.

Advantages

The advantages involved in implementing the Management VPN technique are as follows:

• Provisioning with this method requires only one service request.

• The only routes given to the network management subnet are the routes to the CEs—that is, either 
the address of the CE link to the PE or the CE loopback address. General VPN routes are not given 
to the network management subnet.
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• A CE in the Management VPN method is a spoke to the Management VPN regardless of which role 
the CE has within its own VPN. Therefore, CEs cannot be accidentally exposed to inappropriate 
routes. The only management routes the CEs can learn must come from a hub of the Management 
VPN.

Out-of-Band Technique
The Out-of-Band technique does not employ a management VPN to manage the CEs. Out-of-band 
connectivity is provided by IPv4 links. Out-of-band signifies a separate link between PEs that carries 
the provider’s management traffic. As shown in Figure 7-4, the MCE provides separation between the 
provider’s routes and the customer’s routes.

Figure 7-4 Out-of-Band Technique

The Out-of-Band technique has the advantage of being relatively simple to set up, and no management 
VPN is required. However, its disadvantages are that it is expensive since it requires an IPv4 connection 
to each CE. Also, due to the delicate staging requirements for this technique, the Out-of-Band 
implementation does have a high degree of complexity.

Provisioning a Management CE in ISC
The ISC network management subnet is connected to the Management CE (MCE). The MCE emulates 
the role of a customer edge router (CE), but the MCE is in provider space and serves as a network 
operations center gateway router. The MCE is part of a management site as defined in ISC.

This section contains the following sections:

• Defining a CE as an MCE, page 7-8
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• Creating an MCE Service Request, page 7-9

Defining a CE as an MCE
You configure the MCE by identifying the CE as part of the management LAN in ISC software. To 
define a CE as an MCE, follow these steps:

Step 1 Start up and log into ISC.

Step 2 From the Welcome to ISC window, choose Service Inventory.

Step 3 From the Service Inventory window, choose Inventory and Connection Manager.

Step 4 From the TOC (table of contents) displayed on the left side of the Inventory and Connection Manager 
window, choose CPE Devices.

The list of CPE devices for all currently defined customers is displayed (see Figure 7-5).

Figure 7-5 List of All CPEs for All Customers

Step 5 Select the CE that will function as the MCE in the management VPN, then click Edit.

The Edit CPE Device dialog box appears, displaying the pertinent information for the selected CPE 
(see Figure 7-6).
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Figure 7-6 Editing the Selected CPE Device

Step 6 Management Type: From the drop-down list, set the management type to Managed—Management 
LAN.

Step 7 Click Save.

You return to the list of CPE devices, where the new management type for the selected CE (in our 
example, 3. mlce8.cisco.com) is now displayed (see Figure 7-7).

Figure 7-7 Selected CE Defined as a Management CE

Creating an MCE Service Request
To create an MCE service request, follow these steps:

Step 1 Start up and log into ISC.

a. From the Welcome to ISC window, choose Service Inventory.
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b. From the Service Inventory window, choose Inventory and Connection Manager.

c. From the Inventory and Connection Manager window, choose Service Requests.

The Service Requests dialog box appears (see Figure 7-8).

Figure 7-8 Initial Service Requests Dialog Box

Step 2 To start the process to create a new service, click Create.

A drop-down list is displayed, showing the types of service requests you can create.

Step 3 Choose MPLS VPN.

The Select MPLS Policy dialog box appears (see Figure 7-9).

This dialog box displays the list of all the MPLS service policies that have been defined in ISC.

Figure 7-9 Selecting the MPLS Policy for This Service

Step 4 Select the policy of choice, then click OK.

The MPLS Service Request Editor appears (see Figure 7-10).
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Figure 7-10 MPLS Service Request Editor

Step 5 Click Add Link.

The MPLS Service Request Editor now displays a set of fields, as shown in Figure 7-11. Notice that the 
Select CE field is enabled. Specifying the CE for the link is the first task required to define the link for 
this service.

Figure 7-11 Initial Fields Displayed to Define PE-CE Link

Step 6 CE: Click Select CE.

The Select CPE Device dialog box is displayed (see Figure 7-12). 
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Figure 7-12 Selecting the MCE for the MPLS Link

a. From the Show CPEs with drop-down list, you can display CEs by Customer Name, by Site, or by 
Device Name.

b. You can use the Find button to either search for a specific CE, or to refresh the display.

c. You can set the Rows per page to 5, 10, 20, 30, 40, or All.

d. This dialog box displays the first page of the list of currently defined CE devices. The number of 
pages of information is displayed in the lower right corner of the dialog box. 

To go to the another page of CE devices, click the number of the page you want to go to. 

Step 7 In the Select column, select the name of the MCE for the MPLS link, then click Select.

You return to the Service Request Editor window, where the name of the selected CE is now displayed 
in the CE column.

Step 8 CE Interface: Select the CE interface from the drop-down list (see Figure 7-13).

Figure 7-13 CE and CE Interface Fields Defined

Note that in the PE column, the Select PE option is now enabled.

Step 9 PE: Click Select PE.

The Select PE Device dialog box is displayed (see Figure 7-14). 
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Figure 7-14 Selecting the PE for the MPLS Link

Step 10 In the Select column, select the name of the PE for the MPLS link, then click Select.

You return to the Service Request Editor window, where the name of the selected PE is now displayed 
in the PE column.

Step 11 PE Interface: Select the PE interface from the drop-down list (see Figure 7-15).

Figure 7-15 PE and PE Interface Fields Defined

Note that the Link Attribute Add option is now enabled.

Step 12 In the Link Attribute column, select Add.

The MPLS Link Attribute Editor is displayed, showing the fields for the interface parameters 
(see Figure 7-16).
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Figure 7-16 Specifying the MPLS Link Interface Attributes

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. For details on each of the PE and CE interface fields, see Specifying the PE and CE 
Interface Parameters, page 3-10.

Note The VLAN ID is shared between the PE and CE, so there is one VLAN ID for both.

Step 13 Edit any interface values that need to be modified for this particular link, then click Next.

The MPLS Link Attribute Editor for the IP Address Scheme appears (see Figure 7-17).

Figure 7-17 Specifying the MPLS Link IP Address Attributes

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. For details on the IP address scheme fields, see Specifying the IP Address Scheme, 
page 3-13.

Step 14 Edit any IP address scheme values that need to be modified for this particular link, then click Next.

The MPLS Link Attribute Editor for Routing Information appears (see Figure 7-18).
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Figure 7-18 Specifying the MPLS Link Routing Protocol Attributes

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. For details on the routing information for the PE and CE, see Specifying the Routing 
Protocol for a Service, page 3-16.

Because the service policy used for this service specified the routing protocol as editable, you can 
change the routing protocol for this service request as needed.

Step 15 Edit any routing protocol values that need to be modified for this particular link, then click Next.

The MPLS Link Attribute Editor for the VRF and VPN attributes appears (see Figure 7-19).

Figure 7-19 Specifying the MPLS Link VRF and VPN Attributes

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. For details on the VRF and VPN information, see Defining the Service Policy VRF 
and VPN Information, page 3-35.

Step 16 Edit any VRF values that need to be modified for this particular link, then click Finish.

You return to the MPLS Service Request Editor. 

Step 17 To save your work on this first link in the service request, click Save.

You return to the Service Requests dialog box, where the information for the link you just defined is now 
displayed (see Figure 7-20). 
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Figure 7-20 Service Request for an MPLS Link Completed

You can add additional links to this service request by choosing Add Link and specifying the attributes 
of the next link in the service. As you can see, the service request is in the Requested state. When all the 
links for this service have been defined, you must deploy the service.

Adding PE-CE Links to the Management VPN
When you have created the Management VPN, then you can proceed to add service for the PE-CE links 
you want to participate in the Management VPN.

To add PE-CE links, follow these steps:

Step 1 Navigate to the MPLS Link Attribute Editor - VRF and VPN window for the selected CE.

Step 2 Check the Join the management VPN option, as shown in Figure 7-21.

Figure 7-21 Joining a CE to the Management VPN
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When you join the CE with the Management VPN in this step, ISC generates the appropriate route-map 
statements in the PE configlet. 

The function of the management route map is to allow only the routes to the specific CE into the 
management VPN. Cisco IOS supports only one export route map and one import route map per VRF 
(and therefore, per VPN).

Step 3 Complete the service request user interface. 
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Provisioning Cable Services

This chapter describes how to provision MPLS VPN cable in IP Solutions Center (ISC). This chapter 
contains the following major sections:

• Overview of MPLS VPN Cable, page 8-1

• Provisioning Cable Services in ISC, page 8-6

• Creating the Service Requests, page 8-6

Overview of MPLS VPN Cable
Using MPLS VPN technology, service providers can create scalable and efficient private networks using 
a shared Hybrid Fiber Coaxial (HFC) network and Internet Protocol (IP) infrastructure. The cable MPLS 
VPN network consists of the following two major elements:

• The Multiple Service Operator (MSO) or cable company that owns the physical infrastructure and 
builds VPNs for the Internet Service Providers (ISPs) to move traffic over the cable and IP 
backbone.

• ISPs that use the HFC network and IP infrastructure to supply Internet service to cable customers.

Benefits of Cable MPLS VPNs
Provisioning cable services with MPLS VPNs provides the following benefits:

• MPLS VPNs give cable MSOs and ISPs a manageable way of supporting multiple access to a cable 
plant. 

Service providers can create scalable and efficient VPNs across the core of their networks MPLS 
VPNs provide systems support scalability in cable transport infrastructure and management.

• Each ISP can support Internet access services from a subscriber’s PC through an MSO’s physical 
cable plant to their networks.

• MPLS VPNs allow MSOs to deliver value-added services through an ISP, and thus, deliver 
connectivity to a wider set of potential customers. 

MSOs can partner with ISPs to deliver multiple services from multiple ISPs and add value within 
the MSO’s own network using VPN technology.

• Subscribers can select combinations of services from various service providers.
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• The Cisco IOS MPLS VPN cable feature sets build on Cable Modem Termination Server (CMTS) 
and DOCSIS 1.0 extensions to ensure services are reliably and optimally delivered over the cable 
plant. 

MPLS VPN provides systems support domain selection, authentication per subscriber, selection of 
QoS, policy-based routing, and ability to reach behind the cable modem to subscriber end-devices 
for QoS and billing, while preventing session-spoofing.

• MPLS VPN technology ensures both secure access across the shared cable infrastructure and service 
integrity.

The Cable MPLS VPN Network
As shown in Figure 8-1, each ISP moves traffic to and from a subscriber’s PC, through the MSO’s 
physical network infrastructure, to the ISP’s network. MPLS VPNs, created in Layer 3, provide privacy 
and security by constraining the distribution of VPN routes only to the routers that belong to its network. 
Thus, each ISP’s VPN is insulated from other ISPs that use the same MSO infrastructure.

In the MPLS-based cable scheme, a VPN is a private network built over a shared cable plant and 
MPLS-core backbone. The public network is the shared cable plant or backbone connection points. A 
cable plant can support Internet access services and carry traffic for an MSO and its subscribers, as well 
as for multiple Internet Service Providers (ISPs) and their subscribers.

An MPLS VPN assigns a unique VPN Routing/Forwarding (VRF) instance to each VPN. A VRF 
instance consists of an IP routing table, a derived forwarding table, a set of interfaces that use the 
forwarding table, and a set of rules and routing protocols that determine the contents of the forwarding 
table.

Each PE router maintains one or more VRF tables. If a packet arrives directly through an interface 
associated with a particular VRF, the PE looks up a packet’s IP destination address in the appropriate 
VRF table. MPLS VPNs use a combination of BGP and IP address resolution to ensure security.
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Figure 8-1 Example of an MPLS VPN Cable Network

The routers in the cable network are as follows:

• Provider (P) router—Routers in the MPLS core of the service provider network. P routers run MPLS 
switching, and do not attach VPN labels (MPLS labels in each route assigned by the PE router) to 
routed packets. VPN labels direct data packets to the correct egress router.

• Provider Edge (PE) router—A router that attaches the VPN label to incoming packets based on the 
interface or subinterface on which they are received. A PE router attaches directly to a CE router. 
In the MPLS-VPN approach, each Cisco uBR72xx series router acts as a PE router.

• Customer (C) router—A router in the ISP or enterprise network.

• Customer Edge (CE) router—Edge router on the ISP’s network that connects to the PE router on the 
MSO’s network. A CE router must interface with a PE router.

• Management CE (MCE) router—The MCE emulates the role of a customer edge router (CE), but 
the MCE is in provider space and serves as a network operations center gateway router. The network 
management subnet is connected to the Management CE (MCE). The MCE is part of a management 
site as defined in the ISC.

• Management PE (MPE) router—The MPE emulates the role of a PE in the provider core network. 
The MPE connects the MCE to the provider core network. An MPE can have a dual role as both a 
PE and the MPE.

The shared cable plant supports Internet connectivity from ISP A to its subscribers and from ISP B to 
its subscribers.
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Management VPN in the Cable Network
The MPLS network has a unique VPN that exclusively manages the MSOs devices called the 
management VPN. It contains servers and devices that other VPNs can access. The management VPN 
connects the Management CE (MCE) router and the management subnet to the MSO PE router (a 
uBr72xx router or equivalent). ISC and the management servers, such as Dynamic Host Configuration 
Protocol (DHCP), Cisco Network Registrar (CNR) Time of Day (ToD) are part of the management 
subnet and are within the management VPN for ISP connectivity. For an explanation of the management 
VPN, see Chapter 7, “Provisioning Management VPN.”

As shown in Figure 8-1, the management VPN is comprised of the network management subnet (where 
the ISC workstation resides), which is directly connected to the Management CE (MCE). The 
management VPN is a special VPN between the MCE and the cable VPN gateway. The cable VPN 
gateway is usually a Cisco uBR 72xx router that functions as both a regular PE and a Management PE. 
Notice that there is also a parallel IPv4 link between the MCE and the MPE.

Cable VPN Configuration Overview
Cable VPN configuration involves the following:

• An MSO domain that requires a direct peering link to each enterprise network (ISP), provisioning 
servers for residential and commercial subscribers, and dynamic DNS for commercial users. The 
MSO manages cable interface IP addressing, Data Over Cable Service Interface Specifications 
(DOCSIS) provisioning, cable modem hostnames, routing modifications, privilege levels, and 
usernames and passwords.

• An ISP or enterprise domain that includes the DHCP server for subscriber or telecommuter host 
devices, enterprise gateway within the MSO address space, and static routes back to the 
telecommuter subnets.

Note Cisco recommends that the MSO assign all addresses to the end user devices and gateway interfaces. 
The MSO can also use split management to let the ISP configure tunnels and security.

To configure MPLS VPNs for cable services, the MSO must configure the following:

• Cable Modem Termination System (CMTS)

The CMTS is usually a Cisco uBR72xx series router. The MSO must configure Cisco uBR72xx 
series routers that serve the ISP.

• PE routers

The MSO must configure PE routers that connect to the ISP as PEs in the VPN.

Tip When configuring MPLS VPNs for cable services, you must configure the cable maintenance 
subinterface on the PE. The cable maintenance interface is the means by which the cable device retrieves 
its own IP address. For this reason, the maintenance subinterface must be configured before cable 
services provisioning can take place. 

• CE routers

• P routers

• One VPN per ISP
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• DOCSIS servers for all cable modem customers

The MSO must attach DOCSIS servers to the management VPN and make them visible to the 
network.

The MSO must determine the primary IP address range. The primary IP address range is the MSO’s 
address range for all cable modems that belong to the ISP subscribers.

The ISP must determine the secondary IP address range. The secondary IP address is the ISP’s address 
range for its subscriber PCs.

To reduce security breaches and differentiate DHCP requests from cable modems in VPNs or under 
specific ISP management, MSOs can use the cable helper-address command in Cisco IOS software. 
The MSO can specify the host IP address to be accessible only in the ISP’s VPN. This lets the ISP use 
its DHCP server to allocate IP addresses. Cable modem IP address must be accessible from the 
management VPN.

In ISC, you specify the maintenance helper address and the host helper address and the secondary 
addresses for the cable subinterface. 

Cable VPN Interfaces and Subinterfaces

In the cable subscriber environment, several thousand subscribers share a single physical interface. 
Configurations with multiple logical subinterfaces are a vital part of the MPLS VPN network over cable. 
You can configure multiple subinterfaces and associate a specific VRF with each subinterface. You can 
split a single physical interface (the cable plant) into multiple subinterfaces, where each subinterface is 
associated with a specific VRF. Each ISP requires access on a physical interface and is given its own 
subinterface. The MSO administrator can define subinterfaces on a cable physical interface and assign 
Layer 3 configurations to each subinterface.

The MPLS VPN approach of creating VPNs for individual ISPs or customers requires subinterfaces to 
be configured on the cable interface. One subinterface is required for each ISP. The subinterfaces are 
tied to the VPN Routing/Forwarding (VRF) tables for their respective ISPs.

You must create the maintenance subinterface on the cable interface and tie it to the management VPN. 
The maintenance interface is for the ISP’s use, and it is used for VPN connectivity, as well as the 
management VPN using an extranet between the ISP and the management VPN. 

ISC automatically selects the subinterface number based on the VRF. If a subinterface that is associated 
with the current VRF does not yet exist, ISC creates a subinterface and assigns it to the correct VRF. 
The subinterface number is incremented to 1 greater than the largest subinterface currently assigned for 
the selected cable interface.

The network management subnet (which includes the CNR, ToD, and ISC) can reply to the cable modem 
because the management VPN allows connectivity for one filtered route from the ISP’s VPN to the 
Management CE (MCE). Similarly, in order to forward the management requests (such as DHCP 
renewal to CNR), the ISP VPN must import a route to the MCE in the management VPN. 

Cisco uBR7200 series software supports the definition of logical network layer interfaces over a cable 
physical interface. The system supports subinterface creation on a physical cable interface.

Subinterfaces allow traffic to be differentiated on a single physical interface and associated with 
multiple VPNs. Each ISP requires access on a physical interface and is given its own subinterface. Using 
each subinterface associated with a specific VPN (and therefore, ISP) subscribers connect to a logical 
subinterface, which reflects the ISP that provides their subscribed services. Once properly configured, 
subscriber traffic enters the appropriate subinterface and VPN.
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Provisioning Cable Services in ISC 
The tasks you must complete to provision cable services in ISC are as follows:

• Add the PE that has cable interfaces to the appropriate Region. 

• Generate a service request to provision the cable maintenance interface on the PE. 

• Generate a second service request to provision the MPLS-based cable service. You must generate 
this cable service request for each VPN.

When using the ISC to provision cable services, there are no CEs in the same sense there are when 
provisioning a standard MPLS VPN. Thus, you must use a PE-Only (NOCE) policy or create a cable 
policy with no CE.

Creating the Service Requests
This section contains the following subsections:

• Creating a Cable Subinterface Service Request, page 8-6

• Creating a Cable Link Service Request, page 8-11

Creating a Cable Subinterface Service Request
The cable maintenance subinterface on the PE is the means by which the cable device retrieves its own 
IP address. For this reason, the maintenance subinterface must be configured before provisioning cable 
services.

To create a cable subinterface service request, follow these steps:

Step 1 Start up and log into ISC.

a. From the Welcome to ISC window, choose Service Inventory.

b. From the Service Inventory window, choose Inventory and Connection Manager.

c. From the Inventory and Connection Manager window, choose Service Requests.

The Service Requests dialog box appears. 

Step 2 Click Create.

A drop-down list is displayed, showing the types of service requests you can create.

Step 3 Choose MPLS VPN.

The Select MPLS Policy dialog box appears (see Figure 8-2).

This dialog box displays the list of all the MPLS service policies that have been defined in ISC.
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Figure 8-2 Selecting the Cable Policy for the Subinterface

Step 4 Select the check box for the PE-Only policy (Cable in the example above) policy, and then click OK.

The MPLS Service Request Editor appears (see Figure 8-3).

Figure 8-3 MPLS Service Request Editor

Step 5 Click Add Link.

The MPLS Service Request Editor now displays a set of fields. Notice that the Select PE field is enabled. 
Specifying the PE for the link is the first task required to define the link for this service.

Step 6 PE: Click Select PE.

The Select PE Device dialog box is displayed (see Figure 8-4).
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Figure 8-4 Selecting the PE for the MPLS Link

Step 7 In the Select column, select the name of the PE for the MPLS link, then click Select.

You return to the Service Request Editor window, where the name of the selected PE is now displayed 
in the PE column.

Step 8 PE Interface: Select the PE interface from the drop-down list (see Figure 8-5).

Figure 8-5 PE and PE Interface Fields Defined

Only the major interface names are available for you to select. ISC assigns the appropriate subinterface 
number for each VPN.

The Link Attribute Add option is now enabled.

Step 9 In the Link Attribute column, click Add.

The MPLS Link Attribute Editor is displayed, showing the fields for the interface parameters 
(see Figure 8-6).
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Figure 8-6 Specifying the MPLS Link Interface Attributes

Step 10 Enter a subinterface name in the Interface Description field.

Step 11 Select the check box for the Cable Maintenance Interface, then click Edit beside Cable Helper 
Addresses.

The Cable Helper Addresses window appears.

Step 12 Click Add. The Cable Helper Addresses window appears as shown in Figure 8-7.

Figure 8-7 Cable Helper Addresses

Step 13 Enter an IP address in the IP Address field and select Both for IP Type.

Cable Modems and their attached CPE devices (hosts) will broadcast DHCP packets to the destination 
IP address, and this destination IP address is the configured cable helper address. So, from configured 
cable helper address, cable modems and their attached CPE (hosts) will receive their (CM and CPE) IP 
address.

IP Type can have the following values:

• Host—When selected, only UDP broadcasts from hosts (CPE devices) are forwarded to that 
particular destination IP address. (For example, only hosts will receive IP addresses from the 
mentioned helper address.)

• Modem—When selected, only UDP broadcasts from cable modems are forwarded to that particular 
destination IP address. (For example, only cable modems will receive IP addresses from the 
mentioned helper address.)

• Both—When selected, UDP broadcasts from hosts (CPE devices) and cable modems are forwarded 
to that particular destination IP address. (For example, both cable modems and hosts will receive IP 
addresses from the mentioned helper address.)

Step 14 Click OK.
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The MPLS Link Attribute Editor reappears. 

Step 15 Click Next.

The MPLS Link Attribute Editor - IP Address Scheme appears (see Figure 8-8).

Figure 8-8 Specifying the MPLS Link IP Address Attributes

Step 16 Edit any IP address scheme values that must be modified for this particular link, then click Next.

The MPLS Link Attribute Editor for Routing Information appears (see Figure 8-9).

Figure 8-9 Specifying the MPLS Link Routing Protocol Attributes

The following routing protocol options are supported:

• STATIC

• RIP

• OSPF

• EIGRP

• None

Because the service policy used for this service specified the routing protocol as editable, you can 
change the routing protocol for this service request as needed.

Step 17 Edit any routing protocol values that must be modified for this particular link, then click Next. 

The MPLS Link Attribute Editor for the VRF and VPN attributes appears (see Figure 8-10)
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Figure 8-10 Specifying the MPLS Link VRF and VPN Attributes

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. 

Step 18 Select the check box for Join the Management VPN. 

Step 19 Edit any VRF and VPN values that must be modified for this particular link, then click Finish.

You return to the MPLS Service Request Editor.

Note You can define multiple links in this service request. 

Step 20 To save your work on this first link in the service request, click Save.

You return to the Service Requests dialog box, where the information for the link you just defined is now 
displayed. 

Creating a Cable Link Service Request
To create a Cable Link service request, follow these steps:

Step 1 Start up and log into ISC.

Step 2 Choose Service Inventory > Inventory and Connection Manager > Service Requests.

The Service Requests dialog box appears. 

Step 3 To start the process to create a new service, click Create.

A drop-down list is displayed, showing the types of service requests you can create.

Step 4 Choose MPLS VPN.

The Select MPLS Policy dialog box appears (see Figure 8-11).
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This dialog box displays the list of all the MPLS service policies that have been defined in ISC.

Figure 8-11 Selecting the Cable Link Policy for This Service

Step 5 Select the policy of choice, then click OK.

Step 6 The MPLS Service Request Editor appears. Click Add Link.

The MPLS Service Request Editor now displays a set of fields, as shown in Figure 8-12. Note that in the 
PE column, the Select PE option is now enabled.

Figure 8-12 MPLS Service Request Editor

Step 7 PE: Click Select PE.

The Select PE Device dialog box is displayed (see Figure 8-13). 
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Figure 8-13 Selecting the PE for the MPLS Link

Step 8 In the Select column, select the name of the PE for the MPLS link, then click Select.

You return to the Service Request Editor window, where the name of the selected PE is now displayed 
in the PE column.

Step 9 PE Interface: Select the PE interface from the drop-down list (see Figure 8-14).

Figure 8-14 PE and PE Interface Fields Defined

Note that the Link Attribute Add option is now enabled.

Step 10 In the Link Attribute column, click Add.

The MPLS Link Attribute Editor is displayed, showing the fields for the interface parameters 
(see Figure 8-15).
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Figure 8-15 Specifying the MPLS Link Interface Attributes

Note Do not check the box for Cable Maintenance Interface.

Step 11 Edit any interface values that must be modified for this particular link, then click Edit beside Cable 
Helper Addresses. The Cable Helper Addresses window appears.

Step 12 Click Add. The Cable Helper Addresses window appears as shown in Figure 8-16.

Figure 8-16 Cable Helper Addresses

Step 13 Enter an IP address in the IP Address field and select Both, Modem, or Host for IP Type.

Cable Modems and their attached CPE devices (hosts) will broadcast DHCP packets to the destination 
IP address, and this destination IP address is the configured cable helper address. So, from configured 
cable helper address, cable modems and their attached CPE (hosts) will receive their (CM and CPE) IP 
address.

IP Type can have the following values:

• Host—When selected, only UDP broadcasts from hosts (CPE devices) are forwarded to that 
particular destination IP address. (For example, only hosts will receive IP addresses from the 
mentioned helper address.)

• Modem—When selected, only UDP broadcasts from cable modems are forwarded to that particular 
destination IP address. (For example, only cable modems will receive IP addresses from the 
mentioned helper address.)
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• Both—When selected, UDP broadcasts from hosts (CPE devices) and cable modems are forwarded 
to that particular destination IP address. (For example, both cable modems and hosts will receive IP 
addresses from the mentioned helper address.)

Step 14 Click OK. The MPLS Link Attribute Editor reappears. 

Step 15 Click Edit beside Secondary Addresses. The Cable Secondary Addresses window appears.

The secondary IP address enables CPE devices (hosts) attached to cable modem to talk to CMTS. 
(Usually this is a public IP address so that PCs can go to internet.)

Figure 8-17 Cable Secondary Addresses

Step 16 Enter an IP address in the IP address/Mask field and click OK. The MPLS Link Attribute Editor 
reappears.

Step 17 Click Next. The MPLS Link Attribute Editor for the IP Address Scheme appears (see Figure 8-18).

Figure 8-18 Specifying the MPLS Link IP Address Attributes

Step 18 Edit any IP address scheme values that must be modified for this particular link, then click Next.

The MPLS Link Attribute Editor for Routing Information appears (see Figure 8-19).

Figure 8-19 Specifying the MPLS Link Routing Protocol Attributes

Step 19 Edit any routing protocol values that must be modified for this particular link, then click Next.
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The MPLS Link Attribute Editor for the VRF and VPN attributes appears (see Figure 8-20).

Figure 8-20 Specifying the MPLS Link VRF and VPN Attributes

The field values displayed in this dialog box reflect the values specified in the service policy associated 
with this service. 

Step 20 Select the check box for Join the Management VPN. 

Step 21 Edit any VRF and VPN values that must be modified for this particular link, then click Add.

The Select CERCs/VPN dialog box appears.

Figure 8-21 Select CERCs

Step 22 Select the customer name and VPN.

Step 23 Click Join as Spoke, then click Done.

The MPLS Link Attribute Editor for the VRF and VPN attributes appears (see Figure 8-22).
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Figure 8-22 Specifying the MPLS Link VRF and VPN Attributes

Step 24 Edit any VRF and VPN values that must be modified for this particular link, then click Next.

You return to the MPLS Service Request Editor.

Note You can define multiple links in this service request. 

Step 25 To save your work on this first link in the service request, click Save.

You return to the Service Requests dialog box, where the information for the link you just defined is now 
displayed. 

Figure 8-23 Service Request for an MPLS Link Completed

Step 26 Click Save.
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Provisioning Carrier Supporting Carrier

This chapter describes how to configure the carrier supporting carrier (CSC) feature using the IP 
Solution Center (ISC) provisioning process. This chapter contains the following major sections:

• Carrier Supporting Carrier Overview, page 9-1

• Defining a CSC Service Policy, page 9-5

• Provisioning a CSC Service Request, page 9-5

Carrier Supporting Carrier Overview
The carrier supporting carrier feature enables one MPLS VPN-based service provider to allow other 
service providers to use a segment of its backbone network. The service provider that provides the 
segment of the backbone network to the other provider is called the backbone carrier. The service 
provider that uses the segment of the backbone network is called the customer carrier. 

This documentation focuses on a backbone carrier that offers Border Gateway Protocol and 
Multiprotocol Label Switching (BGP/MPLS) VPN services. There can be two types of customer 
carriers:

• An Internet service provider (ISP) 

• A BGP/MPLS VPN service provider

This documentation describes both types of customer carrier.

It is transparent to the backbone provider when either scenario is in use, after the required functionality 
for basic MPLS VPN CSC is implemented in the backbone network.

Backbone Network with a Customer Carrier Who Is an ISP
In this network configuration, the customer carrier has two sites, each of which is a point of presence 
(POP). The customer carrier connects these sites using a VPN service provided by a backbone carrier, 
who uses MPLS. The ISP sites use IP. To enable packet transfer between the ISP sites and the backbone 
carrier, the CSC-CE routers that connect the ISPs to the backbone carrier run MPLS. 

Figure 9-1 shows a carrier supporting carrier network configuration where the customer carrier is an ISP. 
The customer carrier has two sites, each of which is a point of presence (POP). The customer carrier 
connects these sites using a VPN service provided by the backbone carrier. The backbone carrier uses 
MPLS. The ISP sites use IP. To enable packet transfer between the ISP sites and the backbone carrier, 
the CSC-CE routers that connect the ISPs to the backbone carrier run MPLS. 
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Figure 9-1 Carrier Supporting Carrier Network with a Customer Carrier Who Is an ISP

In this example, only the backbone carrier uses MPLS. The customer carrier (ISP) uses only IP. As a 
result, the backbone carrier must carry all the Internet routes of the customer carrier, which could be as 
many as 100,000 routes. This poses a scalability problem for the backbone carrier. To solve the 
scalability problem, the backbone carrier is configured as follows: 

• The backbone carrier allows only internal routes of the customer carrier (IGP routes) to be 
exchanged between the CSC-CE routers of the customer carrier and the CSC-PE routers of the 
backbone carrier. 

• MPLS is enabled on the interface between the CSC-CE router of the customer carrier and the 
CSC-PE router of the backbone carrier. 

Internal and external routes are differentiated this way: 

• Internal routes go to any of the routers within the ISP. 

• External routes go to the Internet.

The number of internal routes is much smaller than the number of external routes. Restricting the routes 
between the CSC-CE routers of the customer carrier and the CSC-PE routers of the backbone carrier 
significantly reduces the number of routes that the CSC-PE router needs to maintain. 

Since the CSC-PE routers do not have to carry external routes in the VRF routing table, they can use the 
incoming label in the packet to forward the customer carrier Internet traffic. Adding MPLS to the routers 
provides a consistent method of transporting packets from the customer carrier to the backbone carrier. 
MPLS allows the exchange of an MPLS label between the CSC-PE and the CSC-CE routers for every 
internal customer carrier route. The routers in the customer carrier have all the external routes either 
through IBGP or route redistribution to provide Internet connectivity. 

Figure 9-2 shows how information is exchanged when the network is configured in this manner.
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Figure 9-2 Backbone Carrier Exchanging Routing Information with a Customer Carrier Who Is an 

ISP

Backbone Network with a Customer Carrier Who Is a BGP/MPLS VPN Service 
Provider

When a backbone carrier and the customer carrier both provide BGP/MPLS VPN services, the method 
of transporting data is different from when a customer carrier provides only ISP services. The following 
list highlights those differences. 

• When a customer carrier provides BGP/MPLS VPN services, its external routes are VPN-IPv4 
routes. When a customer carrier is an ISP, its external routes are IP routes. 

• When a customer carrier provides BGP/MPLS VPN services, every site within the customer carrier 
must use MPLS. When a customer carrier is an ISP, the sites do not need to use MPLS.

Figure 9-3 figure shows a carrier supporting carrier network configuration where the customer carrier is 
an MPLS VPN provider. The customer carrier has two sites. The backbone carrier and the customer 
carrier use MPLS. The IBGP sessions exchange the external routing information of the ISP. 

Figure 9-3 Carrier Supporting Carrier Network with a Customer Carrier Who Is an MPLS VPN 
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Figure 9-3 figure shows exchanging information with a customer carrier who is an MPLS VPN service 
provider.

Figure 9-4 Backbone Carrier Exchanging Information with a Customer Carrier Who Is an MPLS 

VPN Service Provider

ISC Configuration Options
To configure the CSC network to exchange routes and carry labels between the backbone carrier provider 
edge (CSC-PE) routers and the customer carrier customer edge (CSC-CE) routers, use Label 
Distribution Protocol (LDP) to carry the labels and an Internal Gateway Protocol (IGP) to carry the 
routes.

LDP/IGP

A routing protocol is required between the CSC-PE and CSC-CE routers that connect the backbone 
carrier to the customer carrier. The routing protocol enables the customer carrier to exchange IGP 
routing information with the backbone carrier. RIP, OSPF, or static routing as the routing protocol can 
be selected.

Label distribution protocol (LDP) is required between the CSC-PE and CSC-CE routers that connect the 
backbone carrier to the customer carrier. LDP is also required on the CSC-PE to CSC-CE interface for 
VPN routing/forwarding (VRF).

IPv4 BGP Label Distribution

BGP takes the place of an IGP and LDP in a VPN forwarding/routing instance (VRF) table. You can use 
BGP to distribute routes and MPLS labels. Using a single protocol instead of two simplifies the 
configuration and troubleshooting.

BGP is the preferred routing protocol for connecting two ISPs, mainly because of its routing policies 
and ability to scale. ISPs commonly use BGP between two providers. This feature enables those ISPs to 
use BGP.
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When BGP (both EBGP and IBGP) distributes a route, it can also distribute an MPLS label that is 
mapped to that route. The MPLS label mapping information for the route is carried in the BGP update 
message that contains the information about the route. If the next hop is not changed, the label is 
preserved.

Defining a CSC Service Policy
To define a Service Policy with CSC, choose the CSC Support check box from the MPLS Policy Editor - 
Routing Information, as shown in Figure 9-5.

Figure 9-5 CSC Service Policy

When CSC Support is checked, the CSC functionality is enabled to the MPLS VPN service.

Provisioning a CSC Service Request
To provision a Service Request with CSC, choose the CSC Support check box from the MPLS Link 
Attribute Editor - Routing Information, as shown in Figure 9-6.
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Figure 9-6 CSC Service Request

When CSC Support is checked, the CSC functionality is enabled for the MPLS VPN service.
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Provisioning Multiple Devices

This chapter describes how to configure multiple devices, Layer 2 (L2) “switches” and Layer 3 (L3) 
“routers,” using the IP Solution Center (ISC) provisioning process. This chapter contains the following 
major sections:

• NPC Ring Topology, page 10-1

• Ethernet-To-The-Home, page 10-9

NPC Ring Topology
This section describes how to create a Ring Topology, connect the CE starting and PE-POP ending 
points, and configure the Named Physical Circuits (NPC) from end to end, using the IP Solution Center 
(ISC) provisioning process.

This section contains the following sections:

• Ring Topology Overview, page 10-1

• Creating a Ring of Three PE-CLE, page 10-2

• Configuring NPC Ring Topology, page 10-4

Ring Topology Overview
Service providers are now looking to offer L2 and L3 services that must integrate with a common MPLS 
infrastructure. ISC supports two basic L2 topologies to access L3 MPLS networks: 

• Ring Topology

• Aggregation Topology (“Hub and Spoke”)

Figure 10-1 shows an example of these two basic L2 access topologies.
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Figure 10-1 L2 Access Topologies 

Creating a Ring of Three PE-CLE
In its simplest form, the Ring Topology is a tripartite structure that comprises at least three PE- CLE. A 
PE-POP and a Multi-VRF CE can also be part of a Ring.

Figure 10-2 shows an example ring of three Catalyst 3550 switches: mlsw5, mlsw6, and mlsw7. 

Figure 10-2 A Ring of Three PE-CLE

To create a Ring Topology in ISC, follow these steps:

Step 1 Log into ISC.

Step 2 Choose Service Inventory > Inventory and Connection Manager.

Step 3 Click NPC Rings in the TOC under Named Physical Circuits.

The NPC Rings window appears, as shown in Figure 10-3.
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Figure 10-3 NPC Rings

Step 4 Click Create to continue.

The Create Ring window appears, as shown in Figure 10-4.

Figure 10-4 Create Ring

Step 5 Click Select source device in the first cell.

The Show Devices window appears, as shown in Figure 10-5.

Note The Show Devices drop-down window in Figure 10-5 should show CLE rather than PE. This is a known 
application error. You cannot initiate this process with a PE-POP or a CE. You must begin with a PE- 
CLE.

Figure 10-5 Show Devices

Step 6 To search for a specific CLE, enter the source device in the matching dialog-box and click Find.

Step 7 Choose the CLE and click Select. (mlsw6.cisco.com)

The Create Ring window appears, as shown in Figure 10-6.
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Figure 10-6 Create Ring 

Step 8 Continue from left to right and from top to bottom to fill the table with the appropriate Device and 
Interface information, which would be based on a network diagram from your own environment.

Note If you had used the network diagram in Figure 10-8 to populate the Create Ring table, it would contain 
the above information at the end of this process. 

Step 9 Click Save to save your ring in the Repository. 

The NPC Rings window appears, as shown in Figure 10-7

Figure 10-7 NPC Rings

Proceed to Configuring NPC Ring Topology, page 10-4.

Configuring NPC Ring Topology
Figure 10-8 shows an example of the Ring Topology (three CLE) inserted between a CE (mlce14) and a 
PE-POP (mlpe4). 
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Figure 10-8 The Ring Topology

To configure end-to-end connectivity (CE > Ring (PE-CLE) > PE), follow these steps:

Step 1 Log into ISC.

Step 2 Choose Service Inventory > Inventory and Connection Manager > Named Physical Circuits.

The Named Physical Circuits window appears, as shown in Figure 10-9.

Figure 10-9 Named Physical Circuits

Step 3 Click Create.

The Create Named Physical Circuits window appears, as shown in Figure 10-10.
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Figure 10-10 Create a Named Physical Circuit

Step 4 Click Add Device.

The Select Devices window appears (not shown).

Step 5 Choose the CE and then click Select. (mlce14)

The Create a Named Physical Circuit window appears, as shown in Figure 10-11.

Figure 10-11 Create a Named Physical Circuit

Step 6 Click Add Device.

The Select Devices window appears, as shown in Figure 10-12.

Figure 10-12 Select Devices

Step 7 Choose the PE and then click Select. (mlpe4)

The Create a Named Physical Circuit window appears, as shown in Figure 10-13.
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Figure 10-13 Create a Named Physical Circuit

Step 8 Click Insert Ring.

The Show NPC Rings window appears, as shown in Figure 10-14.

Figure 10-14 Create a Named Physical Circuit

Step 9 Choose an NPC Ring and click Select. (1-mlsw6-FastEthernet0/3)

The Create a Named Physical Circuit window appears, as shown in Figure 10-15.

Figure 10-15 Create a Named Physical Circuit

Step 10 Choose a device with an available check box and click Select device.

The Show PE Devices window appears, as shown in Figure 10-16.
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Figure 10-16 Show PE Devices

Step 11 Choose a PE-CLE and click Select. (mlsw6)

The Create a Named Physical Circuit window appears (not shown).

Step 12 Select the incoming and outgoing interfaces for the CE, CLE, and PE until complete.

Step 13 Choose the remaining device with the darkened check box.

The Create a Named Physical Circuit window appears, as shown in Figure 10-17.

Figure 10-17 Create a Named Physical Circuit

Step 14 Click Save.

The Named Physical Interfaces window appears, with the Ring Topology displayed, as shown in 
Figure 10-18.
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Figure 10-18 Named Physical Circuits

Ethernet-To-The-Home
This section describes how to configure Ethernet-To-The-Home (ETTH) using the IP Solution Center 
(ISC) provisioning process. This section contains the following sections:

• ETTH Overview, page 10-9

• Configuring ETTH, page 10-11

ETTH Overview
ETTH is part of the Cisco ETTx solution, which contains both ETTH and Ethernet-to-the-Business 
(ETTB). ETTB is supported in ISC with the L2VPN Metro Ethernet service feature. Unlike ETTB, 
whose customers are mainly business customers, ETTH is targeted at residential customers. 

Figure 10-19 shows an overview of the Cisco ETTx solution.
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Figure 10-19 Cisco ETTx Solution

From a provisioning standpoint, the main difference between ETTB and ETTH is the consideration of 
resource scalability. For example, with ETTB, each business customer is allocated one or more 
VLAN(s).

With ETTH, it is not practical to assign a unique VLAN to each residential customer. The practical 
solution is to have all, or a group of residential customers, share the same VLAN and use common 
technology, such as a private VLAN (PVLAN) or a protected port, to guarantee traffic isolation.

Another difference between ETTB and ETTH is that most of the ETTB customers use an Ethernet trunk 
port while ETTH customers use an access port. In ISC, the access port is fully supported, with CE 
present or with no CE.

ETTH needs to support multicast based services, such as video, on a shared media such as a ring. 
Typically, Internet Group Management Protocol (IGMP) with Multicast VLAN Registration (MVR) 
would be the technology used to support these services.
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Access Domain Management

To provide more flexibility in managing an access domain, you can define a management VLAN. Once 
defined, the management VLAN is used to construct the list of VLANs allowed on the trunk port for all 
non-UNI ports.

You can also specify how the VLAN allowed list is constructed in a trunk port for a domain, if the list 
is not on the device. This feature is implemented for L2VPN DCPL parameter. It is available for Layer 
2 access to MPLS VPN as well.

As a part of Layer 2 access management, ISC provides the ability to create MAC access lists by 
specifying the MAC addresses to be allowed or blocked.

ISC ETTH Implementation

The ISC MPLS VPN implementation of ETTH consists of the following three sub-features:

• PVLAN or Protected Port, page 10-11

• Access Port, page 10-11

• IGMP with MVR, page 10-11

PVLAN or Protected Port

This feature is used to isolate traffic within a PVLAN. It prevents traffic from flowing between two 
UNIs. 

• PVLAN is only supported on the Catalyst 4500/6500 switches and Cisco 7600 router. 

• Protected Port is only supported on the Catalyst 2950/3550 switches.

Access Port

In ISC, the untagged Ethernet default is supported in the CE present and no CE scenarios. You can 
choose between two encapsulations: Dot1q and Default. 

The Default encapsulation only indicates that the traffic comes in from the CE is untagged. The UNI, 
which is always a Dot1q port, puts a tag on it before transmitting it. UNI has two options to handle this 
untagged traffic. It functions as an access port or a trunk port. For this reason, the GUI adds one more 
item for you to choose.

IGMP with MVR

This feature applies to a very specific user service and network topology. It is used for multicast video 
on a hub and spoke or ring network. However, it is not up to ISC to decide when it is used. ISC only 
makes it available and the network application running above ISC must invoke it when needed.

Configuring ETTH 
To configure ETTH in ISC MPLS VPN, follow these steps:

Step 1 Log into ISC.

Step 2 Choose Service Design > Policies.

Step 3 From the Policies window, select a Service Policy and click Edit.
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Step 4 From the Policy Type window, click Next.

The MPLS Policy Editor - Interface window appears, as shown in Figure 10-20.

Figure 10-20 MPLS Policy Editor - Interface

Step 5 To enable ETTH, click the ETTH Support check box. 

The ETTH UNI Information check boxes appear between the ETTH Support check box and the CE 
Information, as shown in Figure 10-21.

Figure 10-21 ETTH UNI Information

Step 6 To enable Private VLAN or Protected Port, click the Private VLAN/Protected Port check box. 

Step 7 To enable IGMP Snooping with MVR, click the IGMP Snooping with MVR check box. 

Three new UNI Information options appear, as shown in Figure 10-22.
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Figure 10-22 ETTH UNI Information Options

Step 8 Select UNI Information options:

• Mode

– Compatible—Multicast addresses are statically configured on the device.

– Dynamic—IGMP snooping is configured on the device.

• Query Time—Determines how often the device is queried for membership.

• Immediate—Removes the interface from the forwarding table immediately, when the session ends.

Step 9 Complete the standard steps and click Save.

Step 10 Choose Service Inventory > Inventory and Connection Manager > Service Requests.

Step 11 From the Service Requests window, select a Service Request and click Edit.

Step 12 From the MPLS Service Request Editor window, click the Link Attribute cell.

The MPLS Link Attribute Editor - Interface window appears, as shown in Figure 10-23.
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Figure 10-23 MPLS Link Attribute Editor - Interface

Step 13 Edit the following Link Attribute specific UNI Information:

• Secondary VLAN ID—Enter a VLAN ID for the Private VLAN, which is supported only on the 
Catalyst 4000 switch.

• Multicast IP Address—See Step 14.

• Multicast VLAN ID—Enter a VLAN ID for the Multicast VLAN.

Step 14 Click EDIT.

The Multicast IP Addresses dialog box appears, as shown in Figure 10-24.
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Figure 10-24 Multicast IP Addresses

Step 15 Edit the following Link Attribute specific UNI Information:

• Multicast IP Address—Enter an IP Address for the join the multicast group, which allows users to 
have access to video on demand, for example.

• Counter—Enter a count to determine the number of contiguous IP addresses starting with the 
Multicast IP Address. 

Step 16 Click OK.

Step 17 Complete the standard steps for creating an SR and click Save. 
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Spanning Multiple Autonomous Systems

This chapter describes how to configure spanning multiple autonomous systems using the IP Solution 
Center (ISC) provisioning process. This chapter contains the following major sections:

• Overview, page 11-1

• Routing Between Autonomous Systems, page 11-2

• Routing Between Subautonomous Systems in a Confederation, page 11-8

• Using ISC to Span Multiple Autonomous Systems, page 11-10

Overview
The inter-autonomous system for MPLS VPNs feature allows an MPLS VPN to span service providers 
and autonomous systems. An autonomous system is a single network or group of networks that is 
controlled by a common system administration group and that uses a single, clearly defined routing 
protocol.

As VPNs grow, their requirements expand. In some cases, VPNs need to reside on different autonomous 
systems in different geographic areas. Also, some VPNs need to extend across multiple service providers 
(overlapping VPNs). Regardless of the complexity and location of the VPNs, the connection between 
autonomous systems must be seamless to the customer.

The inter-autonomous systems for MPLS VPNs feature provides that seamless integration of 
autonomous systems and service providers. Separate autonomous systems from different service 
providers can communicate by exchanging IPv4 network layer reachability information (NLRI) in the 
form of VPN-IPv4 addresses. The autonomous systems’ border edge routers use the Exterior Border 
Gateway Protocol (EBGP) to exchange that information. An interior gateway protocol (IGP) then 
distributes the network layer information for VPN-IPv4 prefixes throughout each VPN and each 
autonomous system. Routing information uses the following protocols:

• Within an autonomous system, routing information is shared using an interior gateway protocol.

• Between autonomous systems, routing information is shared using an Exterior Border Gateway 
Protocol. An EBGP allows a service provider to set up an inter-domain routing system that 
guarantees the loop-free exchange of routing information between separate autonomous systems.

An MPLS VPN with inter-autonomous system support allows a service provider to provide to customers 
scalable Layer 3 VPN services, such as web hosting, application hosting, interactive learning, electronic 
commerce, and telephony service. A VPN service provider supplies a secure, IP-based network that 
shares resources on one or more physical networks.
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Routing Between Autonomous Systems
The primary function of EBGP is to exchange network reachability information between autonomous 
systems, including information about the list of autonomous system routes. The autonomous systems use 
EGBP border edge routers to distribute the routes, which include label switching information. Each 
border edge router rewrites the next-hop and MPLS labels. See Routing Between Autonomous Systems, 
page 11-2 for more information. 

Inter-autonomous system configurations supported in an MPLS VPN can include:

• Interprovider VPN: MPLS VPNs that include two or more autonomous systems, connected by 
separate border edge routers. The autonomous systems exchange routes using EBGP. No interior 
gateway protocol (IGP) or routing information is exchanged between the autonomous systems.

• BGP Confederations: MPLS VPNs that divide a single autonomous system into multiple 
sub-autonomous systems, and classify them as a single, designated confederation. The network 
recognizes the confederation as a single autonomous system. The peers in the different autonomous 
systems communicate over EBGP sessions; however, they can exchange route information as if they 
were IBGP peers.

Benefits
The inter-autonomous system MPLS VPN feature provides the following benefits:

• Allows a VPN to cross more than one service provider backbone

The inter-autonomous systems for MPLS VPNs feature allows service providers, running separate 
autonomous systems, to jointly offer MPLS VPN services to the same end customer. A VPN can 
begin at one customer site and traverse different VPN service provider backbones before arriving at 
another site of the same customer. Previously, MPLS VPNs could only traverse a single BGP 
autonomous system service provider backbone. The inter-autonomous system feature allows 
multiple autonomous systems to form a continuous (and seamless) network between a service 
provider’s customer sites.

• Allows a VPN to exist in different areas

The inter-autonomous systems for MPLS VPNs feature allows a service provider to create a VPN 
in different geographic areas. Having all VPN traffic flow through one point (between the areas) 
allows for better rate control of network traffic between the areas.

• Allows confederations to optimize IBGP meshing

The inter-autonomous systems feature can make IBGP meshing in an autonomous system more 
organized and manageable. You can divide an autonomous system into multiple, separate 
sub-autonomous systems and then classify them into a single confederation (even though the entire 
VPN backbone appears as a single autonomous system). This capability allows a service provider 
to offer MPLS VPNs across the confederation because it supports the exchange of labeled 
VPN-IPv4 network layer reachability information between the sub-autonomous systems that form 
the confederation.

Routing Between Autonomous Systems
Figure 11-1 illustrates one MPLS VPN consisting of two separate autonomous systems. Each 
autonomous system operates under different administrative control and runs a different IGP. Service 
providers exchange routing information through EBGP border edge routers (ASBR1 and ASBR2).
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Figure 11-1 EBGP Connection Between Two Autonomous Systems

This configuration uses the following process to transmit information:

1. The provider edge router (PE-1) assigns a label for a route before distributing that route. The PE 
router uses the multiprotocol extensions of a border gateway protocol (BGP) to transmit label 
mapping information. The PE router distributes the route as a VPN-IPv4 address. The address label 
and the VPN identifier are encoded as part of the NLRI.

2. The two route reflectors (RR-1 and RR-2) reflect VPN-IPv4 internal routes within the autonomous 
system. The autonomous systems’ border edge routers (ASBR1 and ASBR2) advertise the 
VPN-IPv4 external routes.

3. The EBGP border edge router (ASBR1) redistributes the route to the next autonomous system, 
(ASBR2). ASBR1 specifies its own address as the value of the EBGP next hop attribute and assigns 
a new label. The ASBR1 address ensures the following:

• The next hop router is always reachable in the service provider (P) backbone network.

• The label assigned by the distributing router is properly interpreted. The label associated with 
a route must be assigned by the corresponding next hop router.

4. The EBGP border edge router (ASBR2) redistributes the route in one of the following ways, 
depending on its configuration:

• If the IBGP neighbors are configured with the neighbor next-hop-self command, ASBR2 
changes the next hop address of updates received from the EBGP peer, then forwards it on.

• If the IBGP neighbors are not configured with the neighbor next-hop-self command, the next 
hop address does not get changed. ASBR2 must propagate a host route for the EBGP peer 
through the IGP. 
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To propagate the EBGP VPN-IPv4 neighbor host route, use the redistribute connected subnets 
command. The EBGP VPN-IPv4 neighbor host route is automatically installed in the routing 
table when the neighbor comes up. This is essential to establish the label-switched path between 
PE routers in different autonomous systems.

Exchanging VPN Routing Information
Autonomous systems exchange VPN routing information (routes and labels) to establish connections. 
To control connections between autonomous systems, the PE routers and EBGP border edge routers 
maintain a Label Forwarding Information Base (LFIB). The LFIB manages the labels and routes that the 
PE routers and EBGP border edge routers receive during the exchange of VPN information. 

Figure 11-2 illustrates the exchange of VPN route and label information between autonomous systems. 
The autonomous systems use the following guidelines to exchange VPN routing information:

Routing information includes:

• The destination network (N)

• The next hop field associated with the distributing router

• A local MPLS label (L)

An RD1: route distinguisher is part of a destination network address to make the VPN-IPv4 route 
globally unique in the VPN service provider environment.

The ASBRs are configured to change the next hop (next-hop-self) when sending VPN-IPv4 NLRIs to the 
IBGP neighbors. Therefore, the ASBRs must allocate a new label when they forward the NLRI to the 
IBGP neighbors.
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Figure 11-2 Exchanging Routes and Labels Between Two Autonomous Systems

Figure 11-3 illustrates the exchange of VPN route and label information between autonomous systems. 
The only difference is that ASBR2 is configured with the redistribute connected command, which 
propagates the host routes to all PEs. The redistribute connected command is necessary because 
ASBR2 is not the configured to change the next hop address.
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Figure 11-3 Host Routes Propagated to All PEs Between Two Autonomous Systems

Figure 11-4 illustrates how packets are forwarded between autonomous systems in an interprovider 
network using the following packet forwarding method:

Packets are forwarded to their destination via MPLS. Packets use the routing information stored in the 
LFIB of each PE router and EBGP border edge router. The service provider VPN backbone uses dynamic 
label switching to forward labels.

Each autonomous system uses standard multi-level labeling to forward packets between the edges of the 
autonomous system routers (for example, from CE-5 to PE-3). Between autonomous systems, only a 
single level of labeling is used, corresponding to the advertised route.

A data packet carries two levels of labels when traversing the VPN backbone:

• The first label (IGP route label) directs the packet to the correct PE router or EBGP border edge 
router. (For example, the IGP label of ASBR2 points to the ASBR2 border edge router.)

• The second label (VPN route label) directs the packet to the appropriate PE router or EBGP border 
edge router.
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Figure 11-4 Forwarding Packets Between Two Autonomous Systems

Figure 11-5 illustrates shows the same packet forwarding method, except the EBGP router (ASBR1) 
forwards the packet without reassigning it a new label.
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Figure 11-5 Forwarding Packets Without Reassigning a New Label

Routing Between Subautonomous Systems in a Confederation
A VPN can span service providers running in separate autonomous systems or between multiple 
subautonomous systems that have been grouped together to form a confederation.

A confederation reduces the total number of peer devices in an autonomous system. A confederation 
divides an autonomous system into subautonomous systems and assigns a confederation identifier to the 
autonomous systems.

In a confederation, each subautonomous system is fully meshed with other subautonomous systems. The 
subautonomous systems communicate using an IGP, such as Open Shortest Path First (OSPF) or 
Intermediate System-to-Intermediate System (IS-IS). Each subautonomous system also has an EBGP 
connection to the other subautonomous systems. The confederation EBGP (CEBGP) border edge routers 
forward next-hop-self addresses between the specified subautonomous systems. The next-hop-self 
address forces the BGP to use a specified address as the next hop rather than letting the protocol choose 
the next hop.

You can configure a confederation with separate subautonomous systems in two ways:

• You can configure a router to forward next-hop-self addresses between only the CEBGP border edge 
routers (both directions). The subautonomous systems (IBGP peers) at the subautonomous system 
border do not forward the next-hop-self address. Each subautonomous system runs as a single IGP 
domain. However, the CEBGP border edge router addresses are known in the IGP domains.

CE-1 CE-2

CE-3 CE-4

CE-5

PE-1 PE-2

PE-3

RR-1 RR-2

ASBR1 ASBR2

Core of P
routers

Core of P
routers

48
30

0

Network = N
VPN label = L1 Network = N

VPN label = L2

Network = N
IGP label = ASBR1
VPN label = L2

Network = NNetwork = N

Network = N
IGP label = PE1
VPN label = L1

Network = N
IGP label = ASBR1

VPN label = L2

VPN 1

VPN 1

Service Provider 1

Service Provider 2
11-8
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Chapter 11      Spanning Multiple Autonomous Systems
Routing Between Subautonomous Systems in a Confederation
• You can configure a router to forward next-hop-self addresses between the CEBGP border edge 
routers (both directions) and within the IBGP peers at the subautonomous system border. Each 
subautonomous system runs as a single IGP domain but also forwards next-hop-self addresses 
between the PE routers in the domain. The CEBGP border edge router addresses are known in the 
IGP domains.

Figure 11-6 illustrates a typical MPLS VPN confederation configuration. In this confederation 
configuration:

• The two CEBGP border edge routers exchange VPN-IPv4 addresses with labels between the two 
subautonomous systems.

• The distributing router changes the next-hop addresses and labels and uses a next-hop-self address.

• IGP-1 and IGP-2 know the addresses of CEBGP-1 and CEBGP-2.

Figure 11-6 EGBP Connection Between Two AS’s in a Confederation

In this confederation configuration:

• CEBGP border edge routers function as neighboring peers between the subautonomous systems. 
The sub-autonomous systems use EBGP to exchange route information.

• Each CEBGP border edge router (CEBGP-1, CEBGP-2) assigns a label for the route before 
distributing the route to the next subautonomous system. The CEBGP border edge router distributes 
the route as a VPN-IPv4 address by using the multiprotocol extensions of BGP. The label and the 
VPN identifier are encoded as part of the NLRI.

• Each PE and CEBGP border edge router assigns its own label to each VPN-IPv4 address prefix 
before redistributing the routes. The CEBGP border edge routers exchange VPN-IPv4 addresses 
with the labels. 
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The next-hop-self address is included in the label (as the value of the EBGP next-hop attribute). 
Within the sub-autonomous systems, the CEBGP border edge router address is distributed 
throughout the IBGP neighbors and the two CEBGP border edge routers are known to both 
confederations.

Using ISC to Span Multiple Autonomous Systems
As described in Exchanging VPN Routing Information, page 11-4, autonomous systems exchange VPN 
routing information (routes and labels) to establish connections. To control connections between 
autonomous systems, the PE routers and Exterior BGP ASBRs (Autonomous System Boundary Routers) 
maintain a Label Forwarding Information Base (LFIB). The LFIB manages the labels and routes that the 
PE routers and EBGP border edge routers receive during the exchange of VPN information. 

The ASBRs are configured to change the next hop (next-hop-self) when sending VPN-IPv4 network layer 
reachability information to their IBGP neighbors. Therefore, the ASBRs must allocate a new label when 
they forward the NLRI to their IBGP neighbors.

Figure 11-7 shows the example ISC network used in this section. 

Figure 11-7 Example VPN Network with Two Autonomous Systems

In order for traffic from Acme_Chicago in AS 100 to reach Acme_Rome in AS 200, ISC must provision 
two links only: 

• The link between Acme_Chicago and PE-1

• The link between Acme_Rome and PE-G1 
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As shown in Figure 11-7, ISC routes the VPN traffic from PE-1 to ASBR-1, from ASBR-1 to ASBR-2, 
then from ASBR-2 to PE-G1; finally the traffic is routed to its destination, Acme-Rome.

ASBR-1 and ASBR-2 must run BGP (Border Gateway Protocol). Then iMP-BGP (interior Multiprotocol 
BGP) handles the routes between PE-1 to ASBR-1 in AS 100 and the routes between PE-2 to ASBR-2 
in AS 200. eMP-BGP (exterior Multiprotocol BGP) handles the routes between ASBR-1 and ASBR-2.

Tip The service provider must configure a VPN-IPv4 EBGP session between directly connected 
Autonomous System Boundary Routers (ASBRs). This is a one-time setup procedure that the service 
provider must manage. ISC does not provision the link between the ASBR devices that span autonomous 
systems. 

A VPN-IPv4 address (also referred to as a VPNv4 address) is the combination of the IPv4 address and 
the 8-byte route distinguisher (RD). Combining the RD and the IPv4 address makes the IPv4 route 
globally unique across the MPLS VPN network. BGP considers an IPv4 address as different from 
another IPv4 address that has the same network and subnet mask when the route distinguishers are 
different.
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Setting Up the Network

The Cisco IP Solution Center (ISC) MPLS VPN Management feature is an MPLS VPN provisioning and 
auditing tool. It focuses on the provider edge routers (PEs), customer edge routers (CEs), and the link 
between them. ISC can use either a Telnet gateway or Cisco Configuration Center software to transport 
configuration file information to and from target routers. Additional features include Class of Service 
(CoS) provisioning, VPN-aware NetFlow traffic profiling, and Service Level Agreement (SLA) 
monitoring. 

ISC also provides external access to its provisioning, traffic profiling, and SLA monitoring features 
through CORBA/XML APIs.

In an MPLS network, a customer edge router (CE) is connected to a provider edge router (PE) in such a 
way that the customer’s traffic is encapsulated and transparently sent to other CEs, thus creating a virtual 
private network. The Cisco ISC provisioning engine for MPLS accesses the configuration files on both 
the CE and PE to compute the necessary changes to the configuration files to support the service on the 
PE-CE link.

As shown in Figure A-1, Cisco requires that the Cisco ISC software is installed on its own dedicated 
system. The Cisco ISC workstation is optionally connected on a LAN to one or more Processing servers 
and Collection servers.

Figure A-1 Cisco ISC: MPLS VPN Management in the Service Provider Network
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Tasks to Be Completed Before Using ISC Software
The ISC Network Management Subnet is required when the service provider’s service offering 
entails the management of CEs. The management subnet consists of the IP Solution Center 
workstation where ISC is installed on a Sun Solaris 8 system. On the same LAN, the service provider 
can optionally install one or more Processing servers.

The Processing servers are responsible for executing tasks such as provisioning, auditing, SLA data 
collection, and so on. There can be one or more Processing server machines. 

• The Management VPN

The Management VPN is a special VPN employed by the ISC Network Management Subnet to 
manage the CEs in a service provider network. Once a CE is in a VPN, it is no longer accessible by 
means of conventional IPv4 routing, unless the CEs are part of the Management VPN. To 
communicate with the PEs, the link between the Management PE (MPE) and the Management-CE 
(MCE) uses a parallel IPv4 link. The Management VPN connects to the managed CEs.

• Multi-VRF CE

The Multi-VRF CE is a feature that provides for Layer 3 aggregation. Multiple CEs can connect to 
a single Multi-VRF CE (typically in an enterprise network); then the Multi-VRF CE connects 
directly to a PE. Figure A-1 shows CE 1 and CE2 connected to the Multi-VRF CE, and the 
Multi-VRF CE is connected directly to the PE. For details, see Multi-VRF CE, page 1-18.

• Layer 2 Access to MPLS VPNs

The service provider can install multiple Layer 2 switches between a PE and CE, as shown in 
Figure A-1. This feature provides Layer 2 aggregation. Additional CEs can be connected to the 
switches as well. Cisco supports two switches for the Layer 2 access to MPLS: either a Cisco 
Catalyst 2950 Switch or a Cisco Catalyst 3550 Intelligent Ethernet Switch.

• Collection Servers

Cisco ISC is designed to provision a large number of devices through its distributed architecture. If 
the Master server (equivalent to the ISC workstation) cannot keep up with the number of devices, 
Collection servers can be added to off load the work of the Master server. Among other tasks, 
Collection servers are responsible for uploading and downloading configuration files to and from 
Cisco routers. For more information, see Defining Collection Zones and Assigning Devices to 
Zones, page A-12.

Tasks to Be Completed Before Using ISC Software
Before you use Cisco ISC: MPLS VPN Management software to provision an MPLS network, the 
Service Provider must complete the following tasks:

1. IPv4 connectivity must be operational among all the routers in the MPLS VPN network before 
provisioning can take place.

2. The Service Provider or Customer must create a loopback interface on each router.

3. Each router must have a routable IP address.

4. Optionally, you can set up the Secure Shell (SSH) on the CE routers (see the next section for details).

5. Set up SNMP on all the edge routers in the network—see the Setting Up SNMPv1 and SNMPv2 on 
the Routers in the Service Provider Network, page A-4 and the Setting the SNMPv3 Parameters on 
the Routers in the Service Provider Network, page A-5.

6. Enable SA Agent on all edge devices that you want to collect SLA data from—see Enabling SA 
Agent on Edge Routers for SLA Jitter Probes, page A-7.
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7. If you choose to use TFTP (Trivial File Transfer Protocol) as the default configuration transport 
method, you must enable TFTP on the Cisco ISC workstation—see Enabling TFTP in Cisco ISC, 
page A-8.

8. If you are installing and using Collection servers, complete the procedures described in Defining 
Collection Zones and Assigning Devices to Zones, page A-12.

9. If you are using terminal servers to access routers in the network, you must enable at least as many 
Telnet sessions on the terminal server as there are terminal server ports. For details, see Enabling 
Telnet Sessions for Terminal Server Ports, page A-8.

Caution Make sure that the file descriptor limit is not set in the Cisco ISC workstation login shell file (which can 
be the .login file, the .cshrc file, or the .kshrc file). If the login shell file contains a line with the ulimit 
-n command (for example, “ulimit -n <number>”), comment out this command line in the file.

Cisco ISC cannot override the file descriptor limitation setting in the login shell file. If the value is set 
incorrectly, Cisco ISC may experience operational problems.

Configuring Devices in the ISC MPLS Environment
This section describes the tasks the Service Provider should complete to set up devices in the Cisco IP 
Solution Center MPLS environment.

Setting Up the Secure Shell (SSH) on Edge Routers
Service providers need a mechanism to deploy VPN configuration files to remote edge routers in a secure 
manner. The basic requirements for secured management are as follows:

• The edge device routers and Cisco ISC must be able to authenticate each other.

• An encrypted channel for uploading and downloading router configuration information must be in 
place.

Cisco ISC uses TGS as the configuration file download mechanism. One of the modes that TGS can 
operate in is Secure Shell (SSH) mode. The Telnet Gateway Server uses SSH for both authentication and 
encryption. In this scheme, the edge device router functions as an SSH server, while Cisco ISC functions 
as the SSH client.

Note This configuration procedure assumes that the router’s authentication database is stored locally on the 
router and not on a TACACS (Terminal Access Controller Access Control System) server.

The procedure for configuring SSH on edge device routers is as follows:

Command Description

Step 1 Router# configure terminal Enter global configuration mode.

Step 2 Router(config)# ip domain-name domain_name Specify the IP domain name.
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Setting Up SNMPv1 and SNMPv2 on the Routers in the Service Provider 
Network

The Simple Network Management Protocol (SNMP) must be configured on each router and edge device 
in the service provider network. To determine whether SNMP is enabled and to set the SNMP community 
strings on a router, execute the following steps for each router.

Step 3 Router(config)# crypto key generate rsa Generate keys for the SSH session. 

The crypto key generate rsa command is 
interactive. You will see the following prompt:

Choose the size of the key modulus in the 

range of 360 to 2048 for your general 

purpose keys.

How many bits in the modulus (nnn):

Step 4 Press Enter to accept the default number of 
bits.

Step 5 Router(config)# username username password 
password

Configure the user ID and password. Enter the 
ISC workstation username and password you 
are logged in as. For example, username admin 
password isc.

Step 6 Router(config)# line vty 0 4 Enable SSH as part of the vty login transport.

Step 7 Router(config-line)# login local The login command can take either local or 
tacacs as its value. This command indicates that 
the router stores the authentication information 
locally. 

Step 8 Router(config-line)# transport input telnet 
ssh

Step 9 Router(config-line)# Ctrl+Z Return to Privileged Exec mode.

Step 10 Router# copy running startup Save the configuration changes to NVRAM.

Command Description

Command Description

Step 1 > telnet router_name Telnet to the router you want to configure.

Step 2 Router> enable

Router> enable_password

Enter enable mode, then enter the enable 
password.

Step 3 Router# show snmp Check the output of the show snmp command 
to see whether the following statement is 
present: “SNMP agent not enabled.” If SNMP 
is not enabled, complete the steps in this 
procedure.

Step 4 Router# configure terminal Enter global configuration mode.

Step 5 Router(config)# snmp-server community 
userstring RO

Set the community read-only string.
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Tip The SNMP strings defined in the Cisco ISC for each target device must be identical with those 
configured for the corresponding edge devices in the service provider network.

Setting the SNMPv3 Parameters on the Routers in the Service Provider 
Network

Simple Network Management Protocol Version 3 (SNMPv3) is an interoperable standards-based 
protocol for network management. SNMPv3 provides secure access to devices by a combination of 
authenticating and encrypting packets over the network. 

This section describes how to set the SNMPv3 parameters on the routers in the service provider network. 
To complete the task regarding SNMPv3 parameters, you also must set a selected set of parameters in 
the Cisco ISC software. The SNMPv3 parameters you set on the routers must match the SNMPv3 
parameters you specify in the Cisco ISC software.

The security features provided in SNMPv3 are as follows:

• Message integrity—Ensuring that a packet has not been tampered with in-transit.

• Authentication—Determining the message is from a valid source.

• Encryption—Scrambling the contents of a packet prevent it from being seen by an unauthorized 
source.

Using SNMPv3, data can be collected securely from SNMP devices without fear of the data being 
tampered with or corrupted. Also, using the SNMP Set command, packets that change a router’s 
configuration can be encrypted to prevent its contents from being exposed on the network.

SNMPv3 provides for both security models and security levels. A security model is an authentication 
strategy that is set up for a user and the group in which the user resides. A security level is the permitted 
level of security within a security model. A combination of a security model and a security level 
determines which security mechanism is employed when handling an SNMP packet. 

Three security models are available: SNMPv1, SNMPv2c, and SNMPv3. 

Table A-1 identifies the combinations of security models and levels.

Step 6 Router(config)# snmp-server community 
userstring RW

Set the community read-write string.

Step 7 Router(config)# Ctrl+Z Return to Privileged Exec mode.

Step 8 Router# copy running startup Save the configuration changes to NVRAM.

Command Description

Table A-1 SNMP Security Models and Levels

Model Level Authentication Encryption What Happens

v1 noAuthNoPriv Community 
String

No Uses a community string match for 
authentication

v2c noAuthNoPriv Community 
String

No Uses a community string match for 
authentication.

v3 noAuthNoPriv Username No Uses a username match for 
authentication.
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SNMPv3 objects have the following characteristics:

• Each user belongs to a group.

• A group defines the access policy for a set of users.

• An access policy is what SNMP objects can be accessed for reading, writing, and creating.

• A group determines the list of notifications its users can receive.

• A group also defines the security model and security level for its users.

To check the existing SNMP configuration, use these commands:

• show snmp group

• show snmp user

To set the SNMPv3 server group and server users parameters on a router, execute the following steps:

v3 authNoPriv MD5 or SHA No Provides authentication based on the 
HMAC-MD5 or HMAC-SHA 
algorithms.

v3 authPriv MD5 or SHA DES Provides authentication based on the 
HMAC-MD5 or HMAC-SHA 
algorithms. Provides DES 56-bit 
encryption in addition to authentica- 
tion based on the CBC-DES 
(DES-56) standard.

Table A-1 SNMP Security Models and Levels (continued)

Model Level Authentication Encryption What Happens

Command Description

Step 1 > telnet router_name Telnet to the router you want to configure.

Step 2 Router> enable

Router> enable_password

Enter enable mode, then enter the enable 
password.

Step 3 Router# configure terminal Enter global configuration mode.

Step 4 Router(config)# snmp-server group [groupname 
{v1 | v2c | v3 {auth | noauth | priv}}] [read 
readview] [write writeview] [notify notifyview] 

[access access-list]

The snmp-server group command configures a 
new SNMP group or a table that maps SNMP 
users to SNMP views. Each group belongs to a 
specific security level.

Example: snmp-server group v3auth v3 auth 
read v1default write v1default

Step 5 Router(config)# snmp-server user username 
[groupname remote ip-address [udp-port port] 
{v1 | v2c | v3 [encrypted] [auth {md5 | sha} 
auth-password [priv des56 priv-password]] 
[access access-list]

The snmp-server user command configures a 
new user to an SNMP group.

Example: snmp-server user user1 v3auth v3 
auth md5 user1Pass

Step 6 Router(config)# Ctrl+Z Return to Privileged Exec mode.

Step 7 Router# copy running startup Save the configuration changes to NVRAM.
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Enabling SA Agent on Edge Routers for SLA Jitter Probes
If you want to use the (voice) jitter protocol to collect SLA data from the edge devices in your network, 
you must enable SA Agent on each device from which you want to collect this data.

This procedure assumes that you have already enabled SNMP and set the SNMP parameters on the edge 
device router, as described in the previous sections of this chapter.

To enable SA Agent on an edge router for jitter probes, execute the following steps:

Command Description

Step 1 > telnet router_name Telnet to the router you want to configure.

Step 2 Router> enable

Router> enable_password

Enter enable mode, then enter the enable 
password.

Step 3 Router# configure terminal Enter global configuration mode.

Step 4 Router(config)# rtr responder Enable SA Agent on the SLA probe’s target 
router.

Step 5 Router(config)# Ctrl+Z Return to Privileged Exec mode.

Step 6 Router# copy running startup Save the configuration changes to NVRAM.
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Enabling Telnet Sessions for Terminal Server Ports
You must enable at least as many Telnet sessions on the terminal server as there are terminal server ports. 
Otherwise, concurrent access to all the routers via the terminal server may fail.

To enable the appropriate number of Telnet sessions for terminal server access, follow these steps:

Time Zone Support in ISC
ISC supports only the time zones that are in the /usr/share/lib/zoneinfo directory of the Solaris 
workstation on which the ISC software is installed. The contents of this directory could change with each 
version of Solaris. 

ISC cannot change the manner in which these time zones are configured, most notably the variations in 
Daylight Savings Time. 

Note ISC does not support custom time zones.

Setting Up the ISC Workstation
This section describes the elements or components you should set up on the Cisco ISC workstation.

Enabling TFTP in Cisco ISC
The Cisco ISC software in MPLS mode is set by default to use Telnet as the mechanism to transport 
configuration files to and from routers. To set Cisco ISC software to use the Trivial File Transfer 
Protocol (TFTP) instead, edit the Hosts Configuration GTL device-config-access protocol property as 
described in this section. ISC properties are defined in the Dynamic Component Properties Library 
(DCPL).

Changing this value sets the default upload and download mechanism for all the devices configured to 
use the default for the Terminal Session Protocol and the Configuration Access Protocol.

Step 1 Log into Cisco ISC.

Command Description

Step 1 > telnet terminal_server_name Telnet to the terminal server.

Step 2 Terminalserver> enable

Terminalserver> enable_password

Enter enable mode, then enter the enable 
password.

Step 3 Terminalserver# configure terminal Enter global configuration mode.

Step 4 Terminalserver(config)# line vty 0 31 Set the number of Telnet sessions to the number 
of available ports on the terminal server. This 
example sets 32 Telnet sessions.

Step 5 Terminalserver(config)# Ctrl+Z Return to Privileged Exec mode.

Step 6 Terminalserver# copy running startup Save the configuration changes to NVRAM.
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Step 2 From the Welcome to ISC window, choose Administration.

Step 3 From the Administration window, choose Control Center.

The Hosts window appears (see Figure A-2).

Figure A-2 Selecting the ISC Host

The Hosts window lists the hosts and servers that are managed by ISC.

Step 4 In the check box next to the host name, select the name of the ISC workstation.

Step 5 Click Config.

The Hosts Configuration window appears (see Figure A-3).

Figure A-3 Hosts Configuration Window
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Step 6 Locate the GTL (Generic Transport Layer) folder, then click to expand it.

Figure A-4 shows the expanded GTL folder displaying the list of GTL options.

Figure A-4 GTL Options

Step 7 Select device-config-access-protocol.

The GTL Attributes dialog box for the device access protocol appears (see Figure A-5).

Figure A-5 Specifying the Device Access Protocol

As you can see from the Description area, the numeral 2 corresponds to TFTP.

Step 8 In the New Value field, enter the numeral 2.

Step 9 Click Set Property.

Proceed to the next section to define the ISC workstation as a TFTP server.

Setting the ISC Host as a TFTP Server
This section describes how to set up a local Solaris host as a TFTP server. If the ISC Network 
Management Subnet includes one or more Collection or Processing servers, you must set up the Cisco 
ISC workstation as a TFTP host.

To set up the ISC workstation as a TFTP server:

Step 1 From the Welcome to ISC window, choose Administration.

Step 2 From the Administration window, choose Control Center.

The Hosts window appears (see Figure A-2 on page A-9).

Step 3 Locate the DCS (Device Configuration Service) folder, then click the folder to expand it.
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Figure A-6 shows the expanded DCS folder displaying the list of TFTP options.

Figure A-6 TFTP Options

Step 4 Select tfpServerIPAddress.

The TFTP Server IP Address Attributes dialog box appears (see Figure A-7).

Figure A-7 Specifying the Host as a TFTP Server

Step 5 In the New Value field, enter the host name or the IP address of the ISC workstation.

Step 6 Click Set Property.

Step 7 From the list of TFTP options, select tftpSubDirectory.

The TFTP Subdirectory dialog box appears (see Figure A-8).

Figure A-8 Specifying the Directory for the TFTP Server
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Step 8 In the New Value field, enter the location of the directory for TFTP server.

Step 9 Click Set Property.

Step 10 From the list of TFTP options, select tftpRootDirectory.

The TFTP Root Directory dialog box appears (see Figure A-9).

Figure A-9 Specifying the TFTP Root Directory

Step 11 In the New Value field, enter the location of the TFTP root directory.

Step 12 Click Set Property.

Step 13 From the ISC workstation, at the command line, stop the WatchDog by typing stopwd -y.

Step 14 To enable these changes, restart the WatchDog (startwd).

Step 15 Restart ISC.

Defining Collection Zones and Assigning Devices to Zones
ISC is designed to provision a large number of devices through its distributed architecture. If the Master 
server (equivalent to the ISC workstation) cannot keep up with the number of devices, Collection servers 
can be added to off load the work of the Master server.

Since Collection servers communicate a great deal with the network devices (for example, uploading and 
downloading configuration files to Cisco routers is handled through a Collection server), it makes sense 
to place Collection servers in a LAN near the routers, instead of placing the Collection server in the ISC 
network management subnet of the Master server.

Network devices are associated with collection servers by means of collection zones. A collection zone 
is a geographical grouping of devices that are served by a single Collection server. Each collection zone 
is associated with exactly one Collection server that collects data from each device. However, a 
Collection server can service multiple collection zones. For example, you may initially create several 
collection zones and have all of them serviced by the Master server. As the number of devices in each 
zone grows you can install additional Collection servers and assign some of the zones to them.

For information on installing a Collection server in ISC, see “Installing ISC” in Chapter 2, “Installing 
and Logging Into ISC” in the Cisco IP Solution Center Installation Guide.

The recommended sequence for setting up collection zones in ISC is as follows:

1. Examine your network to determine the optional set of collection zones.

2. Create the collection zones that are optimal for your network.

3. Create the network devices in ISC.

4. Assign each network device to the appropriate collection zone.
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Defining Collection Zones
To define collection zones in ISC, follow these steps:

Step 1 Log into Cisco ISC.

Step 2 From the Welcome to ISC window, choose Administration.

Step 3 From the Administration window, choose Control Center.

The Hosts dialog box appears, along with the Hosts table of contents (TOC), as shown in Figure A-10.

Figure A-10 Collection Zones Option in Hosts TOC

Step 4 From the Hosts TOC, choose Collection Zones.

The Collection Zones dialog box is displayed.

Step 5 Click Create.

The Create Collection Zone dialog box appears (see Figure A-11).

Figure A-11 Creating a Collection Zone

Step 6 Enter the name of the collection zone.

Step 7 From the Collection Host drop-down list, select the name of the Collection server, then click Save.

You return to the Collection Zones dialog box, where the new collection zone name and its attributes are 
displayed (see Figure A-12).
A-13
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Appendix A      Setting Up the Network
Defining Collection Zones and Assigning Devices to Zones
Figure A-12 Collection Zone Created

Step 8 Repeat this procedure for any additional collection zones you need to define for your network.

Assigning Devices to a Collection Zone
After you have defined all the collection zones that are necessary for your network, you must assign the 
set of geographically related network devices to the appropriate collection zone.

To assign devices to a collection zone:

Step 1 Choose Service Inventory, then choose Inventory and Connection Manager.

Step 2 From the Inventory and Connection Manager window, choose Devices.

The Devices dialog box appears (see Figure A-13).

Figure A-13 List of Devices Recognized by ISC 
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Step 3 Click the name of the device that you want to assign to a collection zone.

The Edit Cisco IOS Devices dialog box appears (see Figure A-14).

Figure A-14 Specifying the Collection Zone for a Device

Step 4 From the Collection Zone drop-down list, specify the appropriate collection zone for the selected device, 
then click Save.

Step 5 Repeat this procedure for each device to be assigned to a collection zone.

Seeing the Devices Assigned to a Collection Zone
To see the list of network devices assigned to a specific collection zone:

Step 1 Choose Administration, then choose Control Center.

The Hosts dialog box appears, along with the Hosts table of contents (TOC), as shown in Figure A-10.

Step 2 From the Hosts TOC, choose Collection Zones.

The Collection Zones dialog box is displayed (Figure A-15).

Figure A-15 Selecting the Collection Zone

Step 3 Click Devices.
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ISC displays the list of devices assigned to the specified collection zone (see Figure A-16).

Figure A-16 List of Devices in a Collection Zone
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Service Request Transition States

Service Request State Transition Sequences
Table B-1 and Table B-2 on page B-2 show the state transition paths for IP Solution Center (ISC) service 
requests. The beginning state of a service request is listed in the first column; the states that service 
requests transition to are displayed in the heading row. 

For example, to use Table B-1 to trace the state of a Pending service request to Functional, find Pending 
in the first column and move to your right until you find Functional in the heading. You can see that for 
a service request to move from Pending to Functional, a successful routing audit must take place.

Table B-1 shows the service request transitions from Requested to Lost. 

Table B-1 State Transition Paths for ISC Service Requests (Part 1)

Service 
Request States Requested Pending Failed Audit Deployed Functional Lost

Requested

No transition to 
Requested

Successful 
service request 
deployment

No transition to 
Failed Audit

No transition to 
Deployed

No transition to 
Functional

No transition 
to Lost

Pending

No transition to 
Requested

Successful 
service request 
deployment

Audit is not 
successful

Audit is 
successful

Routing audit is 
successful

No transition 
to Lost

Failed Audit

No transition to 
Requested

Successful 
service request 
redeployment

No transition to 
Failed Audit

Audit is 
successful

Routing audit is 
successful

No transition 
to Lost

Deployed

No transition to 
Requested

Successful 
service request 
redeployment

No transition to 
Failed Audit

Audit is 
successful

Routing audit is 
successful

Audit found 
error

Functional

No transition to 
Requested

Successful 
service request 
redeployment

No transition to 
Failed Audit

No transition to 
Deployed

Routing audit is 
successful

Audit found 
error

Lost

No transition to 
Requested

Successful 
service request 
redeployment

No transition to 
Failed Audit

Audit is 
successful

Routing audit is 
successful

Audit found 
error

Broken

No transition to 
Requested

Successful 
service request 
redeployment

No transition to 
Failed Audit

No transition to 
Deployed

Routing audit is 
successful

Audit found 
error
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Table B-2 shows the service request transitions from Broken to Closed.

Invalid

No transition to 
Requested

Successful 
service request 
redeployment

Redeployment 
caused service 
request error

No transition to 
Deployed

No transition to 
Functional

No transition 
to Lost

Failed Deploy

No transition to 
Requested

Successful 
service request 
redeployment

Redeployment 
service request 
failed. Configlet 
cannot be 
downloaded.

No transition to 
Deployed

No transition to 
Functional

No transition 
to Lost

Closed
No transition to 
Requested

No transition to 
Pending

No transition to 
Failed Audit

No transition to 
Deployed

No transition to 
Functional

No transition 
to Lost

Table B-1 State Transition Paths for ISC Service Requests (Part 1) (continued)

Service 
Request States Requested Pending Failed Audit Deployed Functional Lost

Table B-2 State Transition Paths for ISC Service Requests (Part 2)

Service 
Request States Broken Invalid Failed Deploy Closed

Requested
No transition to Broken Deploy Service 

Request error
Deployment failed No transition to Closed

Pending

Route audit is not 
successful. Configlet is 
correct.

Redeployment 
caused service 
request error

Redeployment service 
request failed. Configlet 
cannot be downloaded.

Removal of the service 
request is successful

Failed Audit

Route audit is not 
successful. Configlet is 
correct.

Redeployment 
caused service 
request error

Redeployment service 
request failed. Configlet 
cannot be downloaded.

No transition to Closed

Deployed

Route audit is not 
successful. Configlet is 
correct.

Redeployment 
caused service 
request error

Redeployment service 
request failed. Configlet 
cannot be downloaded. 

No transition to Closed

Functional

Route audit is not 
successful. Configlet is 
correct.

Redeployment 
caused service 
request error

Redeployment service 
request failed. Configlet 
cannot be downloaded.

No transition to Closed

Lost

Route audit is not 
successful. Configlet is 
correct.

Redeployment 
caused service 
request error

Redeployment service 
request failed. Configlet 
cannot be downloaded.

No transition to Closed

Broken

Route audit is not 
successful. Configlet is 
correct.

Redeployment 
caused service 
request error

Redeployment service 
request failed. Configlet 
cannot be downloaded.

No transition to Closed

Invalid

No transition to Broken Redeployment 
caused service 
request error

Redeployment service 
request failed. Configlet 
cannot be downloaded.

No transition to Closed
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Failed Deploy

No transition to Broken Redeploy 
service request 
error

Redeployment service 
request failed. Configlet 
cannot be downloaded.

No transition to Closed

Closed
No transition to Broken  No transition 

to Invalid
No transition to Failed 
Deploy

No transition to Closed

Table B-2 State Transition Paths for ISC Service Requests (Part 2) (continued)

Service 
Request States Broken Invalid Failed Deploy Closed
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Troubleshooting MPLS VPN 

This chapter contains the following major sections:

• MPLS VPN Provisioning Workflow, page C-1

• General Troubleshooting Guidelines, page C-2

• Common Provisioning Issues, page C-2

• Troubleshooting MPLS VPN and Layer 2 VPN, page C-4

MPLS VPN Provisioning Workflow
The tasks listed below depict the MPLS provisioning workflow. This section assumes an operator 
deploys a service request using a caller such as Task Manager.

1. The Provisioning driver (ProvDrv) gets the service request to be deployed.

2. From the service request, the Provisioning driver deduces which devices are involved.

3. The latest router configurations must be obtained, so the Provisioning driver tells the Generic 
Transport Library (GTL)/ Device Configuration Service (DCS) to upload the latest router 
configurations. The result is used by the service module.

4. The Provisioning driver determines what service modules are involved based on the service and 
device types.

5. The Provisioning driver queries the Repository for the service intention. The Provisioning driver 
sends the service intention to the service module, along with the uploaded configuration. 

6. The service module generates configlets based on the configurations and service intention and 
returns the appropriate configlets to the Provisioning driver.

7. The Provisioning driver signals GTL/DCS to download the configlets to the target routers.

8. The Provisioning driver sends the updated result, including the download result, to the Repository, 
which then updates its state.
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Appendix C      Troubleshooting MPLS VPN
General Troubleshooting Guidelines
Terms Defined
• Device Configuration Service (DCS): Responsible for uploading and downloading configuration 

files.

• Generic Transport Library: Provides APIs for downloading configlets to target devices, 
uploading configuration files from target devices, executing commands on target devices, and 
reloading the target device. 

This library provides a layer between the transport provider (DCS) and the client application (for 
example, the Provisioning Driver, Auditor, Collect Config operation, Exec command). The main 
role of the GTL is to collect the target specific information from the Repositories and the properties 
file and pass it on to the transport provider (DCS).

• ProvDrv (the Provisioning driver): ProvDrv is the task responsible for deploying one or more 
services on multiple devices. 

ProvDrv performs the tasks that are common to all services, such as the just-in-time upload of 
configuration files from the devices, invocation of the Data Driven Provisioning (DDP) engine, 
obtaining the generated configlets or the audit reports from the DDP engine, and downloading the 
configlets to the devices.

• Repository: The Repository houses various IP Solution Center data. The ISC Repository uses 
Sybase or Oracle.

• Service module: Generates configlets based on the service types.

General Troubleshooting Guidelines
For general troubleshooting of failed provisioning, follow these steps:

Step 1 Identify the failed service request and go into Details. 

a. To do this, go to the Service Request Editor and click Details. Of main concern is the status 
message—this tells you exactly what happened. 

b. If the status message tells you it’s a failed audit, click the Audit button to find out exactly what part 
of the audit failed.

Step 2 If the troubleshooting sequence in Step 1 doesn’t give you a clear idea as to what happened, use the logs 
in the Task Manager to identify the problem. 

a. To do this, choose Monitoring > Task Manager > Logs > Task Name. 

b. There is a lot of information in this log. To isolate the problem, you can use the filter. If you filter 
by log level and/or component, you can usually reduce the amount of irrelevant information and 
focus on the information you must know to locate the problem.

Common Provisioning Issues
Below is a list of common provisioning problems and recommended solutions.
C-2
Cisco IP Solution Center MPLS VPN User Guide, 4.0

OL-6372-02



 

Appendix C      Troubleshooting MPLS VPN
Common Provisioning Issues
Symptom 1

My task does not execute even if I schedule it for immediate deployment.

Recommended Action

This problem is likely due to one of the ISC servers being stopped or disabled. 

Step 1 To check the status of all ISC servers, open the Host Configuration dialog by choosing 
Administration > Control Center.

The Control Center Hosts page is displayed.

Step 2 Click the check box for the host of interest. 

The menu buttons for the Hosts page are enabled.

Step 3 Select Servers.

The Server Status page is displayed (see Figure C-1).

Figure C-1 ISC Server Status

Step 4 On the ISC server, use the wdclient status command to find out the detailed status of the server.

Symptom 2

The service request is in the Wait Deployed state.

Recommended Action

This concerns the devices that are configured to use the CNS 2100 Series Intelligence Engine as the 
access method. If the devices are offline and a configlet was generated for it, the service request will 
move into the Wait Deployed state. As soon as the devices come online, the list of configlets will be 
downloaded and the status of the device will change.

Symptom 3

The service request is in the Failed Audit state.
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Appendix C      Troubleshooting MPLS VPN
Troubleshooting MPLS VPN and Layer 2 VPN
Recommended Action

At least one command is missing on the device.

Step 1 From the ISC user interface, go to Service Request Editor > Audit > Audit Config. 

Step 2 Check the list of commands that are missing for each device. 

Step 3 Look for any missing command that has an attribute with a default value.

Symptom 4

The service request is in the same state as it was before a deployment.

Recommended Action

If after a deployment a service request state remains in its previously nondeployed state (Request, 
Invalid, or Pending), it’s an indication that the provisioning task did not complete successfully. Use the 
steps described in General Troubleshooting Guidelines, page C-2 to find out the reason for the service 
request failure.

Symptom 5

You receive the following out-of-memory error: OutOfMemoryError.

Recommended Action

Step 1 Open the Host Configuration dialog by choosing Administration > Control Center.

The Control Center Hosts page is displayed.

Step 2 Click the check box for the host of interest. 

The menu buttons for the Hosts page are enabled.

Step 3 Click Config.

The Host Configuration window is displayed.

Step 4 Navigate to watchdog > servers > worker > java > flags.

Step 5 Change the following attribute: 

Change the Xmx256M attribute to Xmx384M or Xmx512M.

Troubleshooting MPLS VPN and Layer 2 VPN 
Go through the troubleshooting steps described in General Troubleshooting Guidelines, page C-2. If you 
have failed to troubleshoot or identify the problem, the information in this section provides information 
on how to gather logs for the development engineer to troubleshoot. 

Tip The logs apply to both MPLS VPNs and Layer 2 VPNs.
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Appendix C      Troubleshooting MPLS VPN
Troubleshooting MPLS VPN and Layer 2 VPN
There is a property in DCPL called Provisioning.Service.mpls.saveDebugData. If this property is set 
to True, whenever a service request is deployed, a temporary directory is created in 
ISC_HOME/tmp/mpls. 

The directory contains the job ID of the service request prefixed to it, along with a time stamp. This 
directory contains the uploaded configuration files, service parameters in XML format, and the 
provisioning and audit results. 

The default is set to True. 

Step 1 To verify, you can locate the property by choosing Administration > Control Center.

The Control Center Hosts page is displayed.

Step 2 Click the check box for the host of interest. 

The menu buttons for the Hosts page are enabled.

Step 3 Click Config.

The Host Configuration window is displayed.

Step 4 Navigate to Provisioning > mpls.

Step 5 Click saveDebugData.

Frequently Asked Questions
Below is a list of FAQs concerning MPLS VPN provisioning. (Question 13 pertains to Layer 2 VPNs.)

Q 1: Why does my service request go to Invalid when I select provisioning of an extra CE Loopback 
interface?

It is possible that the auto pick option of the IP addresses was selected for the service request, but a /32 
IP address pool was not defined. Check and make sure the IP address and the IP address pool defined for 
this service request are compatible.

Q 2: When saving a service request, why does it say “CERC not initialized”?

It is necessary to pick a CERC for the link to join. Please check the service request to see if a CERC was 
selected.

Q 3: Why does creation of a VLAN ID pool require an Access Domain?

VLAN ID pools are associated with an Access Domain. Access Domains model a bridged domain; 
VLAN IDs should be unique across a Bridged Domain. 

PE-POPs must be associated with an Access Domain. An Access Domain can have more than one 
PE-POP associated with it.

Q 4: In a Paging table, why are the Edit and Delete options disabled, even though only one check box 
is checked?

This is possible if one or more check boxes are selected in previous windows.

Q 5: Why can I not edit an MPLS VPN or L2VPN policy?

If a service request is associated with a policy, that policy can no longer be edited.

Q 6: I’m unable to create a CERC—can you explain why?
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Troubleshooting MPLS VPN and Layer 2 VPN
You have to define a Route Target pool before you create a CERC, unless you specify the Route Targets 
manually.

Q 7: How can I modify the configlet download order between the PE, CE, and PE-CLE devices?

There is a property called Provisioning.Services.mpls.DownloadWeights.* that allows you to specify 
the download order for the following device types: PE, CE, PE-CLE, and MVRF CE. 

For example, to ensure that the configlet is downloaded to the PE before it’s downloaded to the CE, 
configure the Provisioning.Services.mpls.DownloadWeights.weightForPE property with a weight 
value greater than that of the CE.

Q 8: What does this property Provisioning.Service.mpls.reapplyIpAddress do?

If this property is set to True, during deployment of a decommissioned service request, this property will 
keep the IP address on the CE and PE intact on the router to maintain IPv4 connectivity to the CE.

Q 9:When I create a multi-hop NPC between a CE and PE through at least one PE-CLE device, why do 
I see some extra NPCs created?

IP Solution Center creates the extra NPCs to prevent operators from having to enter the same information 
again. A CE can now be connected to the PE-CLE device, and a new NPC will be created that will 
connect the new CE to a PE over the PE-CLE-to-PE NPC link.

Q 10: During service request provisioning, in the Interface selection list box, why don’t I see the entire 
list of interfaces on the device?

This is probably due to a particular interface type being specified in the service policy. If that is the case, 
only interfaces of the specified interface type are displayed.

Q 11: Why do BGP and EIGRP not appear in the Routing protocol selection list for a service request 
associated to a No-CE policy?

BGP and EIGRP require certain CE-related parameters, such as the customer AS number and the CE’s 
IP address. Since none of these parameters are requested in a No-CE policy, it is not feasible to provision 
these protocols. To provision a service request with BGP or EIGRP, use a policy with the CE present 
option specified, and you can set the CE to unmanaged.

Q 12: Why do the routing protocols BGP and EIGRP not appear when I select No CE?

If there is no CE in the scenario, BGP and EIGRP are not supported.

Q 13: This is a Layer 2 VPN question: Why does my service request go to Invalid with the message 
“loopback address missing”?

This is because the loopback address required to peer the pseudowire between PEs has not been defined 
in the PE-POP object in ISC.

Troubleshooting IPsec Mapping into MPLS
IPsec mapping into MPLS consists of an IPsec service request and an MPLS service request. Each has 
its own debugging mechanism. There is no common debugging methodology for both IPsec and MPLS 
since they are two independent service requests. - IPsec is not supported in this release. -
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